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About This Book

This book describes License Use Management Runtime for AIX® and Windows®. It
contains information about how to set up:

* The servers where product licenses are to be installed
* The clients that use the products
* An environment that can support network licensing

It also explains how to manage the licenses for the products you install. Before
reading this guide, read the documentation supplied with the licensed product.

Who Should Read This Book

This book is intended for the following types of user.

* The system administrator who is responsible for setting up and administering
the license management environment. According to the platform where the
product is installed, this person, depending on the platform being used, must
have general knowledge of the following products and environments:

— AIX or Windows
— The TCP/IP transport protocol
— The network environment

* The end users who run the software products and the License Use Management
Runtime product. End users require only general knowledge of the AIX or
Windows operating environment.

How This Book is Organized

This book is organized into the following sections:

[Chapter 1, “Introduction”| provides an overview of License Use Runtime features
and benefits, describes supported license types, license policies, and
license-enabling models, and presents some simple scenarios for the use of licensed
products.

[Chapter 2, “Planning Network Licensing”| provides the basic NCS concepts you
need to set up your network and manage licenses.

[Chapter 3, “Installing License Use Management Runtime”| explains how to install
and uninstall License Use Runtime components.

[Chapter 4, “Configuring License Use Management Runtime”] provides scenarios for
configuring License Use Runtime, administering product licenses, and
implementing customer-controlled policies, using the License Use Runtime tools.

[Chapter 5, “Administering License Use Management Runtime”| describes daily
tasks such as administering product licenses, and implementing
customer-controlled policies.

[Chapter 6, “License Use Management Runtime Command Line Interface”]
documents the License Use Runtime command line interface.

© Copyright IBM Corp. 1995, 2006 xi



[Chapter 7, “Hints and Tips”| explains how to take better advantage of License Use
Management Runtime.

[Chapter 8, “Troubleshooting”| explains how to improve performance and handle
problems, should they arise when you use license-enabled products.

[Appendix A, “License Use Management Runtime Configuration File”| provides
reference information on the configuration file.

[Appendix B, “Environment Variables,” on page 185| describes the environment
variables used by License Use Management Version 5.1.1.

[Appendix C, “Using the Nodelock Directory,” on page 187] explains how to prepare
the nodelock directory manually and how to use it.

[Appendix D, “Operating Systems and License Use Management Support”|identifies
the operating systems supported by License Use Management and indicates, where
appropriate, the conditions of their support.

[Appendix E, “Accessibility”] provides a summary of the implementations that make
the use of the interface accessible to people with some physical disabilities.

The explains terms used in this manual.

Prerequisite and Related Information

xii

This section lists other sources of information for License Use Management
Runtime.

README File

For changes to License Use Management Runtime that were made after the book
was finished, see the README.ARK file in the download package from the License
Use Management Web site.

Ihttp: / /www.ibm.com/software/ lum|

Depending on the operating system you are working on, you can find the
README.ARK file in the directories listed below:

AIX

/opt/LicenseUseManagement/doc

Windows

C:\Program Files\IBM\License Use Management

where C: is the drive where License Use Management Runtime was installed.

MAN Pages for Command Syntax

To display the man pages, you might need to add an entry to the MANPATH
environmental variable in the profile. The new entry must specify the directory.

If you are working on AIX platform, the files are in one of the following
directories:

If only the lum.base.cli package is installed:
/opt/LicenseUseManagement/doc

If both the lum.base.cli and the lum.html.en_US packages are installed:

Using License Use Management Runtime
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/opt/LicenseUseManagement/doc/en_US/catl

To get help with the syntax of a particular command, go to the en_US directory and
type:

man command_name

This displays the command syntax. For example, to get help with the command
LUMDI, type:

man LUMb1t

HTML Files

To view an HTML file, open it in your Web browser.

If you are working on an AIX platform, the files are in one of the following
directories:

* If only the lum.base.cli package is installed:
/opt/LicenseUseManagement/doc
e If both the lum.base.cli and the lum.html.en_US packages are installed:

/opt/LicenseUseManagement/doc/en_US

If you are working on Windows platform, the files are in the directory:

c:\Program Files\IBM\License Use Management\doc\en_ US

There are HTML versions of:

* License Use Management Runtime Message References for non-IBM AIX and
Windows:

Tummsg.htm

* This book Using License Use Management Runtime
Tumusg.htm
A PDF version of this book is available for download from the IBM® License Use
Management Web site.

* Using Application Developer’s Toolkit (if Application Developer’s Toolkit is
installed in your environment).
Tumtkt.htm

This book describes how to license-enable software products for use with
License Use Management.

License Use Management Web Site

For information and news about IBM License Use Management, and to download
License Use Management Runtime publications and code, visit the IBM License
Use Management Web site at:

[http:/ /www.ibm.com /software /lum|

Notational Conventions

This book uses the following notation in text:

Bold Bold print indicates something you click, select, or type, such as a menu
option, field, or push button.

Italics Ttalics are used for variables, for new terms in the text, for directories and
for emphasis.

About This Book  xiii
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Monospacing

Monospacing is used for system messages and examples.

When you see an operating system icon, the text applies only to the operating
systems indicated by that icon until the next icon appears. Icons used in this book
are described in the following table.

ALL

¢
=

&
I..IHE

This icon identifies text that is common to all operating systems.
This icon identifies text that refers to all NON-IBM UNIX® operating
systems (AIX and Windows).

This icon refers to text for AIX systems only

This icon refers to text for Windows systems only

This icon refers to text for AIX and Windows systems only

This icon refers to text for NON-IBM UNIX and Windows systems
only

Default Windows Installation
In all Windows examples and commands, this book uses the following notation:

* The default installation drive used is c:\. You can use any drive for installation,
but remember to substitute the drive letter shown in this book from c:\ to the
one you use for installation.

* The Program Files directory is used in this book, but the name of the directory
might be different if you are using any version of Windows that is not an

English version.

* The Documents and Settings\A11 Users\Application Data\ directory is used in
this book, but the name of the directory might be different if you are using any
version of Windows that is not an English version.
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Summary of Changes

Summary of Changes for Versions 5.1.0 to 5.1.1

This edition of the book incorporates changes made in Versions 5.1.0 through 5.1.1
of License Use Management Runtime, which were documented in the
README.ARK files for those versions.

This section summarizes the changes made to this book to reflect new and changed
function and support.

Operating systems no longer supported

The following operating systems are no longer supported:
* HP-UX 11. for 64 bit

* IRIX 6.5 for 32 bit

e Solaris 8, 9, and 10 for 64 bit

* Windows 2000

Custom Configuration Policy

Vendors can now offer a combination of products, tailored to the needs of each
user, under a single custom configuration license.

Release Dependent Key

Vendors can now offer the capability to use the same licenses for different versions
of the product.

© Copyright IBM Corp. 1995, 2006 XV
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Chapter 1. Introduction

ALL

License Use Management Runtime is part of IBM License Use Management, a
combination of tools for software asset protection. The License Use Management
tools enable software vendors and their customers to ensure that customers comply
with the terms and conditions of license agreements. They check compliance
through runtime monitoring of the usage of software assets.

License Use Management Version 5.1.1 Compatibility

Version 5.1.1 is a new product and has no backward compatibility with previous
releases of License Use Management . No upgrade is possible from previous
releases of License Use Management to version 5.1.x. However, both version 4.6.8
and version 5.1.1 can coexist on the same machine.

License Use Management at a Glance

License Use Management consists of two components:

License Use Management Application Developer’s Toolkit (License Use
Management ADK)
Enables vendors to implement license management in an application. To
implement license management, vendors embed API calls and API code in their
products. The product is then described as license-enabled. Vendors can
license-enable C-language programs and Java " applications.

The License Use Management ADK offers the vendor great flexibility:
* Level of control that is used by the license-enabled application
* Type of customer licensing environment for which the application is intended
* Implementation of policies
License Use Management Runtime
Enables users of license-enabled software to manage the licensing environment.

The License Use Management Runtime software is free of charge and is
available for download from the IBM License Use Management Web site:

Ihttp:/ /www.ibm.com/software/ lum|

License Use Management Vendor Perspective

License Use Management benefits software vendors by enabling them to do the

following:

* Ensure that customers use software licenses within entitled limits

* Base product prices on actual usage

* Protect intellectual property from unauthorized use

* Increase overall revenue as customers acquire all the licenses they need

* Distribute software for a trial period with trial licenses that can be replaced by
production licenses, thus minimizing distribution cost

License Use Management Customer Perspective

License Use Management benefits the customers of software vendors by enabling
them to do the following:

© Copyright IBM Corp. 1995, 2006 1
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LUM Customer Perspective

* Ensure that they have enough licenses to satisfy their business requirements and,
at the same time, that they are not paying for more licenses than they need

* Base software charges within the enterprise on actual usage

* Demonstrate license use compliance to internal and external auditors

* Protect organizations from inadvertent violations of license agreements

* Change software assets to alternative pricing policies that the vendor offers

Basic Concepts of License Use Management

A license, in the context of License Use Management, is permission to use an
instance of a licensed software product or service, according to the basis on which
the vendor charges for the product or service. The term license in this context does
not refer to the license agreement that governs use of, and rights to, a product.

License-Enabling a Product

Vendors deliver licenses to customers in the form of a license password. The
password contains encrypted terms of the usage of the software product, such as
the following:

* The number of licenses or concurrent copies of the product the customer can use
* The expiration date of the licenses

+ The license type (see [‘License Types” on page 5)

In the license-enabling process, the vendor can do the following:
* Select among the various license types

* Decide to distribute licenses one-by-one or in packages of multiple licenses from
which individual licenses can be extracted (see [“License Passwords” on page 3)

* Implement direct controls over the use of licenses, or make it possible for the
customer to control use of licenses (see [“Use-Control Levels” on page 4)

* Impose, or allow the user to impose, various types of control over
administration of licenses (see [“License Policies” on page 7)

When the product is installed, License Use Management Runtime checks that a
license is available each time the product is run.

Nodelocked and Network Licenses

Vendors can supply licenses in two forms: nodelocked licenses or network licenses.

A nodelocked license is a license for a specified workstation (node). It is stored on
the specified workstation, and the license-enabled product will run on only that
workstation.

A network license is a license, stored on a server, that can be used by any client
workstation. Many License Use Management Runtime clients can share the licenses
for enabled products.

The licenses are stored on one or more network license servers. Each client
workstation must be connected to a server. When the user at a client starts a
licensed program, License Use Management Runtime at the license server
determines whether a license is available.
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Managing Licenses

License Use Management Runtime includes the basic license tool, which manages
network licenses. The basic license tool enables you to do the following:

* Add licenses to or delete licenses from the server database

* Display information about the licenses installed

* Distribute the licenses among the license servers available on the network

* Reserve licenses for the exclusive use of certain users

¢ Generate reports on license usage and server events

The basic license tool has a graphical user interface (GUI) and a command-line
interface. For more information about what the basic license tool does, see
[Chapter 5, “Administering License Use Management Runtime,” on page 65

License Use Management Runtime Platforms

shows which platforms License Use Management Runtime supports, and
where to get the License Use Management Runtime code.

Table 1. License Use Management Runtime Platforms

AIX 5.2.0.30 You can install Version 5.1.1 from the product
package downloaded from the IBM License Use
Management Web site:

[http:/ /www.ibm.com /software /lum|

Windows XP ! License Use Management Runtime, Version 5.1.1 can
Windows Server 2003 ! either be redistributed with the license-enabled
product or be downloaded from the IBM License Use
Management Web site:

[http:/ /www.ibm.com /software /lum|

Notes:
1. 64 bit version is supported only on X64 processor.

License Passwords

Vendors provide license passwords (also known as license keys) with their products.

A license password is an encrypted character string. It contains information about
the license, such as the following:

* The types of licenses (see [“License Types” on page 5)

* The date when the licenses become active

* The date when the licenses expire

There are two types of password: simple and compound. A simple password
represents one or more licenses. A compound password contains multiple simple
passwords, each of which represents one or more licenses.

Note: The expiration date of simple licenses that are contained in a compound
password must fall on or before the expiration date of their compound

password.

Compound passwords can be used as follows:
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License Passwords

* Vendors use compound passwords to distribute multiple licenses to their
customers.

* The customer installs the compound password on the assigned license server.
The customer extracts the licenses and distributes them, as required, to different
license servers. (These servers are not specified in the compound password.)

The vendor includes the password, along with other information about the
application, in the enrollment certificate file (ECF). You then make licenses available
to users of the product by enrolling the product using the license password. See
[“Enrolling the Product” on page 67

Use-Control Levels

Products can have one of the following predefined use control levels:
+ [Vendor-managed use controll
* [Customer-managed use contr01|

Vendor-Managed Use Products

With vendor-managed use (VMU) products, the vendor manages compliance with
the terms of the acquisition of the software product.

When you request licenses for a vendor-managed use product, the product vendor
asks you to supply the unique identifier (target ID) of each workstation where you
intend to install the product licenses. For nodelocked licenses, this is the
identification of the workstation where the enabled product is to be installed; for
network licenses, this is the network license server. You must also supply the
number of licenses that you want to acquire. The vendor uses this information to
create the password that you use to install and activate the licenses.

Vendors ship a vendor-managed use product typically with a simple password.
They can also use compound passwords for this purpose.

If you want to change the terms and conditions of the contract, (for example, to
increase the number of licenses), you provide the vendor with similar information
for each of the workstations on which you intend to install the licenses and get a
new password.

A vendor can produce a vendor-managed use license password with target ID set
to ANY, so that you can install it on any workstation. The vendor can deliver such
a password with the product package without your specifying how many licenses
you want to acquire. Instead, the vendor sets an upper limit, possibly very large,
on the number of licenses you can install on each license server. By generating and
delivering such a password, the vendor has decided not to perform the checks that
are normally associated with vendor-managed use.

Customer-Managed Use Products

To provide vendors with greater flexibility in the way they deliver licensed
software, License Use Management Runtime supports customer-managed use
(CMU) control. With products that are enabled in this way, the vendor does not
directly associate licenses with a particular license server (or group of license
servers). The vendor does not set an upper limit on the number of licenses that
you are entitled to use. Instead, it is your responsibility to set that upper limit,
depending on the terms of the software product acquisition.
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License Use Management Runtime provides you with the information on the usage
of the enabled products, thereby helping you stay within the boundaries of the
acquisition agreement. Transactions, such as enrollment, distribution of licenses,
updates, and deletions, are logged in a tamper-proof License Use Management
Runtime database.

Vendors typically ship a customer-managed use product with a compound
password that you can use to extract and distribute the number of licenses you
have acquired. They can also use simple passwords for certain types of licenses.

License Types

This section describes the types of license the vendor can select. When you receive
a license-enabled product, check the product documentation to determine the
license type.

Nodelocked Licenses

A nodelocked license restricts the use of a product to the workstation specified in
the license. Vendors typically use nodelocked licenses for standalone applications,
rather than for client/server applications.

For nodelocked licenses, the license-enabled product itself, rather than License Use
Management Runtime manages use of the nodelocked license. The password for
such a product is stored in a nodelock directory. When you start the application, it
checks the nodelock directory to ensure that you have a valid license. See
[“License-Enabling Models” on page 11| for more information about license-enabling
models.

A nodelocked license allows an unlimited number of simultaneous uses of the
licensed application on the local workstation. A word processor is a typical
example of a product that uses nodelocked licenses.

Network Licenses

Network licenses, rather than being restricted to a single workstation, are stored on
a network license server and shared among multiple network license clients.

Vendors can enable their products to use the following kinds of network licenses:
* |Concurrent licenses)

+ |Concurrent-offline licenses|

+ [Reservable licenses|

+ [Use-once licenses|

* [Per-seat licenses|

Concurrent Licenses

A concurrent license is a network license that can be temporarily granted to run
the licensed application on a client.

When the product is running, that license remains unavailable to other users of the
product. When the product stops running, the license is returned to the server,
where it becomes available to other users.

Concurrent licenses allow as many users to run a licensed application

simultaneously as there are valid licenses for the product available from the
network license servers in your licensing environment.
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A typical use of concurrent licenses is for products with relatively expensive
licenses that each user will use only some of the time. The customer shares
network licenses among users to optimize the usage of the licenses. Such
applications might be either client/server applications, for which the client is
enabled, or non-client/server applications.

Vendors can use concurrent licenses for both vendor-managed and
customer-managed products.

Concurrent-Offline Licenses

The concurrent-offline license allows users to reserve a concurrent license for a
certain number of days and to use it on a portable computer disconnected from the
network. Only authorized users can exploit this feature. The users must be defined
by the license administrator at the customer site. The portable computer can use
supported Windows platforms only (see [Table 1 on page 3| for a list of supported
platforms).

A concurrent-offline license is installed on the network license server. It is similar
to a normal concurrent license because it can also be used as a normal concurrent
license.

For the duration of the reservation, the license remains unavailable to other users
of the product. The license becomes available to other users when one of the
following occurs:

¢ The reservation period expires

* The license is returned to the server from the portable computer

When the concurrent-offline license has been reserved for use, a copy is installed
on a portable computer connected to the network. This copy of the
concurrent-offline license is called an offline-nodelocked license. When the
offline-nodelocked license has been installed on the portable computer, the portable
computer can be disconnected from the network.

Reservable Licenses

A reservable license is a network license that the license administrator can reserve
for the exclusive use of a user, a group, and a node. The reservation is for a
specified time period. A reservable license that has been reserved is called a
reserved license. A reservable license that has not been reserved is called an
unreserved license.

The license administrator can reserve some of the reservable licenses for an
application and leave others unreserved. Unreserved licenses are treated like
concurrent licenses. Reserved licenses become available to other users when the
reservation period expires or when the license administrator explicitly unreserves
the license.

Vendors can use reservable licenses for both vendor-managed and
customer-managed products.

Note: The reservation period is the time frame during which the license remains
unavailable to other users. For a reservable license, this period starts when
the license administrator defines the reservation. For a concurrent-offline
license, the period starts only when the user actually requests the license
from the portable computer.
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Use-Once Licenses

A use-once license is a network license that permits a single use of a licensed
product during the time the license is valid. Every time the product is started, one
license is used.

A typical use of use-once licenses is to distribute promotional or demonstration
versions of software.

Vendors also provide use-once licenses to supplement concurrent licenses when
user demand for those products exceeds the number of available concurrent
licenses.

Vendors can use use-once licenses for both vendor-managed and
customer-managed products.

Per-Seat Licenses

multiple-server solutions. With per-seat licenses, the server of a licensed
client/server application can request licenses for its clients. The application clients
need not be license-enabled.

‘% Vendors use per-seat licenses to enable client/server applications constructed for

For per-seat licensing, unused application client licenses are kept in a central
repository, which all the application servers share. They also share a central list of
application clients to which a license has been assigned. When a license for a C or
C++ application or for a Java application is assigned to an application client, that
assignment is permanent. If an application client connects to multiple application
servers, it is assigned only one license.

Per-seat licenses are valid only for customer-managed use products.

License Policies

Vendors can enable their products to implement various policy decisions regarding
how licenses are managed.

Vendor Controlled Policies

The vendor can implement the license policies: capacity, value units policy,
try-and-buy, multiuse rules, license annotation, custom configuration, custom
attributes, and release dependent key.

Capacity

With this policy vendors can comply with the terms and conditions of products
that are priced based on certain characteristics of the system on which the product
is running, not only on the number of users who are using the product. This
includes, for example, the number of processors on which the application can run
or the maximum size of the physical memory.

In such cases the vendor can specify a capacity type that defines the unit of measure
for the internal counter (“capacity units”) associated to the license password. The

capacity type is an integer value between 1 and 255; some of these values have a
predefined value; others might have any vendor specific meaning.

The i redefined capacity types and supported platforms are shown in [Table 2 o
page 8
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Table 2. Predefined capacity types and supported platforms

Configured Online Physical disks Physical
processors processors memory (in MB)
AIX Y Y Y Y
HP-UX N Y Y Y
Solaris Y Y Y Y
Windows N Y Y Y

When you use one of the predefined capacity types, the License Use Management
library embedded in the license application can calculate the number of capacity
units that are used by the application itself. In the other cases the vendor must
calculate them before passing the results to the License Use Management library. In
either case, the license is granted only if the capacity type of the password matches
the capacity type specified in the request, and the capacity units are not exceeded.
This applies to nodelock and concurrent network license types, under either
vendor-managed or customer-managed use control.

Value Units Policy

With this policy vendors price their products by assigning a value expressed in
units to each resource in an environment. All the different metrics (like usage
count, system resources or other product-specific indicators) are defined into the
same license certificate, as well as the rules and relative weights for their
translation into value units. The Value Units policy can only be applied to
concurrent licenses. See the table below.

Type of Server Type A | Server Type No. of No. of clients | Single user
resource B clients
2 processors 1 processor 1-10 11 - 50
No. of value 50.15 30.20 20.30 45.00 10.00
units assigned

Value units are multiplied by the number of actual resources in your environment
according to the rules defined in the enrollment certificate. The value units are
then checked against the limit that is also defined in the enrollment certificate. This
policy enables you to change your environment to suit your needs, without
exceeding the value units assigned.

Try-and-Buy

The vendor can enable a product with a special simple nodelocked license for
customers to use during an evaluation period. The evaluation period (with
duration that is set by the vendor) starts either when the product is enrolled or
when the product is run for the first time.

Multiuse Rules

Multiuse rules define the conditions under which multiple calls of a product
require only a single license. These rules are applicable only to concurrent network
and concurrent-offline licenses.

The vendor can enable a product so that after a license has been granted to a

particular user, group, node, job ID, or ACID, a second call of the product does not
require a second license.
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Multiuse rules might be based on any combination of the following tests that the
server performs when a concurrent license is requested:

* The request for a license is associated with the same user as a previous request.

* The request for a license is associated with the same group as a previous
request.

¢ The request for a license is associated with the same node as a previous request
(applicable to concurrent licenses only).

* The request for a license is associated with the same job ID as a previous
request.

* The request for a license is associated with the same ACID as a previous request.

An ACID is a generic string that the vendor can use to further identify the caller
of the license request. For example, if a user calls a compiler repeatedly, a
multiuse rule might specify that the second and subsequent calls do not require
additional licenses.

License Annotation

License annotation is data that is defined and included as part of the license
information when a license is created. When the license is granted, the data is
passed to the enabled application for its own use. Licenses of any type can be
annotated.

Custom Configuration

Vendors who want to offer a selected combination of products, tailored more
precisely to the needs of users, can define custom configuration by adding
functions and products to a base configuration.

You specify the required content of a custom configuration when you order the
configuration. You can order a custom configuration for one seat or for a group of
any number of identical seats. If you order a configuration for a block of seats, the
quantity of each add-on functions or products must equal the number of seats in
the block. Each custom configuration, whether for a single seat or for a block of
two seats is assigned as a separate custom configuration license.

A custom configuration license is a special case of a concurrent network license, a
concurrent-offline network license and a simple nodelock license that contains an
unique serial number identifying that custom configuration. The single serial
number and license for a block configuration helps you to manage your installed
licenses more easily.

After initial installation of a custom configuration, you can better manage the
evolution and growth of your configuration by ordering additional add-on
functions or products as necessary.

Custom License Attributes

Vendor-specific license attributes can be defined and included as part of the license
information when a license is created. When the license is granted, the attribute
data is passed to the enabled application.

Three general purpose attributes can be used in License Use Management Runtime.
These are specified with the -A parameter of the LUMIct - License Creation Tool,
(described in Using License Use Management Runtime Application Developer’s Toolkit):

1. Custom attribute 1
2. Custom attribute 2
3. Custom attribute 3
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These attributes can be exploited by a vendor to enforce any specific policy.
License Use Management Runtime only records the attribute and makes it
available to the vendor’s application upon request.

Release Dependent Key

The vendor can enable a product so that different product versions can use the
same license certificate. In particular older product versions can run if a license for
a new product version is enrolled. This policy is applicable only to simple
nodelock, concurrent, and concurrent-offline licenses.

Customer Controlled Policies

The customer can use the license policies hard stop/soft stop and user access
restriction.

Hard Stop/Soft Stop

The vendor can enable a product so that you can choose the behavior of the
product when the end user starts it and no licenses are available.

If no license is available, one of two things can happen:

* The product does not start, and there is no way for the end user to go on (hard
stop policy).
¢ The product starts (soft stop policy).

When you enroll a product enabled for hard stop/soft stop, the default is hard
stop. To use soft-stop, you must enable a network license server with the correct
option. You can use the basic license tool to change the policy to soft stop and back
in. For details, see [“Scenario 7: Using the Hard Stop/Soft Stop Policy” on page|
76

When the soft stop policy is set, License Use Management Runtime keeps track of
the high-water mark. The high-water mark is the maximum number of licenses that
are ever granted for a given product beyond the number of licenses that are
enrolled for that product. You can see this number through the basic license tool,
and you can reset it to zero. Use this number to help you decide the number of
additional license keys you need. When the hard stop policy is selected, the
number of in-use licenses cannot exceed the number of enrolled licenses, so the
high-water mark is not maintained.

While for CMU licenses the vendor can decide to let the user exploit the License
Use Management Runtime hard stop/soft stop policy, VMU application vendors
can decide to have a soft stop policy that is under the full control of the enabled
application itself.

User Access Restriction

The License Administrator can grant or deny usage of a product to specific users
or specific groups through the basic license tool graphical user interface or
command line. This applies only to concurrent and concurrent-offline products. For
concurrent-offline products the authorization can also be based on the end-user
machine target ID and optionally secured by a password.

In addition to the authorization method, you can use the user file to control which
users have access to licenses for specific products. The user file is a flat American
National Standard Code for Information Interchange (ASCII) file that you create
using a text editor. For each product in the file, there is a list of users. It lists either
those who are allowed to use the product (in which case no one else can use it) or
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those who are not allowed to use it (in which case anyone else can use it). Should
a certain user be defined with both methods, the user file authorization method
overrides the basic license tool method.

For details, see [’Scenario 8: Restricting User Access” on page 78

License-Enabling Models

The product vendor can create license-enabled products that use nodelocked or
network licenses.

Nodelocked license-enabled products (non-runtime-based)

If the vendor chose nodelocked non-runtime-based enabling, the product does not
make use of License Use Management Runtime on the workstation where the
product runs. Following the vendor’s installation instructions, you might be
required to store the password for such a product in a vendor-selected nodelock
directory. When you start the application, it checks the nodelock directory to
ensure that you have a valid license. Information about use of the product is not
logged. You cannot use the basic license tool to view information or get reports
about the product and its usage.

Network license-enabled products (non-runtime-based)

A non-runtime-based network license-enabled product does not make use of
License Use Management Runtime on the workstation where the product runs and
requires manual configuration on that workstation. The licenses are stored on one
or more network license servers. When the user at a client starts a licensed
program, the license server determines whether or not a license is available.

Network license-enabled products (runtime based)

A runtime-based network license-enabled product makes use of License Use
Management Runtime on the workstation where the product runs and requires
some limited configuration on that workstation. The licenses are stored on one or
more network license servers. When the user at a client starts a licensed program,
License Use Management Runtime at the license server determines whether or not
a license is available.

summarizes the license-enabling models, license types, and license policies.

Table 3. License Types and Policies Available for License Use Management Runtime

Products
License-Enabling Model License Types Available License Policies Available
Nodelocked license-enabled | Simple nodelocked @Try-and-buy
products @License annotation
@Capacity
@Release Dependent Key
@Custom Configuration
Network license-enabled Concurrent @Hard stop/soft stop
products (runtime and @Multiuse rules
non-runtime-based enabling) @User access restriction
@License annotation
@Capacity
@ Value units
@Release Dependent Key
@Custom Configuration
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Table 3. License Types and Policies Available for License Use Management Runtime
Products (continued)

License-Enabling Model License Types Available License Policies Available
Reservable @Hard stop/soft stop (wWhen
unreserved)

@User access restriction
@License annotation

Use-once @User access restriction
@License annotation

Per-seat @Hard stop/soft stop
@License annotation

Concurrent-offline @Hard Stop/Soft Stop (if
used as concurrent)

@User access restriction
@Multiuse rules (if used as
concurrent)

@License annotation
@Release Dependent Key
@Custom Configuration

Note: Custom license attributes are available for any license type.

Scalable Installation

License Use Management Runtime consists of separate installable features, so that
you can install exactly what you need on each workstation. When you install
License Use Management Runtime, the command-line interface is always installed.
There is an optional graphical user interface which can be installed on all
platforms

For example, in AIX 5.3, all required License Use Management Runtime features
are automatically installed on every AIX workstation as part of the AIX 5.3
installation. You can install optional features, such as the graphical user interface,
either when you install AIX or later.

Creating Licenses

License Use Management provides a tool that creates product licenses for the use
of vendors who create license-enabled products. The tool enables vendors to create
these kinds of passwords:

* Test passwords, for use in testing while enabling a product

* Production passwords, to deliver to customers

Distribution of production passwords to customers depends on the use control
level of the license-enabled products:

For customer-managed use control products, the customer receives the license
password together with the product package.

For vendor-managed use control products, for IBM license-enabled products, the

customer requests the license password from the IBM country software password
distribution center. For non-IBM license-enabled products, the customer requests

the license password from the vendor software password distribution center.

12 Using License Use Management Runtime



Creating Licenses

Note: The LUMIct license creation tool is not included in the toolkit or the runtime

package or the application developer's toolkit. If you need to create test
passwords while enabling a product you should contact LUM Support
(Tumhelp@it.ibm.com).You can not use LUMIct with parameters -F and -C in
the same time.

For details about how to use this tool, see Using License Use Management Application
Developer’s Toolkit.

Administering Licenses

Use the basic license tool to administer licenses.

The basic license tool has a command-line interface and a graphical user interface
on all platforms.

The tool enables you to do the following:

Manage network licenses.

Add licenses to or delete licenses from the network license server database;
update information about existing customer-managed use licenses.

Display a notebook of information about the licenses installed for each product.

Manage authorizations for the usage of concurrent and concurrent-offline
licenses.

Extract licenses from a compound password and distribute them among the
network license servers available on the network.

Manage the reservation of reservable licenses for the exclusive use of certain
users.

Manage multiple network license servers. From any properly configured
workstation, you can view and manage licenses that are installed on any
network license server in the network.

Monitor license server’s workload, set load thresholds and enable trace mode for
debugging reasons.
Generate the following reports:

Standard Event Report. Displays detailed information about significant events
that occur on the license servers that you specify.

License Request by Product Report. Displays statistical information about the
use of the licenses of a product in the time interval that you specify. For each
product, it reports the licenses that were requested, the licenses that were
granted, and the percentage of rejections.

License Request by User Report. Displays statistical information about the use

of products by users in the time interval that you specify. For each user, it

reports the licenses that were requested, the licenses that were granted, and the

percentage of rejections.

License Use by Product Report. Displays statistical information about the use of

the licenses of a product in a specified time interval. For each product, it reports:

— The maximum number of nodes that used licenses for the product at the
same time

— The maximum number of users that used licenses for the product at the same
time

— The average time the licenses were in use
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License Use by User Report. Displays statistical information about the use of
the licenses by each user in a specified time interval. For each user, it reports the
times the user requested licenses and the length of time the user kept the
licenses in use.

Customer-Managed Use Audit. Reports the following information for
customer-managed use product transactions:

— Vendor name

— Product name

— Product version

— Product features

— Administrator information
— Time stamp

— Number of licenses

— Transaction type (for example, product enrolled, license distributed, license
deleted, license updated, and high-water mark changes)

— Signature stamp (user, group, and node)
— Signature information

* Use the high-water mark. When the soft-stop policy is in effect, the high-water
mark is recorded in the licensing database. The high-water mark is the
maximum number of licenses that are ever granted for a given product beyond
the number of licenses that are enrolled for that product. You can see this
number through the basic license tool and can reset it to 0. This number assists
you in deciding how many additional licenses you need. When the hard stop
policy is selected, the number of in-use licenses cannot exceed the number of
enrolled licenses, so the high-water mark is not maintained.

* Set a threshold percentage of licenses. If more than the threshold percentage of
licenses for a product are in use, messages about the level of usage are logged.
There is a single threshold that applies to all vendor-managed products. You can
change that threshold, and you can also set a separate threshold for each
product.

* Exercise customer-controlled policies. You can switch between hard stop and soft
stop and manage the identifiers of application clients using per-seat licenses.

+ Administer high-availability licensing (see [“High-Availability Licensing”). That
is, create clusters, activate and deactivate members of clusters, and show cluster
status.

For heli on using the basic license tool, see [‘Performing Basic Administration” on|

High-Availability Licensing

High-availability licensing enables you to set up an environment in which there is
a very high degree of certainty that concurrent licenses will be available, even if a
network license server goes down.

When you use this option, you create a cluster of network license servers. A cluster
is a group of from 3 to 12 network license servers that jointly serve
vendor-managed concurrent licenses that are enrolled on the cluster rather than on
an individual server.

You can create and administer a cluster, and administer high-availability licenses,
from any workstation.
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While some servers in the cluster are serving licenses, one or more servers remain
in reserve, ready to take over should an active server fail.

Each active server serves an equal share of the licenses enrolled on the cluster.
When a server becomes unavailable and another server takes its place,
responsibility for the licenses is automatically redistributed among active servers.

For high-availability licensing to work for a particular product, the product vendor
must supply a password tied to a cluster rather than to an individual target server.

High-availability licensing works only with the Internet Protocol (IP). Before you
decide to use high-availability licensing for a product, make sure that such a
password is available from the product’s vendor.

High-availability licensing is recommended only for users who are already

experienced with managing individual license servers and who already have a
stable licensing environment working.

For planning information, see [“Planning Clusters for High-Availability Licensing”|
For an example, see |“Creating a Cluster” on page 86

Note: Only normal network concurrent licenses can exploit HAL.

Note: Due to incompatibility between HAL cluster members 5.1.1 and HAL cluster
members 5.1.0 of License Use Management Runtime, creating a cluster using
a mixed server environment is not recommended. The mixed mode
environment results in unstable HAL operation. All HAL cluster members
have to be 5.1.1 or higher.

Backing Up Databases and Files

On license servers, there is an automatic backup procedure for License Use
Management Runtime databases and files. See [“Using the Built-In Backup and]
[Recovery Procedure” on page 151

Working with Licensed Products

This section explains what happens when a user starts a licensed product,
depending on how the product is enabled.

Only C, C++, and Java programs can be license-enabled.

In the figures and text in this section, references to the enabled application refer to
the application plus the embedded code that services the API calls (which carries
out the described steps).

This section assumes that, if required:

* License Use Management Runtime is installed properly.

* License Use Management Runtime is configured properly.
* The network is running properly.

If not, what happens depends on how the vendor enabled the product. See the
product documentation for details.
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Central Registry License Server

Some of the scenarios in this section show the use of a central registry license server.
The central registry is a repository of information that all the other network license
servers can use. If you plan to install customer-managed use products with
network licenses, or products with reservable licenses, you must identify one (and
only one) central registry. Otherwise, the central registry license server is not
required.

The central registry can contain:

* A record of all per-seat licenses

* The list of application clients to which per-seat licenses have been granted
* A record of soft stop license use

e The high-water mark

* Reserved licenses

Working with Nodelocked Licenses (Non-Runtime-Based
Enabling)

shows what happens when an end user calls an application with
nodelocked licenses for which the vendor chose non-runtime-based enabling. The
licenses must be simple nodelocked licenses.

1
e
Enabled
3 Application
4

Figure 1. Using a Nodelocked License (Non-Runtime-Based Enabling)

Nodelock
Directory

1. The end user calls the application.

2. The application checks the nodelock directory to ensure that a license is stored
on the local system.

3. If there is a valid license in the nodelock directory, the application runs. If not,
depending on how the vendor enabled the application, it might return
information to the end user, or it might run even with no license available.

Working with Use-Once Licenses

[Figure 2 on page 17| shows what happens when an end user calls an application
with use-once licenses.
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Working with Use-Once Licenses
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Figure 2. Using a Use-Once License

1. The user calls the application.
2. The application requests a license from the network license server.

3. The network license server checks its license database for an available license
and the proper authorization.

4. The network license server returns the status of the request to the application.
If a license is found and granted, the application runs, and one license is
subtracted from the number of available use-once licenses.

5. If no license can be granted, depending on how the vendor enabled the
product, the application might return information to the end user, or it might
run even with no license available.

Working with Concurrent Licenses

[Figure 3 on page 18|shows what happens when an end user calls an application
with concurrent licenses.
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Working with Concurrent Licenses
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Figure 3. Using a Concurrent License

1. The user calls the application.
2. The application requests a license from the network license server.
3. The network license server checks the following;:

* The license server for an available license.

* Its license database for an authorization record that allows a request for that
license for the user and group specified in the client request.

4. The network license server returns the status of the request to the application.
If a license is found and granted, the application runs.

5. If a network license is not available and the application implements the soft
stop policy, the application requests a soft stop license.

6. The central registry license server checks its database for a soft stop license and
the user file for authorization.

7. The central registry license server returns the status of the request to the
application. If a soft stop license is granted, the application runs.

8. If no license can be granted, depending on how the vendor enabled the
product, the application might return information to the end user, or it might
run even with no license available.

Working with Concurrent-Offline Licenses

[Figure 4 on page 19| shows what happens when an end user calls an application
with offline licenses.
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Working with Concurrent-Offline Licenses
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Figure 4. Using a Concurrent-Offline License

1. The user calls the application.
2. The application looks for an offline-nodelocked license in its nodelock directory.
If a license is found and is valid, the application runs.

3. If the application does not find a license in the nodelock directory and the
portable computer can reach a License Use Management network license server,
the application requests a concurrent-offline license from it.

4. The network license server checks if the license has an authorization for the
user, group, or for the target ID of the machine, and validates the password
provided by the user.

5. If the authorization is for a concurrent-offline license, the server creates an
offline-nodelocked license and copies it to the nodelock directory of the
portable computer. The license is marked as in use on the server.

6. The application checks that the nodelock directory contains a valid license and
the application starts. The application can now run without a connection to the
License Use Management network license server (that is, the application can
run on a portable computer).

Note: At the end of the reservation period, the copy of the license stored in the
nodelock directory of the portable computer expires (the license can also be
returned by the user before the reservation period expires). The license can
be used by another user both as a normal concurrent license and as a new
offline-nodelocked license.

Working with Reservable Licenses

[Figure 5 on page 20| shows what happens when an end user calls an application
with reservable licenses.
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Working with Concurrent-Offline Licenses
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Figure 5. Using a Reservable License

10.

11.

The user calls the application.

The application requests a reserved license from the central registry license
server.

The central registry license server checks its database for a reserved license
and the user file for authorization. This is a license that you reserved for the
user, group, and node.

The central registry license server returns the status of the request to the
application. If a reserved license is found and granted, the application runs.

If a reserved license is not found, the application requests a reservable license
from the network license server. This is a reservable license that you have not
reserved for anyone.

The network license server checks its license database for a reservable license
and the user file for authorization.

The network license server returns the status of the request to the application.
If a reservable license is found and granted, the application runs.

If a reservable license is not found, and the application implements the soft
stop policy, it requests a soft stop reservable license from the central registry
license server.

The central registry license server checks its database for a soft-stop reservable
license and the user file for authorization.

The central registry license server returns the status of the request to the
application. If a soft stop license is granted, the application runs.

If no license can be granted, depending on how the vendor enabled the
product, the application might return information to the end user, or it might
run even with no license available.

Working with Per-Seat Licenses

[Figure 6 on page 21| shows what happens when an end user calls an application

with per-seat licenses when per-seat has been enabled. In the figure, the
application server is license-enabled.
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Working with Per-Seat Licenses

Application Central

Registry

Server .
License Server

Central

Reagistry
License
Database

Figure 6. Using a Per-Seat License

1. The application client user calls the application.

2. The application server requests a per-seat license from the central registry
license server on behalf of its application client.

3. The central registry license server checks whether a license is already being
used by the requesting application client, possibly granted through another
application server. In such a case the application can start without having a
new license granted. Otherwise, the central registry license server checks
whether a per-seat license is available. If so, it grants the license and records
the application client identifier. If no per-seat license is available, but the
application implements the soft stop policy, the central registry license server
checks for a soft stop license.

4. The central registry license server returns the status of the request to the
application server, and the application runs.

5. If no license can be granted, depending on how the vendor enabled the
product, the application might return information to the end user, or it might
run even with no license available.
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Working with Per-Seat Licenses
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Chapter 2. Planning Network Licensing

This chapter is for the administrator who is setting up an environment to allow
multiple client workstations to share licenses stored on one or more network
license servers. Skip this chapter if both of the following are true:

* You are using applications with nodelocked licenses only

* You do not intend to use the basic license tool from one workstation to
administer licenses on other workstations

Designing the network licensing environment that provides the best solution for
your business requires careful and thoughtful planning. This chapter will assist
you, as the system administrator, to plan the environment for network-licensed
products and to decide on the configuration options you need.

It is important that you allow enough time for planning, especially when using
License Use Management Runtime in large networks or across subnetworks.

The decisions you need to make include the following:

* How many network license servers you will set up

* Which workstations, if any, will be the network license servers

* How you will distribute product licenses among the network license servers
* Which clients will have access to which servers

* How clients will locate the servers

¢ Whether all servers will serve all clients, or whether you will set up independent
groups of servers and clients

* Which workstation will be the central registry (if required)

* Whether you will make use of License Use Management Runtime
high-availability licensing; and, if so, which network license servers will be part
of a cluster

¢ Whether and how you will make use of remote administration to administer
from one workstation the network licenses on other workstations

¢ Whether your network will be configured with firewalls.

Selecting Your Servers

The license server system depends on a stable network. If name resolution and
routing in a network are not running properly, then the network license servers,
network license clients, and central registry license server might be unable to
communicate properly.

In designating workstations to be network license servers or the central registry
license server, keep the following criteria in mind:

* A license server should be a computer that stays on at all times. Workstations
that are frequently unavailable or unreliable, such as those that are brought
down often for testing or maintenance, are not good candidates.

* It is important to keep license servers for production environments separate
from those for test environments.
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* If you have multiple subnetworks, then ideally, the servers should be on the
same subnetwork as the majority of clients that will run the licensed products.
Accessing in another subnetwork, across a bridge or router, might not be quite
as fast.

If the network spans subnetworks, you need to spread the licenses out among
network license servers. Also, inside the same network, each client request for a
license generates network traffic. Therefore, it can be useful to spread the
application licenses across more than one network license server, and across
multiple platforms. When a computer is down, the licenses assigned to the
network license server on that system are unavailable, but licenses assigned to
other network license servers remain available. Having several license servers on
the network will help to prevent bottlenecks that result when many clients
communicate with a single network license server.

The number of network license servers in the network should be proportional to
the frequency of license requests rather than to the number of users. For example,
suppose that a compiler and a word processor are both license-enabled. A single
user running many short compilations will place a heavier load on the license
server than many users each starting the word processor once.

Computers that function as network license servers or as the central registry can
also run the license-enabled products. The license server software does not have a
noticeable effect on the performance of products.

When you have identified the network license servers, and before you configure
them, you must organize the servers into one or more groups. The servers in a
group form an independent licensing environment and serve a common set of
clients. You must also identify a central registry license server for the group, if it
requires one. [“Using Direct Binding”| will help you to group your servers.

Using Direct Binding

ALL

License Use Management Runtime provides the direct binding network
configuration to enable clients to locate (or bind to) the network license servers and
the central registry.

Make a list of your network license servers and the central registry. The list is
called the direct binding servers list in this chapter and in the configuration scenarios
in [“Setting Up Your Servers and Clients” on page 51

During configuration of servers and clients, you specify the network addresses of
all the servers on the list. The network addresses are stored on every server and
every client in a configuration file.

All network license servers, and the central registry license server, listen for
incoming communications on ports:

Table 4. Communication Ports Used

Protocol Ports Operating Environments and Systems
UDP/IP 2215, 10998 AIX, Windows XP, Windows Server 2003 and
Solaris
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The network license client uses these port numbers, together with the network
addresses of the server systems that are specified in the configuration file, to locate
and connect to the servers.

In addition to enabling clients to locate license servers, the direct binding
mechanism makes it possible, from any license server, to use the basic license tool
remotely to administer licenses on all the servers in the direct binding list.

Performance Considerations

Assuming that licenses are equally spread over all the license servers and that all
servers belong to the same licensing environment, keep in mind that workload
balance is not automatic. The license system administrator must simulate it
arranging the clients’ Direct Binding list so that each license server occupies
different positions on the same number of clients.

In all cases in which there is discretion in deciding the order of the servers,
consider the following:

* What has to be balanced is not the number of client workstations, but the
number of application clients; if more than one enabled application runs on a
workstation this must be taken into account.

* The frequency of license requests and license checks is relevant. That is,
applications that frequently request and check licenses impact server
performance more than applications that request and check licenses in longer
time intervals. Fast applications that are frequently run belong to this category.

e In a normal environment, clients reach servers on the same subnetwork more
quickly.

On the client side, clients are configured in direct binding only. Workload
balancing over multiple servers is not automatic, you must simulate it. This can be
done by varying the order of the servers in the clients” direct binding list so that
the servers occupy different positions on the same number of clients. This scenario
makes sense if some clients need to contact only a subset of the license servers in
the licensing system. These clients might be configured to contact only the servers
they actually need to reach.

Planning Direct Binding

ALL

Before you begin configuring workstations, be sure you have identified all the
servers in your direct binding servers list and refer to the configuration scenarios
in“Setting Up Your Servers and Clients” on page 51| As you configure direct
binding at each server and at each client, be sure you enter exactly the same list of
servers.

It is important that the direct binding servers list include all the servers, and that it
excludes workstations that will not function as servers. If there are any
workstations that are not servers in the list, there will be a noticeable effect on
performance.

When a network license client requests a license, and multiple servers have
licenses for the product, the servers are checked for an available license in the
sequence in which they were entered into the direct binding servers list during
configuration of the client. Therefore, if you know how frequently specific network
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license clients will request licenses for specific products, you might be able to
balance the workload of the servers by varying the sequence in which servers are
defined at different clients.

If all the licenses requested by a particular network license client are to be supplied
by a subset of the servers, when you configure the client you might configure
direct binding with just those servers, rather than all servers in the direct binding
servers list. This will improve performance. If you configure the client in this way,
make sure that it is configured to communicate with the necessary servers;
otherwise, it will not obtain licenses.

Planning the Central Registry

ALL

The central registry license server subsystem provides a mechanism for storing
licensing information in a database common to all the servers. It is used for the
administration of customer-managed use products and products with reservable
licenses. Only one central registry subsystem must be running in a direct binding
servers list. This ensures that the data is accurate and complete.

Notes:

1. Use the configuration tool to specify where to start the central registry.

2. Select the node where you will run the central registry carefully. After you
place the central registry on a node, it cannot be moved.

3. The workstation running the central registry must be up and running in order
to perform administration tasks on network customer-managed products or on
products using reservable licenses.

Planning Clusters for High-Availability Licensing

High-availability licensing is recommended only for users who are already
experienced with managing individual license servers and who already have a
stable licensing environment working.

For high-availability licensing, you set up clusters of network license servers
connected through TCP/IP. For concurrent licenses with vendor-managed use
control only, the software vendor generates passwords that are bound to the cluster
rather than to a single server. Some of the servers in a cluster serve licenses, while
others wait in reserve to take over in case a serving server goes down. The servers
that are serving at any time share equally the responsibility for the licenses that are
bound to the cluster, and keep one another informed about the status of the
licenses.

You can create and administer a cluster, and administer high-availability licenses,
from any workstation.

A network license server that is a member of a cluster can serve licenses that are
bound to the server, and participate as a member of a cluster at the same time.

Restrictions on Cluster Size and Composition

For security reasons, it is necessary to impose strict rules on the size and
composition of clusters.
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Attention: Be very careful when you decide how many and which servers to put
in a cluster. You will not be able to change your decisions after the fact
and they will affect the size and composition of the cluster as long as it
exists.

When you create a cluster, you specify the initial number of servers in the cluster,
and which servers they are. The initial number must be in the range 3 through 10.
The first server assigned to the cluster is automatically activated; that is, it is
available to participate in serving licenses as part of the cluster. You must explicitly
activate the other members.

The initial number of servers dictates two important attributes of the cluster:

¢ The minimum number of servers that must be activated in the cluster for the
cluster to work

¢ The maximum number of servers that can be added to the cluster in addition to
the initial number

If you want to replace a server workstation that is one of the initial minimum
number, to upgrade the hardware or to replace failing hardware, add a new server
to the cluster. The number of new servers you can add, even to replace other
servers, is limited.

Attention: The initial minimum number of servers must always be in the cluster;
they must not be deactivated. If any is deactivated, the cluster ceases to serve
licenses.

Passwords that are bound to a cluster are usable on only that cluster. If you find it
necessary to delete a cluster and create a new one, or to create additional clusters,
you will not be able to use existing passwords on the new cluster.

Note: To delete a cluster, deactivate all its members. When you deactivate a server,
it must be up and running.

After a cluster has been created and its members have been activated, the number
of activated members determines how many servers must be up and running for
the cluster to function.

The relationships between these cluster attributes is shown in [Table 5 on page 28}

The minimum number of servers up and running, as shown in the table, is the
number of servers that serve licenses. All servers beyond that number are in
reserve, waiting to take over if a serving server goes down.
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Table 5. Number of Servers in a Cluster

Minimum Up

Minimum Maximum and Running

Activated for Added after for Cluster to

Initial Number | Cluster to Work | Cluster Creation | Actual Activated | Work

3 2 1 2 2
3 2
4 3
4 4 2 4 3
5 3
6 4
5 4 1 4 3
5 3
6 4
6 6 2 6 4
7 4
8 5
7 6 1 6 4
7 4
8 5
8 8 2 8 5
9 5
10 6
9 8 1 8 5
9 5
10 6
10 10 2 10 6
11 6
12 7

Examples of Cluster Size Rules

Example 1: Initial number of servers is 3

The following rules apply:

* During the life of the cluster, you can add only one server to the cluster, but the
first two servers declared in the cluster cannot be replaced (due to security
exposure). This means you can add a new server with upgraded hardware, and
deactivate the original third declared server, only once during the life of the
cluster. This scenario has the effect of replacing a server with an upgraded
workstation. Alternatively, you can add a fourth server to the cluster without
deactivating any of the original three, thus increasing the cluster size to four
servers. Again, you can add a server only once.

The relationships between these cluster attributes is shown in

* More than half of the activated servers must be up and running for the cluster
to work.

[Table 6 on page 29 shows how the servers are deployed, depending on how many
are activated, and how many are up and running.
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Table 6. Example - Cluster with Three Initial Members

Number of Activated | Number of Members | Number of Members | Number of Servers
Members Up and Running Serving Licenses In Reserve
2 2 2 0*
2 2 0*
3 3 2 1
3 3 0*
4 4 3 1
* When the number of servers in reserve is 0, there is no high-availability advantage

Example 2: Initial number of servers is 6

The following rules apply:

* During the life of the cluster, you can add two servers to the cluster, but the first
six servers declared in the cluster cannot be replaced (due to security exposure).

Tlhe relationships between these cluster attributes is shown in [Table 5 on page|

* Whether the cluster has six, seven, or eight members, at least six members must
be activated for the cluster to work.

* More than half of the activated servers must be up and running for the cluster
to work.

shows how the servers are deployed, depending on how many are
activated, and how many are up and running.

Table 7. Example - Cluster with Six Initial Members

Number of Servers

In Reserve
0*
1
2
0*
1
2
3
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1

2
3

Number of Members
Serving Licenses

Number of Members
Up and Running

Number of Activated
Members
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* When the number of servers in reserve is 0, there is no high-availability advantage

Cluster Membership Considerations

If you want to take full advantage of the high availability of licenses, make sure
the following have the cluster servers in their direct server binding lists:

1. The network clients that will use licenses bound to the cluster
2. All the servers of the cluster

If you use HAL with remote administration disabled, there are some important
points to take into consideration:
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* All cluster members must adhere to the same remote administration policy (that
is, either all disabled, or all enabled).

¢ From a remote administration point of view, the cluster behaves as a single
server.

* If remote administration is disabled, it is not possible to enroll or delete licenses
from a machine that is not a cluster member.

* A cluster can be created only if the request comes from the local node. Cluster
members can be deactivated only from another cluster member.

A server can be activated in only one cluster at any time. If you assign a server to
a cluster and never activate it, or explicitly deactivate it, it can join a second cluster
and be activated there. But in this case, the server cannot be activated in its
original cluster, and no other server can be substituted in the original cluster. To
reactivate the server in its original cluster, you must first deactivate it in the second
cluster.

Note: Either disable or enable remote administration on all servers. If you enable
or disable it only on some servers, you might have problems enrolling and
removing licenses bound to the cluster.

Note: Due to incompatibility between HAL cluster members 5.1.1 and HAL cluster
members 5.1.0 of License Use Management Runtime, creating a cluster using
a mixed server environment is not recommended. The mixed mode
environment results in unstable HAL operation. All HAL cluster members
have to be 5.1.1 or higher.

Firewall Support

If a server runs behind a firewall with respect to the client side, the client-server
communications are prevented. This method increases the level of security on
those special company assets which are represented by the LUM License Electronic
Certificates. In this way nobody outside the Local Area Network of the company
that purchased the certificates can have a license granted from the company server.

[Figure 7 on page 31|shows an example of a network configuration that uses a
firewall. The example shows a network consisting of a network license server and
three network license clients on the protected side of a firewall, and two network
license clients on the unprotected side of a firewall.
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Figure 7. Direct Binding with Network License Servers, Firewall, and Network License Clients

License server communications take place on two ports. The main server port is
defined (ipPort in the configuration file), however, server responses to client
requests for authentication take place on a secondary, randomly chosen, port. This
is why client/server communications cannot take place through a firewall. If the
port number is defined, communications can take place through a firewall, once
the firewall administrator has applied proper rules to UDP packets flowing
to/from the license server on that port number.

Firewall support has been introduced, based on the customization of the server
authentication port. This is represented by a new ipAuthPort= tag in the
configuration file. By default the port number is randomly chosen, but if a specific
value is set then the authentication server port will be fixed to that value, for
example:

ipAuthPort=2216

Using this method, it is possible to install the LUM license server inside the
company LAN, protected by the firewall, and to enable the incoming connections
of LUM clients from, for example, a DeMilitarized Zone (DMZ), by opening the
firewall on the two ports used by the server. Packets directed the opposite way,
from the LAN to the DMZ, must not be filtered by the firewall.

When configured to support clients through a firewall License administration is
permitted only when the basic license tool is run on the same machine as the
license server. When multiple servers are connected to set up a High Availability
Licensing cluster environment, all the server members of the cluster must be
placed in the same side of the firewall.
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The main server port number can be changed through the panels of the LUM
Configuration tool or its command line interface. However, the authentication port
number can be changed only by editing the lum_ini.txt configuration file.

Only the network license server can use firewall support, the central registry
license server is excluded from using a firewall.

Note: Support is not included for configurations where the firewall includes
dynamic network address translation (NAT) or dynamic port address
translation (PAT).

Verifying Network Connections

License Use Management Runtime provides the LUMtv tool to verify that network
license servers, and the central registry, are running properly. For information on
how to use the tool, see ['LUMtv - Test Verification Tool” on page 144
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Chapter 3. Installing License Use Management Runtime

This chapter is intended for administrators that are using license-enabled products
and for software programmers who are developing license-enabled products. The
following sections show you how to install License Use Management Runtime on
AIX and Windows.

Attention: If any other license management product is installed on the machines in
your environment, you must be aware of certain requirements before
you install. Be sure you read [Chapter 2, “Planning Network Licensing”]
carefully. Considerations for coexistence with other license management
products are in the section [Selecting Your Servers}

Installing License Use Management Runtime on AIX 5

The License Use Management Runtime base code is included in the basic operating
system components installed on every machine that runs AIX 5.2.0.30. This section
shows you how to install the latest version of License Use Management Runtime
on AIX 5.

Note: If the License Use Management Runtime code is incorporated in the
license-enabled product, you can install License Use Management Runtime
packages as part of the installation of the licensed product, rather than by
using the procedures in this section.

Before Installing License Use Management Runtime Packages

This section identifies the components of License Use Management Runtime and
gives their disk space requirements. It also gives the hardware and software
requirements for License Use Management Runtime. This section explains how to
determine the level of License Use Management Runtime installed on a system. It
explains how to determine whether you need to install License Use Management
Runtime.

License Use Management Runtime Packages, Components, Disk
Space Requirements

Before installing License Use Management Runtime, allocate sufficient disk space
in the /opt file system. identifies the components of License Use
Management Runtime and gives their disk space requirements.

Table 8. License Use Management Runtime Packages, their Components, and their Disk
Space Requirements on AIX 5

License Use Management Runtime
Package Component Disk Space
lum.base.cli Base code and command-line interfacel8 MB
lum base.gui Base GUI 7 MB
lum html.en_US LUM documentation 4 MB

Note: The default directory for these packages is /usr/sys/inst.images
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License Use Management Runtime also requires space in the /var file system for
databases, log files, and trace output. If you are using several licensed products
and there is extensive activity on your system, License Use Management Runtime
might need 10 MB or more in /var.

For an overview of the packages, see [“Installing License Use Management Runtime]

omponents.”]

Hardware and Software Requirements
License Use Management Runtime requires a system that can run AIX 5.2.0.30.

GUI Requirements: Java Runtime Environment, as follows:
* AIX 5.2 requires Java Runtime Environment 1.4.1, or later.

* AIX 5.3 requires Java Runtime Environment 1.4.1, or later.

The License Use Management Runtime Java GUI requires a minimum of 192 MB of
RAM.

Determining the Level of License Use Management Runtime
Installed

If you need to determine the level of License Use Management Runtime Version 5
already installed on your workstation, check the file:

/var/LicenseUseManagement/VERSION

Use the smitty List Installed Software panel. Next to each License Use
Management Runtime fileset:

* 5.1.0.0 indicates License Use Management Runtime Version 5.1.0

¢ 5.1.1.0 indicates License Use Management Runtime Version 5.1.1

Installing License Use Management Runtime Components

This section outlines the content of the License Use Management Runtime
packages, summarizes the installation procedure, and provides instructions on
what to install from which package.

You can install License Use Management Runtime from the AIX installation media.
Before you install License Use Management Runtime packages, make a backup
copy of the originals.

Log in with root authority, and use the smit command to install License Use
Management Runtime from the following packages:

e lum.base.cli. This is the runtime code and the command line interface for the
basic license tool and the configuration tool.

* lum.base.gui. The Java graphical user interface for the basic license tool and the
configuration tool.

The sequence of smit panels to follow is:
1. Software Installation and Maintenance
2. Install and Update Software

3. Install Software

If you do not have a graphical terminal, use the smitty command.
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Setting Up the .profile File

After installation, and before starting License Use Management Runtime, log in
with root authority and check that there is a .profile file. If there is not, create it
and add the following path to the .profile:

PATH=/opt/LicenseUseManagement/bin:$PATH

The default directory for the .profile file of the user root is /. License Use
Management Runtime looks for this file and automatically updates it, if it is found.
However the user root can choose to change the location of its .profile file. In this
case License Use Management Runtime cannot perform the automatic update and
it must be done manually by the user root. A typical path for the root .profile file
is /home/root.

You might also need to add a path for the man pages. For details, see m
[Pages for Command Syntax” on page xii|

Exit and log in again for the changes to take effect.

Uninstalling License Use Management Runtime Packages

This section describes how to remove the License Use Management Runtime
packages from your workstations:

The GUI file sets can be removed without removing the base file sets. Removal of
the base file sets requires the removal of the GUI file sets.

Uninstall the packages and file sets in the following sequence:
1. The License Use Management Runtime GUI, lum.base.gui.

2. The License Use Management Runtime CLI, lum.base.cli.

The uninstallation procedure does not delete the License Use Management
Runtime databases, which are in the /var/LicenseUseManagement/ directory.

Use the smit command to uninstall License Use Management Runtime. If you do
not have a graphical terminal, use the smitty command.

Installing License Use Management Runtime on Windows

E This section is intended for:

* The software vendor who needs to install License Use Management Runtime on
Windows XP or Windows Server 2003 for use in license-enabling a product

¢ The customer of a license-enabled product if the vendor did not incorporate the
License Use Management Runtime features into the product

Before You Install

Read this section to be sure you have everything you need and that you have
made the necessary decisions before installing.

Note: To install License Use Management Runtime, you must log in as a user with
administrator privileges. This ensures that the path and registry information
is updated during the installation. If you try to install License Use
Management Runtime from another user ID, the installation program issues
the message:
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Installation stopped. Only the user administrator can
install License Use Management Runtime.

To determine whether License Use Management Runtime is already installed on
your workstation, refer to the following file:

c:\Documents and Settings\A11 Users\Application Data\IBM\License Use
Management\version

Selecting License Use Management Runtime Features
License Use Management Runtime consists of these features:

* License Use Management Runtime. This contains a sub feature named Java GUL

* Documentation

Install the Documentation feature on any workstation to give you access to the
online Using License Use Management Runtime and Message Reference books, in
.HTML format for viewing with a Web browser.

Hardware Requirements

The hardware requirements for the various Windows platforms are shown in

Table 9. Hardware Requirements

Minimum Suggested

Processor RAM Processor RAM

1.5 GHz Pentium® IV | 512 MB 2.0 GHz Pentium IV |1 GB
or higher

Before installing, make sure that there is enough disk space for the features, as
shown in [Table 10

Table 10. Disk Space Requirements

Feature Requirement
Java GUI 52 MB
License Use Management Runtime 10 MB
Documentation 3 MB

Software Requirements

* One of the following operating systems:
— Windows XP with Service Pack 1
— Windows Server 2003

* For all supported Windows platforms:

— A device driver that complies with network driver interface specification
(NDIS) 4

— The latest level of the device driver. To determine the latest level of IBM
device drivers, see:

[http:/ /www.networking.ibm.com|
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— The LUMtarget executable. If License Use Management Runtime is not yet
installed on the workstation, you can download it from the License Use
Management Web site:

Ihttp: / /www.ibm.com/software/ 1um|

or the vendor of a license-enabled product can supply it to you.
e The TCP/IP transport protocol.

If the prerequisites are not met, the hardware-based target ID is not generated.

Obtaining the License Use Management Runtime Code
1. Download the self-extracting EXE or the compressed equivalent TAR file from:

[http:/ / www.ibm.com /software /lum|
2. Run the self-extracting EXE or uncompress the equivalent TAR file.

Deciding How to Install
Before you install, you need to decide:

+ Whether to install interactively, using the installation GUI (sed”Installing License|
[Use Management Runtime Interactively”)

* Whether to install noninteractively, using the setup command (see |”Installin§|
[License Use Management Runtime Noninteractively” on page 47)

Installation Considerations
Windows Installer is used for installing License Use Management Runtime.

If License Use Management Runtime program files are damaged and need to be
replaced, run the setup program again, and select the Repair option.

Installing License Use Management Runtime Interactively
To install License Use Management Runtime interactively, follow these steps:
1. Log on as Administrator.

2. Shut down any currently running programs, including virus scanning
programs.

3. Start the installation program:

* Switch to the directory to which you have downloaded the code, and run
setup or the self-extracting EXE file.

The Welcome window is displayed (see [Figure 8 on page 38).
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Welcome to the InstallShield Wizard for
License Use Management Runtime v5

The Installshield(R) Wizard will install License Use Management
Runtime v5 on your computer, To continue, dick Mext,

WARMIMG: This program is protected by copyright law and
international freaties,

e | [ Cancel

Figure 8. Welcome Window

4. In the Welcome window, select Next >.

The License Agreement Window is displayed (see [Figure 9 on page 39|
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i License Use Management Runtime v3 - InstallShield Wizard

License Agreement

Please read the following license agreement carefully,

International Program License Agreement ~
Part 1 - General Terms

PLEASE READ THIS AGREEMENT CAREFULLY BEFOEE USING THE
PROGRAM. IEBM WILIL LICENSE THE PROGRAM TO YOU CNLY IF YOU
FIRS5T &CCEPT THE TEEREMS OF THIS AGREEMENT. BY USING THE
PROGRAM YOU AGREE TCO THESE TEERMS. IF YOU DO NOT AGREE TO
THE TERMS OF THIS5 AGREEMENT, PROMPTLY RETURN THE UNUSED b

(%31 accept the terms in the license agreement:
{1 do not accept the terms in the license agreement

(et ][ <Back J[_mewt> J[ Conced |

Figure 9. The License Agreement Window

5. In the License Agreement window, choose I accept the terms in the license
agreement and select Next >.
The READ.ME file for License Use Management Runtime is displayed (see
[Figure 10 on page 40).
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i& License Use Management Runtime v3 - InstallShield Wizard

Readme

- License Use Management Runtime - ”~

For the latest changes to the product information, including updated information
about License Use Management Runtime software requirements, refer to the
file readme.ark located in

the root directory of License Use Management.

Package Content

This License Use Management Runtime package contains the following
components:

4 Mt i~ —

< Back ]| Next > { [ Cancel

Figure 10. READ.ME Window. The text displayed on your monitor might be different from that
shown here.
This file contains an overview of the installation procedure.
6. When you have read the document, select Next >.
The Customer Information window is displayed (see [Figure 11 on page 41).
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i License Use Management Runtime v5 - InstallShield Wizard

Customer Information

Please enter your information.

User Mame:
ITI'u'D"

Qrganization:
|IBM Tivoli Laboratory

[ < Back ” Mext = ] [ Cancel

Figure 11. Customer Information Window

7. Enter your customer details, then click Next >. The Setup Type window is
displayed (see [Figure 12 on page 42).
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5! License Use Management Runtime v5 - InstallShield Wizard X

Setup Type
Choose the setup type that best suits your needs,

Please select a setup type.

() Complete
i All program features will be installed. (Requires the most disk
space.)

Choose which program features you want installed and where they
will be installed, Recommended for advanced users.

< Back ][ Mext = ] [ Cancel

Figure 12. Setup Type Window

8. Choose Complete or Custom setup. If you choose Custom setup, you will be
able to specify the disk drive on which to install License Use Management
Runtime and the features to install.

9. Click Next >.
The Custom Setup window is displayed (see [Figure 13 on page 43).
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ﬁ' License Use Management Runtime v5 - InstallShield Wizard

Custom Setup

Select the program features you want installed.

Click @n an icon in the list below to change how a feature is installed.

Feature Description

License Use Management
Runtime

(=2 ~ | License Use Management Runtime!
= ~ | Documentation

This feature requires 10ME on
your hard drive, Ithas 1of 1
subfeatures selected. The
subfeatures require 52MB on
your hard drive,

Install to:

C:\Program Files\IBMLicense Use Management),

[ Help ] [ Space ] [ < Back ][ Mext = ] [ Cancel ]

Figure 13. Custom Configuration Window

By default, all the features will be installed on the drive on which the
operating system is installed. If you want to install all the features on that

drive, go to step [15 on page 45

If you want to install the features on a different drive, go to step

If you want to install only one or two features, go to step

10. To change the drive on which to install the features, click Change....

The Change Current Destination Drive window is displayed (see
[page 44)).
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i& License Use Management Runtime v3 - InstallShield Wizard

Change Current Destination Folder
Browse to the destination folder,

Look in:

=3 Local Disk {C:) e

[ Ok, i [ Cancel

Figure 14. Change Current Destination Drive Window

11. Select the drive from the Look in drop-down list.

Notes:

a. Specify the drive only. The product is always installed in the Program
Files\IBM\License Use Management directory. Do not specify a folder name
in the Drive letter field.

b. If the Application Developer’s Toolkit is installed on the workstation,
License Use Management Runtime is always installed on the same drive.

12. Click OK.

The Custom Setup window is displayed again, showing the changed drive
information.

If you want to install all the features, continue at step |15 on page 45

13. To not install a feature, click the icon:

=

beside its name.

The feature selection menu is displayed (see Figure 15).

= This feature will be installed on local hard drive.
=28 This feature, and all subfeatures, will be installed on local hard drive.

X This feature will not be avaiable,

Figure 15. Feature Selection Menu
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14. Select the choice This feature will not be available. The icon changes to:

X

to indicate that the feature will not be installed.

15. Click Next >. The Ready to Install the Program window is displayed (see

[Figure 16).

i License Use Management Runtime v5 - InstallShield Wizard

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Badk. Click Cancel to
exit the wizard.

[ < Back ]L Install i [ Cancel

Figure 16. Ready to Install Program Window

16. Click Next >.
The Installing License Use Management Runtime window is displayed (see
[Figure 17 on page 46), and License Use Management Runtime starts to copy
files.
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i& License Use Management Runtime v3 - InstallShield Wizard

Installing License Use Management Runtime v5

The program features you selected are being installed.

Please wait while the Installshield Wizard installs License Use Management
Runtime v5. This may take several minutes.

Status:

(RERRNNRRNRRNRNNRNRRNRRRRARRAE )

Figure 17. Installing License Use Management Runtime Window

If you get the message:
UnabTe to update PATH system variable.

Add the following path manually:

c:\Program Files\IBM\License Use Management\bin;
c:\Program Files\IBM\License Use Management\bin\en_US

Windows has not updated the PATH environment variable, because the sum
of the length of the current environment variable plus the length of the
environment variable would exceed 1024 bytes. See |“Verifying and Updating]
[the PATH Environment Variable” on page 48| for information about how to
manually add the License Use Management Runtime path information.

When installation is complete, the InstallShield Wizard Completed window is
displayed.

17. Click Finish.
You can start using License Use Management Runtime immediately.

18. If you are planning to use the machine in a Windows Terminal Server
environment, run the LUMregister.cmd script (located in the
Windows/Application Compatibility Scripts/Install directory) to register
the DLLs.

License Use Management Runtime is installed on your workstation, and a folder
called License Use Runtime v5 is added to the Programs menu.

After installation you must configure License Use Management Runtime as
explained in [Chapter 4, “Configuring License Use Management Runtime,” on page]
i
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Installing after a Version 5.1.1 Uninstallation

If you uninstall Version 5.1.1, your existing license databases are not deleted. They
remain in the directory c:\Documents and Settings\A11 Users\Application
Data\IBM\License Use Management. If you then re-install License Use Management
Runtime Version 5.1.1, the installation process renames the databases to have an
extension of .old. If you want to use the old databases, follow these steps:

1. Enter the following sequence of commands:

LUMcfg -stop
cd c:\Documents and Settings\A11 Users\Application Data\IBM\
License Use Management
dir

2. Look for the following files in the Documents and Settings\Al1
Users\Application Data\IBM\License Use Management directory list, and if
present, perform the appropriate actions, in the order shown:

Step If these files are Enter the following commands:
present:

1 crpdb.dat.old copy crpdb.dat.old crpdb.dat
crpdb.idx.old copy crpdb.idx.old crpdb.idx

2 licdb.dat.old copy licdb.dat.old licdb.dat
licdb.idx.old copy licdb.idx.old Ticdb.idx

crpdb file migration

* To migrate the crpdb.* file, type the following command:
LUMmig -c

licdb file migration

* To migrate the licdb.” file, type the following command:
LUMmig

Installing License Use Management Runtime Noninteractively

You can use the setup command to install License Use Management Runtime
without being prompted.

You need to be present only to initiate the installation and to restart your
workstation, if necessary, when the installation is complete. No questions are asked
while the installation is running. To install License Use Management Runtime
noninteractively, follow these steps:

1. Make sure that the environment variable LUM_INSTALL_DRIVE is set. To do this,
look in the windows registry at the entry: HKEY_LOCAL_MACHINE -->
SYSTEM --> CurrentControlSet --> Control --> Session Manager -->
Environment.

2. To set the LUM_INSTALL_DRIVE variable, follow these steps:

a. Open Start --> Settings --> Control Panel --> System --> Advanced -->
Environment Variables.

The Environment Variables dialog is displayed.

b. In the System Variables box, click New. In the New System Variable dialog,
add the following information:

* In the Variable Name field, type:
LUM_INSTALL_DRIVE
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* In the Variable Value field, type the installation drive letter; for example,
c.
c. Click OK.
3. Check, in the file Tum.bat, whether the value of the ADDLOCAL parameter is
suitable. If it is not, change it. This parameter identifies the features to be
installed.

4. In a new command prompt window, run Tum.bat.

5. When installation is complete, follow the instructions inkfhapter 4,|
[‘Configuring License Use Management Runtime,” on page 51]

Using the Installation Command
The following syntax shows the parameters accepted by the setup installation
command:

setup /s /v"ADDLOCAL=Runtime,GUI_Runtime,Documentation LUM_SILENT=1 /qn /1 log file"

where:
s Specifies silent installation
\% Indicates that what follows is a command line parameter

ADDLOCAL
Specifies the features to be installed

LUM_SILENT=1
Specifies that installation is to run silently

qn Specifies that the user interfaces not to be displayed during installation

1 log_file
Specifies the log file in which installation information is to be logged

When the installation completes successfully, the message Installation operation
completed successfully is written to the log file.

Verifying and Updating the PATH Environment Variable
Check whether the PATH environment variable contains the following information:

c:\Program Files\IBM\License Use Management\bin;
c:\Program Files\IBM\License Use Management\bin\en_US

If the License Use Management Runtime path information has not been added,
update the PATH environment variable manually, as follows:

1. Click Start --> Settings --> Control Panel --> System --> Advanced -->
Environment Variables.

2. If necessary, delete unused path information. Remember to add any necessary
delimiting semicolon to the end of the original PATH statement.

3. Highlight the system variable PATH. Click Edit. In the Edit System Variable
dialog, add the following information to the end of the PATH variable:

;¢:\Program Files\IBM\License Use Management\bin;
c:\Program Files\IBM\License Use Management\bin\en_US

4. Click OK.
The maximum length of the PATH environment variable is 1024 bytes. Therefore, if

the sum of the length of the current path plus the length of the License Use
Management Runtime PATH information would exceed 1024 bytes, Windows will
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not update the current PATH environment variable. You will then not be able to
run License Use Management Runtime, until you manually update the PATH
statement.

If License Use Management Runtime Fails to Start:

In certain unusual circumstances, the License Use Management Runtime
environment variables are set during installation, but are not propagated to the
system. The product therefore fails to start. If you experience this situation, select
Start --> Settings --> Control panel --> System --> Advanced --> Environment
Variables --> OK. License Use Management Runtime should then start correctly.

Uninstalling License Use Management Runtime

You can remove features of License Use Management Runtime, or the whole
product, from your computer.

Remove License Use Management Runtime features from your workstation, as
follows:

1. Click Start -> Settings --> Control Panel --> Add/Remove Programs. The
Add/Remove Programs window is displayed.

2. Select License Use Management Runtime v5.

3. Click Change.

4. The License Use Management Runtime installer’s Welcome window is
displayed.

5. Click Next. The Program Maintenance window is displayed.

6. Click Modify.

7. Click Next. The Custom Setup window is displayed.

8. Select the features you want to delete. The feature selection menu is

displayed.
9. Click This feature will not be available for each feature to be deleted.
10. Click Next. The Ready to Modify the Program window is displayed.

11. Click Install. When uninstallation is complete, the InstallShield Wizard
Completed window is displayed.

12. Click Finish.
The selected features have been removed from your computer.

Remove the whole License Use Management Runtime product from your
workstation, as follows:

1. Click Start --> Settings --> Control Panel --> Add/Remove Programs. The
Add/Remove Programs window is displayed.

2. Select License Use Management Runtime v5.

3. Click Remove. A window is displayed asking you if you are sure that you
want to remove License Use Management Runtime. Click Yes to confirm. The
Windows InstallShield Wizard deletes License Use Management Runtime from
your computer.

Note: The uninstallation process does not remove configuration files or other files
created after installation. To remove such files, after the uninstallation
process has finished, delete the Program Files\IBM\License Use
Management directory and all its contents.
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Chapter 4. Configuring License Use Management Runtime

ALL

The scenarios in this chapter describe how to set up your License Use Management
Runtime environment.

License Use Management Runtime is not required for non-runtime nodelocked
workstations (see [“License Use Management at a Glance” on page 1)).

Setting Up Your Servers and Clients

After you install License Use Management Runtime, you must configure the
program on each workstation.

The configuration tool has a GUI, and a command line interface. The information
you provide is saved in a configuration file. When you start License Use
Management Runtime, it uses the information in this file to direct the behavior of
the local system in the licensing environment. See |[Appendix A, “License Usel
[Management Runtime Configuration File,” on page 179 for reference information
on the configuration file.

Configuring to Handle Network Licenses

To handle products with network licenses, you must configure at least one network
license server (“Scenario 1: Configuring a Network License Server” on page 55)
and configure each client as a network license client (“Scenario 3: Configuring a|
[Network License Client” on page 60). If you use products with customer-managed
or reservable licenses, you must also configure one server as the central registry
server (“Scenario 2: Configuring the Central Registry License Server” on page 59).

Determining the Required Configuration

You can configure a workstation to play more than one role in your licensing
environment. For example, if you configure the same workstation as a network
license server, and the central registry license server, that workstation can handle
all types of licensed products.

If you know the types of licenses that are used by the license-enabled products in
your environment, [Table 11| will help you to determine how to configure:

* The license servers for the application

* The workstations that will request licenses for the application

See the application documentation for information that might affect your
configuration. The enrollment certificate file that you receive from the vendor shows
the type of license.

Table 11. Configuration Required to Support All Types of Licenses

License Type License Requester License Server

Simple Nodelocked License-Enabled Application |None
(Non-Runtime-Based
Enabling) (note 1)

Use-Once Network License Client Network License Server
(note 2), and Central Registry
License Server (note 3)
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Table 11. Configuration Required to Support All Types of Licenses (continued)

License Type License Requester License Server

Network License Server
(note 2) and Central Registry
License Server (note 3)

Concurrent Network License Client

Network License Server
(note E[) and Central Registry
License Server (note 3)

Concurrent-Offline Network License Client

Per-Seat Network License Client Central Registry License
Server (note 3)
Reservable Network License Client (note | Network License Server
4) (note 2) and Central Registry
License Server (note 3)
Notes:

1. If the vendor enabled the product with simple nodelocked licenses and delivered the

licenses to you in a compound network password, you must also:

* Configure a network license server, where you will install the compound password,

and

¢ Configure the local workstation (where the nodelocked license is to be installed) as a

network license client of that server

You can configure one or more network license servers.

3. You can configure only one central registry license server. For customer-managed use
products, the central registry is required. It enables you to update the count of product
licenses, implement the hard stop or soft stop policy, or track the high-water mark.
Note that because per-seat licenses are always customer-managed, they require the
central registry. For reservable licenses, the central registry is required if you want to be
able to reserve licenses for specific users.

4. No server is required once the reservation has been made.

n

Before You Configure

Before you begin the configuration process, for every workstation you are going to
configure, you need to decide which roles it will play and how you plan to set up
direct binding. You might also decide to override some of the configuration
defaults. The actions you can take during configuration are summarized in

Check the table for all the roles your workstation will play, and make all
the indicated decisions before you start configuration.

Table 12. Configuration Options

Central
Network |Network Registry
License License License
Configuration Options Client Server Server
Customize selection of information logged or Yes Yes
accept default? (“Customizing Log Information”
|0n page 53|D
Start license servers at system startup (default is Yes Yes
no)? (“Automatically Starting License Servers” on|
|Eage 53|D
Disable remote administration of network license Yes Yes
servers (default is no)? (“Disabling Remote]
|[Administration” on page 54)
Set up direct binding (“Configuring Direct|
[Binding” on page 54)
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Table 12. Configuration Options (continued)

Central
Network | Network Registry
License License License
Configuration Options Client Server Server
Have your direct binding servers list ready Yes Yes Yes
Know which workstation is the central registry Yes Yes Yes
Change default direct binding ports? Yes Yes Yes

Customizing Log Information

For any license server, you can customize the selection of events that are logged,
and the location of the log file. Note that if you want to change the location of the
log from the default to a path you choose, the directory you specify must already
exist.

The following events can be logged:
All events Includes all the events in the list.

Errors Describes server errors that do not stop the server, but return a
status code and a message. This is logged by default.

License timeout
Tells you that the server has canceled the request for a license
because the check period expired. This is not logged by default.

License checkin
Tells you when a licensed product has sent a check-in call to the
server to notify that the product is running. This is not logged by
default.

License grant/release
Tells you when a license was granted or released. This is not

logged by default.

Vendor added/deleted
Tells you when a product of a new vendor was registered or
deleted. This is logged by default.

Vendor messages
Provides the log messages the vendor inserted in the enabled

product. This is logged by default.

Product added/deleted
Tells you when a new product was registered or deleted. This is
logged by default.

Server start/stop and load messages
Logs the successful start or stop of the license server, and when the
threshold on the workload is exceeded or regained. This is not
logged by default.

Automatically Starting License Servers

During configuration of any license server, you can specify that license servers
should start automatically when you start the workstation. Otherwise, you must
remember to start the services manually after you configure and before you use the
basic license tool or any enabled applications.
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Disabling Remote Administration

When you configure a network license server, you can specify that licenses stored
on that server can be administered by running the basic license tool on that
machine only.

Configuring Direct Binding
When you configure a network license server, network license client, or central
registry license server, you must have your direct binding servers list ready.

When you configure a network license server, or central registry license server, you
must also have ready a list of license servers whose licenses you want to
administer remotely from this workstation.

You will enter the hostnames or network addresses of all the servers in the list on
the local workstation. You will also designate which server, if any, is the central
registry.

When you configure the servers in the direct binding servers list, and the clients
that will use them, be sure you define exactly the same set of servers on each.

You can change the default port numbers for network license servers and the
central registry license server. Do not change the defaults unless they are already
in use by other applications.

Using the Configuration Tools

ALL To configure License Use Management Runtime, you can use one of the following
tools:

* Configuration Tool graphical user interface
* Configuration Tool command line interface

Using the Configuration Tool GUI
If the License Use Management Runtime graphical user interface is installed on
your workstation, you can use it to configure your workstation.

Login with root authority and issue the command:
LUMcfg

Login with administrator authority and start the configuration tool by one of the
following means:

* Click Start --> Programs --> License Use Runtime v5 --> Configuration Tool.
* In the License Use Runtime v5 folder, click the Configuration Tool icon.

* Enter the LUMcfg command with no parameters.

Gl @

ALL The configuration tool notebook appears. Follow the steps in one or more of the
configuration scenarios in this section, depending on the role of your workstation
in your licensing environment.

Each of the configuration scenarios in this chapter shows how to configure a
workstation to play only one role in the licensing environment. If the workstation
is to play two or more roles, check all the applicable roles on the Configure As
page of the configuration tool notebook.

If you configure a specific page of the notebook more than once, the most recent
configuration takes effect.
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Using the Configuration Tool Command-Line Interface

You can use the LUMcfg command to accomplish the same configuration tasks
explained in the scenarios in this chapter. At the end of each scenario, a section
named "Command-Line Equivalent” shows the LUMcfg commands that
correspond to the GUI scenario.

For details of the LUMcfg command, see [“LUMcfe - Configuration Tool” on page]
140.

Manually Configuring License Use Management Runtime

In addition to the basic configuration tasks described in this chapter, you can also
manually configure License Use Management Runtime by editing the Tum_ini.txt
configuration file. The contents of the file are described in|[Appendix A, “License|
[Use Management Runtime Configuration File,” on page 179. Editing this file lets
you take advantage of the advanced options for fine tuning the server.

Scenario 1: Configuring a Network License Server

This scenario shows how the administrator configures License Use Management
Runtime as a network license server.

When you configure a workstation as a network license server, you can use
licenses of the types shown in [Table 11 on page 51} You can also use the basic
license tool to administer licenses on remote license servers in the network.

To configure the network license server, after installation of License Use
Management Runtime:

1. %rt the Configuration Tool. See [“Using the Configuration Tool GUI” on page

2. On the Configure As page, select Network License Server. Note that Network
License Client is then automatically checked. Leave Disable Remote
Administration unchecked. The Configure As page is shown in
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# LUM Configuration Tool v5

Configure A5
Log |

Metwork License Cliert

] Disable remate administration

[ Central Registry License Server (CrLS)

Canfiguration File: I and seti i ihmili use manage! o

Figure 18. Configuration Tool Notebook - Network License Server

3. On the Start up page, select Start services at system startup to start the
network license server when you power on the workstation.

4. On the Log page, select the events you want to be logged and specify where
you want the log to be kept, as shown in

Log fie depciary | & Déeumerts are Somrgniad Us

Sore Log seage [el[=

Figure 19. Configuration Tool Notebook - Log Page
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The logged events are stored in the files Togdbnn_, where nn assumes the
default values from 00 to 01, but can use other values up to a maximum of 99.
When a file is full, according to a maximum size that is defined in the
configuration file, a new one is started.

5. Select the Direct binding tab. The Direct binding section is displayed, as

shown in

/ LUM Configuration Tool v5

ervers

Configure A

i orirmmer]10998] (CLS)

i:orimmer{2215] (NetworkL )

Log
Direct binding ports
User
Accessiilty
.pEctbinding i
Start up

Server

NetworkLS [] Central Registry LS
NetworkLS Fort 215
LS Port 10858

== Add

Enter here your direct binding servers list

(e ll=s]

Figure 20. Configuration Tool Notebook - Direct Binding Section

On this page you specify all the network license servers in the direct binding
servers list. You must include this network license server that you are
configuring, and the central registry license server, if any. If the central registry
license server and a network license server run on the same workstation, be
sure you include both servers in the list.

As you configure the servers in the direct binding servers list, be sure you
define exactly the same set of servers on each.

In this example, the administrator performs the following steps for each server:

a. In the Name field, enter the TCP/IP host name of the workstation you are
adding to the Servers list. Note that the server name is case-sensitive.

b. If the server being added is a network license server, leave only the
NetworkLS check box selected.

c. Check NetworkLS, or Central Registry LS, or both, depending on the roles
the workstation plays in the network.

Leave the default values in the NetworkLS Port and CrLS Port fields.
Select the <<Add push button to add the server to the Servers list.
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6. On Windows, select the User tab. The User section is displayed, as shown in
- igure 21

/ LUM Configuration Tool v5

User nare | acliinistrator

n
Group name | Administrators v

Figure 21. Configuration Tool Notebook - User Section

The user name is the logon user ID in effect when you do the configuration.
Select a group name if you want to change the default.

License Use Management Runtime treats the user name as the name of the user
who requests and uses licenses on this workstation. The user name is displayed
as part of various reports about license usage. It is also used to reserve
reservable licenses for a specific user. The group name is used to reserve
reservable licenses for a specific group and is also used when assigning
authorizations for concurrent-offline licenses.

7. Select Close from the system menu in the upper left corner of the notebook. A
message is displayed to confirm that you are ready to save your choices.

8. To run the configured servers, see [‘Starting and Listing Your Servers” on page]

Now the workstation can be used as a network license server, to install and grant
product licenses and monitor their usage.

Command-Line Equivalent
ALL To configure the network license server

LUMcfg -a s -S a -e cegvmp -b "'network ip:goldasz'
'registry ip:goldasz'"
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Scenario 2: Configuring the Central Registry License Server

This scenario shows how the administrator configures the central registry license
server, making it part of a direct binding servers list.

Be sure you configure only one central registry license server. Carefully plan where
to configure it; after you start it, you cannot move it. (See [“Planning the Centrall

[Registry” on page 26

Configuring a workstation as the central registry license server makes it possible to
use licenses of the types shown in [Table 11 on page 51| It also makes it possible to
use the basic license tool to administer licenses on remote license servers in the
network.

To configure the central registry license server after installation of License Use
Management Runtime:

1. %rt the Configuration Tool. See [“Using the Configuration Tool GUI” on page|

2. On the Configure As page, select Central Registry License Server. Network
License Client is then automatically checked. The Configure As page is shown

in [Figure 22,

/ LUM Configuration Tool v5

Configure A5

" TR
__ Accessihilty_
Direct binsling

Direct binding ports

L

—

[ Hetwork License Server (MetworkLS)

[Certral Registry License Server (CrLZ]

Configuration File: [ and sett icati i use managei | ‘)

Figure 22. Configuration Tool Notebook - Central Registry License Server

3. On the Start up page, select Start services at system startup to start the central
registry license server when you power on the workstation.

4. Select the Direct binding tab. The Direct binding section is displayed, as
shown in [Figure 20 on page 57}
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On this page you specify all the license servers in the direct binding servers
list. You must include the central registry license server that you are
configuring. If the central registry license server and the a network license
server run on the same workstation, include all servers in the list.

As you configure the servers in the direct binding servers list, be sure you
define exactly the same set of servers on each.

In this example, the administrator performs the following steps for each server
with which this server will communicate: Make sure that the following are set:

a. Check NetworkLS, or Central Registry LS, or both, depending on the roles
the workstation plays in the network.

b. Leave the default values in the NetworkLS Port and CrLS Port fields.
C. Select the <<Add push button to add the server to the Servers list.
5. On Windows, select the User tab. The User section is displayed.

The user name is the logon user ID in effect when you do the configuration.
Select a group name if you want to change the default.

License Use Management Runtime treats the user name as the name of the user
who requests and uses licenses on this workstation. The user name is displayed
as part of various reports about license usage. It is also used to reserve
reservable licenses for a specific user. The group name is used to reserve
reservable licenses for a specific group, and is also used when assigning
authorizations for concurrent-offline licenses.

6. Select Close from the system menu in the upper left corner of the notebook. A
message is displayed to confirm that you are ready to save your choices.

7. To run the configured server, see|“Starting and Listing Your Servers” on page|

Now the workstation can be used as the central registry license server.

Command-Line Equivalent

ALL To configure the central registry license server:

LUMcfg -a r -S a -e cegvmp -b "'network ip:1ab15099 ip:rocky ip:coyote ip:sprint'
'registry ip:1ab15099'"

Scenario 3: Configuring a Network License Client

This scenario shows how the administrator or the end user configures License Use
Management Runtime as a client of the network license servers configured in
[‘Scenario 1: Configuring a Network License Server” on page 55)and of the central
registry license server configured in[“Scenario 2: Configuring the Central Registryl|
[License Server” on page 59 Configuring a workstation as a network license client
makes it possible to use licenses of the types shown in [Table 11 on page 51|

This scenario shows the steps the end user follows to configure the network license
client after installation of License Use Management Runtime.

1. Start the configuration tool. See [“Using the Configuration Tool GUI” on page

54.! The Configuration Tool notebook is displayed, as shown in [Figure 23 on]
age 61

60 Using License Use Management Runtime



/ LUM Configuration Tool v5
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Figure 23. Configuration Tool Notebook - Network License Client

2. Select the Direct binding tab. The Direct binding section is displayed, as
shown in [Figure 20 on page 57|

On this page you specify all the license servers with which this client will
communicate. Before you begin specifying the servers, be sure you have read
the performance notes under [‘Planning Direct Binding” on page 25

In this example, for each license server, the administrator does the following:

a. Enter the TCP/IP host name of the license server in the Name field. (Note
that the server name is case-sensitive.)

b. Check NetworkLS, Central Registry LS, or both, depending on the roles
the server plays in the network.

c. Leave the default values in the NetworkLS Port and CrLS Port, fields.

d. Select the <<Add push button to add the server to the Servers list.

3. On Windows, select the User tab. The User section is displayed.
The user name is the logon user ID in effect when you do the configuration.
Select a group name if you want to change the default.

License Use Management Runtime treats the user name as the name of the user
who requests and uses licenses on this workstation. The user name is displayed
as part of various reports about license usage. It is also used to reserve
reservable licenses for a specific user. The group name is used to reserve
reservable licenses for a specific group and is also used when assigning
authorizations for concurrent-offline licenses.

4. Select the close window icon from the system menu at the top of the notebook.
A message is displayed to confirm that you are ready to save your choices.

The end user can now use products that have network licenses.
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Command-Line Equivalent

ALL To configure the network license client:

LUMcfg -a ¢ -b "'network ip:thelma ip:Touise’
'registry ip:thelma'"

Starting and Listing Your Servers

ALL When you finish your configuration, issue the command:
LUMcfg -start

to start the server you have configured on your workstation.

To verify that they are up and running, issue the command:
LUMcfg -Tist

License Use Management Runtime Processes Defined as
Windows Services

I lI In Windows XP and Windows Server 2003, you can start and list your processes
et either by treating them as Windows services or by using the service manager tool
(see ["Managing License Use Management Runtime with Service Manager Tool”).

During installation, your License Use Management Runtime processes are defined
as services on Windows XP and Windows Server 2003. You can view them in the
Start --> Settings --> Control Panel --> Administrative Tools --> Services window.
If you are logged on with administrator authority, you can also start and stop the
services in the same window.

During configuration, the processes you configure are defined as manual services,
which means they are not started when you start the workstation. You can change
them to automatic services in the Services window, or by checking the Start
services at system startup box on the Start up page of the configuration tool.
Services you do not configure are defined as disabled services.

Note that errors during start or stop of the License Use Management Runtime
processes are logged in the Windows XP and Windows Server 2003 log. To view
them, go to the Start --> Settings --> Control Panel --> Administrative Tools -->
Event Viewer window, and select Application Log.

Managing License Use Management Runtime with Service
Manager Tool

When you finish your configuration, double-click the Service Manager Tool icon in
the License Use Runtime folder to start the processes. The Service Manager Tool
window is displayed, as shown in [Figure 24 on page 63|
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‘2. LUM Service Manager Tool v5 |Z||E|[X|
Service  Selected Options  Help

Marne | Status Description

LUMLMD EXE Started Metwork License Server

LUMGDE EXE Started Central Registry License Server

Figure 24. Service Manager Tool Window

In the Service Manager Tool window select Service from the menu bar and Start
from the pull-down menu.

Verifying Connections to Servers

To verify that license servers are running properly, use the LUMtv (test verification)
tool, or use the LUMb1t -Tn command to get a list of active servers (network license
servers and the central registry license server). For more information about these
commands, see |Chapter 6, “License Use Management Runtime Command Line|
[[nterface,” on page 107 |

Clients and Servers Separated by a Firewall

In this section, the customer wants LAN A computers and LAN B computers to
communicate correctly via TCP/IP and wants the network license server to serve
both License Clients A and License Clients B, with License Client B behind the

firewall. See

license
LAN B Manogement

Client B
169.77.112.33)

Firewall

License Management
Sarer
(146.84.177.10)

Figure 25. Network License Clients Separated by a Firewall

To set up communication between the license management server and client B, the
license server and the firewall must be properly configured. To do this:
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* Fix the secondary authentication server port. Edit the Tum_ini.txt file on the
license management server and set the ipAuthPort value to 9900.

* Define new rules on the firewall to let inbound UDP packets for the destination
146.84.177.10, and ports 2215 and 9900 pass through.

* Define rules to let outbound UDP packets from the source 146.84.177.10 and
ports 2215 and 9900 pass through.

* Let ICMP packets to and from the license management server pass through
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Chapter 5. Administering License Use Management Runtime

ALL This chapter contains scenarios that illustrate the daily tasks needed to manage
license-enabled products.

The tasks can be done using either the basic license tool GUI (BLT GUI) or the
command-line interface (CLI). The scenarios use the GUI. The equivalent CLI
commands are shown at the end of each scenario.

Attention: If you want to run the scenarios, you must substitute your own values
for the sample or fictitious names: server name, product name, vendor name,
enrollment certificate name, product version, product features, and user name.

The scenarios assume that the server IBM-CB4812B86A2 is running a network
license server and the central registry license server. The basic license tool is run
from IBM-CB4812B86A2.

The scenarios use three sample products from three fictitious IBM vendors:

¢ SMART]ava Version 23, simple configuration, a product of the vendor IBM
Software Group. SMART]Java has concurrent licenses, which the vendor delivers
via a compound password. It is a customer-managed use product, and the
vendor enabled it to allow the customer to exercise the hard stop/soft stop
policy. Its enrollment certificate is named smartjava.lic.

e DataMaster Version 21, instrumented version, a product of the vendor IBM
Corporation. DataMaster is a vendor-managed use product with reservable
licenses. Its enrollment certificate is named DataMaster.Tic.

¢ e-MailVision Version 12, with calendar, a product of the vendor IBM Software
Solutions. e-MailVision has per-seat licenses. The enrollment certificate for the
per-seat license is emailvpt.lic.

¢ TechDesign Version 52, advanced engine design, a product of the vendor IBM
Design Solutions. TechDesign has concurrent licenses. It is a vendor-managed
use product and the vendor enabled it for custom configuration policy. Its
enrollment certificate is named TechDesign.lic.

The enrollment certificate files can be placed in any directory, in these scenarios the
administrator has placed them in the home directory.

Using the Basic License Tool GUI

This section gives some general guidance for using the Basic License Tool GUL

Starting the Basic License Tool GUI
To start the basic license tool GUI,
* On AIX: login with root authority and issue the command:
LUMbTt

* On Windows: double-click the Basic License Tool icon in the License Use
Management Runtime v5 folder or start the BLT GUI by issuing the command:

LUMbTt

The main window appears (Figure 26 on page 66).

© Copyright IBM Corp. 1995, 2006 65



LUM Basic License Tool v5 [ [=1E3]
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LUM Test Product UM Test Vendor 10000

Figure 26. Basic License Tool GUI - Main Window

The products shown belong to all the active network license servers and the
central registry.

In the Basic License Tool window, the heading Licenses indicates licenses that are
available to end users (including those that are in use) unless the current date is
before the start date of the licenses or the licenses have expired.

Refreshing License Information

Before viewing information about concurrent and reservable licenses in use for a
product, it is a good idea to clean up stale licenses. In the main window:

1. Highlight the product.
2. Select Clean up stale licenses from the Selected menu.

If you turned the automatic cleanup feature on (see|Appendix A, “License Use|
[Management Runtime Configuration File,” on page 179) all stale licenses are
cleaned up automatically at each BLT refresh.

Selecting Servers, Vendors, and Licenses

To reduce the number of servers, vendors, or licenses shown in the window, use
the Include... option of the View menu. You can specify which servers and vendors
are shown as of the next refresh.

Notes:
1. If a selected server shuts down, it is no longer selected, even if it is restarted.

If a selected server shuts down, and you subsequently request a report or a
display of information gathered from all selected servers, the request fails and
error messages notify you that it was not possible to communicate with the
server. In this case, use the Refresh Now option of the View menu, or deselect
or restart the failing server and try again.

2. The Include... option filters information only for network servers. It does not
restrict the information displayed for the central registry license server.

Performing Basic Administration

The scenarios in this section demonstrate how to:

* Enroll a licensed product (“Enrolling the Product” on page 67).

» Distribute licenses from a compound password (‘Distributing the Licenses” on|
page 69).

* Get a report on the use of licensed products (“Generating Reports” on page 70).
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Check the current users of licensed products (“Checking the Number of Product]
[Users” on page 72).
Reserve reservable licenses for specific users and monitor the use of reservable
licenses (“Scenario 5: Managing Reservable Licenses” on page 72).

Scenario 4: Managing a Licensed Product

In this scenario, the administrator enrolls and manages the SMART]Java product.
This scenario shows you how to:

Enroll the SMART]Java product

Enroll 20 licenses for SMART]ava

Distribute five of the SMART]Java licenses to a network license server
Request a report on usage of SMART]Java licenses during a one-month period
Check the number of concurrent users of SMART]ava

Enrolling the Product
To enroll the SMARTJava product:

1.

In the main window, select Import certificates from the File menu. The Open
window is displayed (Figure 28 on page 68).

Select the Import button. The Import window is displayed. See for an
example of the Import window.

Look ir: |;{'3h0me V| ? \}I||E

=) Datahasteric
{ 2} e-Wail\vision lic

My Recent ermailvpt lic
Documerts stnartjava lic

=
L
Desktop

(9

My Docurmerts

58

by Commputer
% File name: | Cpen
My Metwwork

Flaces Files of type: | lizense filesr® lic) w | Cancel

Figure 27. Import Window

a. In the Look In drop-down list, select the directory containing the
enrollment certificate.

b. From the list of files, select the enrollment certificate. For the SMART]Java
product, the file is smartjava.lic.

3. Click Open. The Enroll Product window is redisplayed, filled in with the

information from the enrollment certificate file. See [Figure 28 on page 68|
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Enroll Certificate

~Product
Pracuct Mame |
Product Yersion |23 |
Product Features |Simple Configuration

rLicenze

License Serial Mumber |

License Amaunt [ps535 |

License Expiration  |July 2, 2008 |

~sendar

Yendar Marme |IBM Software Solutions |

Wendar 1D |bBED1 c44c514 02,0984 22.17.00.00.00 |

Server name |

[ Ok ] [ Cancel ] [ Helg ]

Figure 28. Enroll Product Window

4. In the Server name field, select the server on which the licenses are to be
installed. In this example, because the product is customer-managed and has
network licenses, the licenses are enrolled on the central registry license server
IBM-CB4812B86A2.romelab.it.ibm.com.

Notes:

a. If the product is vendor-managed, and has a specific target ID set in the
enrollment certificate, the licenses must be enrolled on the network license
server of that target workstation.

b. If the product is vendor-managed and the target ID in the enrollment
certificate file is set to ANY, select a network license server.

c. If the password is bound to a cluster rather than an individual server, select
any network license server that is an activated member of the cluster.

5. Click OK.
Because the product is customer-managed, the Enroll Licenses window is
displayed.

6. Fill in the Enroll Licenses window with your user information and the number

of licenses you want to enroll (in this example, 20) as shown in
-a ge 69
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Enroll Licenses

r&dministrator information

Mamne |Michael Princeton |
Company |IBM |
Address |T3 Fifth Avenue, Mews Yark |

Additional information | |

rProciuct information

Enrolled licenses 20

’ OK ] [ Cancel ] [ Helg ]

Figure 29. Enroll Licenses Window

7. Click OK. A message is displayed indicating that the product has been
enrolled.
The main window is displayed again, as shown in There is a new
line corresponding to SMART]ava, and the icon for the product (a wrapped
box) indicates that the product has a compound password.

LUM Basic License Tool v |;HE‘E‘
File Selected Feeport

BMOEEEm

ocal node: IBM-CE4&1 255642 romelab it forn.com }Drmﬁums 2

Product ‘ersion “endor Feafures Licenses In Use Licenses

ﬁ SMARTJava 23 |EM Sattware Solutions iSimple Coniguration o o

Figure 30. Main Window with SMARTJava Enrolled

Distributing the Licenses
Before the network license clients can be granted licenses to use the product, the
administrator must distribute the licenses to a network license server.

Network licenses delivered with a compound password must be distributed.
Simple passwords (for example, per-seat licenses) must not be distributed.

To distribute five licenses to the network license server IBM-
CB4812B86A2.romelab.it.ibm.com:

1. In the main window, select the line for the product.
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2. Select the Distribute licenses... option from the Selected menu. The Distribute
Licenses window is displayed, as shown in

Distribute Licenses SMART Java

Licenses Selected Help

nrolled: 20 |T|:| be distributed: 20

License Server Mewy licenses Currert licenses

it |BM-CE431 2B5642 romelab...

Figure 31. Distribute Licenses Window

3. In the Distribute Licenses window, select the network license server. Right-click
the selected server, and select the Selected » Set number of licenses.... option
from the pop-up menu. The Set Number of Licenses window is displayed.

4. Enter 5 in the Number of licenses field, as shown in and click OK.

Set Number of Licenses

Murnber of licenses |5 |

[ Ok H Cancel ][ Helg ]

Figure 32. Set Number of Licenses Window

The Distribute Licenses window is redisplayed. The window now shows 15 as
the number of licenses available to be distributed. Select the Distribute option
from the Licenses menu to confirm data and distribute the licenses.

5. In the main window, the number of available licenses changes to 5 and the icon
for SMART]Java changes to show a compound password with distributed
concurrent licenses.

End users can now use the SMART]Java product.

Generating Reports
This section shows how to get a report of SMART]Java usage for one month: from
July 2 to August 2, 2005.

1. Select SMARTJava in the main window (Figure 26 on page 66).

2. Select the Report selected... option from the Report menu.
The Select report window is displayed.
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Note: You can not generate reports if a selected server shuts down. For more
information see [“Selecting Servers, Vendors, and Licenses” on page 66|

3. Fill in the Reports window as shown in

Select report

Repoart typi
() Standard () Licensze uze by product
@ Licenze requests by product O Licenze use by uzer
O Licenze requests by uzer O Customer-managed use audit
Date rang
Set date range
Year Month Diary
Frorn | 2005 |[7 |2 |
To | 2008 E E| |
Ewvert fitter
Product dependert
Server name |I
[ Ok ] [ Cancel ] [ Help ]

Figure 33. Reports Window

a. Select the report type License requests by product.

b. Check the Set date range check box and set the date range for the report in
the From and To fields (in this example, from July 2 to August 2, 2005).

c. Click OK.

4. View the Report window, which contains the following report:

Licenses Licenses  Percent
Vendor/Product Vrsn  Requested Granted Rejections
IBM Software Group 23 120 120 0

SMARTJava

The report shows that 120 requests were made to use SMART]Java Version 23,
and all of them were granted.

5. Click Cancel in the Reports window.
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Checking the Number of Product Users
To check the number of concurrent users of SMART]ava:

1. Select the line corresponding to the SMART]Java product on the main window.

2. Select the option Open as Details from the Selected menu. The Details
notebook is displayed.

3. Select the Concurrent Users tab. The Concurrent Users page is displayed, as

shown in [Figure 34

Details of SMART Java 3]

Fsers‘.‘\ Flcens‘es‘.‘\ Product

Hatre: Group hots ID Acid Licenses | Capacty Typs|  Date Compound,
o | concurrert_|
w seministratar Administrators BM-CB4E12... Howember 9,... i Efs—

Figure 34. Concurrent Users Page

It shows the number of licenses in use, with the name of each user. In this
example, the user administrator is using one SMART]Java license.

4. Close the notebook.

Command-Line Equivalent

The GUI scenario shows how to enroll SMART]Java licenses on the central registry
license server, distribute five of the licenses to network license server
IBM-CB4812B86A2.romelab.it.ibm.com, get a report on one month’s usage, and check
the number of concurrent users.

The equivalent CLI commands are as follows.

* To enroll the product on the central registry license server:

— LUMb1t -a -n IBM-CB4812B86A2.romelab.it.ibm.com -f smartjava.lic -T 20
-R "'Michael Princeton' IBM '73 Fifth Avenue, New York'"
-1 "'First installed by Ian'"

e To distribute five licenses to a network license server:

— LUMb1t -E -n IBM-CB4812B86A2.romelab.it.ibm.com -v "'IBM Software Group'"
-p "SMARTJava 23 'Simple Configuration'" -A 5 -w 1ab15099 -I "'Alex
using root'"

* To generate a report of requests for SMART]Java from July 2 to August 2, 2005:

LUMbTt -r2 -p "SMARTJava 23 'Simple Configuration'" -b 07/02/2005
-g 08/02/2005

* To display information about concurrent users of SMART]ava:
LUMbTt -s -Tc -p "SMARTJava 23 'Simple Configuration'"

For more information about the command line interface, see [Chapter 6, “License|
[Use Management Runtime Command Line Interface,” on page 107 |

Scenario 5: Managing Reservable Licenses

In this scenario, the administrator manages licenses of the DataMaster product.
This scenario shows you how to:

* Reserve one reservable license for the exclusive use of a specified user, group
and node.
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* Monitor use of unreserved reservable licenses by other users

In this scenario, 100 reservable licenses for DataMaster have already been enrolled.
The enrollment process is the same as for concurrent licenses of a
customer-managed use product, as shown in |[“Enrolling the Product” on page 67,
except that the Enroll Licenses window is not used. After enrollment, the product
appears in the main window. Note that the icon (a hand holding some licenses)
indicates that the licenses are reservable.

To reserve some of the licenses for a specific user and monitor use of the
reservable licenses:

1. Double-click the product in the main window and go to the Reservable tab of
the Details notebook, as shown in

Details of DataMaster

Licenses Selected  Help

Reservable ‘
|,h:anses‘1 oa Pn-Resarvadﬂ an I_In-Resarvad In-Use:0 'Jn-Raserved Soft Stop In-Use:0 Feserved il r 3

License=s | Un-Reserve. . | Un-Reserve . | Reserved Li | License Ser Start Date | Expiration O Annatation Time Starnp Soft Stop | Soft Stop En

Q 100 100

&

|

Figure 35. Details Notebook with Reservable Tab. Custom configuration serial number not
shown.
Note that there are 100 total licenses, with none in use and none reserved.

2. Right click the product, and select Selected » Reserve... from the pop-up menu.
The Reserved Licenses - Details window is displayed.

3. Fill in the user, group, and node ID for which you want to reserve licenses; and

the date and time that the reservation is to expire, as shown in The
latest allowed expiration date of a reservation is 12/31/2037.

Reserved Licenses - Details. [5__(|

Marne: | Paula

|
Group | Staft |
|

Mode & | louise rome tivali com

Expirstion  Year Manth Day Haour Minute
Titrier - - - - -

| 2005 11 10 18 44

- - - - -

[ (o104 ] [ Cahcel ] [ Help ]

Figure 36. Reserving Reservable Licenses

In the figure, the administrator is reserving one license for user Paula, a
member of the group staff, for use on the node louise.rome.tivoli.com. The
reservation is to expire on November 10, 2005 at 16:44. Note that normally you
reserve one license for a specific user and more than one license for a group or
node.

4. Click OK.
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5. The Reserved page is added to the Details notebook, as shown in

Details of DataMaster

Licenses Selected Help

'_\censesﬂ

hlode (0 CR server Start Time

&"" Paula  Statf Iouise rone tivoli com i IBk-CE: melab it ibm com |[11/9/05 4:03 Phi i
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Figure 37. Details Notebook with Reserved Licenses

The example shows one license reserved for the user Paula in the group staff.
6. User Paula can now request the DataMaster.license without restriction (as many
times as required).

7. Now assume that the user root requests a license to DataMaster. No licenses
have been reserved for root, but there are 99 unreserved licenses. Such licenses
are available to all users until the license administrator reserves them. One of
those licenses is granted to root. It is managed exactly like a concurrent license.

The Un-Reserved Users page is added to the Details notebook for DataMaster,

as shown in |[Figure 38

Details of DataMaster
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Figure 38. Un-Reserved Users Page

8. The Reservable page now shows one reserved licenses, one unreserved license
in use, and 99 unreserved licenses, as shown in [Figure 39

Details of DataMaster
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=
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Figure 39. Reservable Page with Unreserved Licenses in Use

Command-Line Equivalent

The GUI scenario shows how to reserve one DataMaster license for the user Paula,
display information about that user’s use of the reserved licenses, display
information about the use of the unreserved licenses by other users, and display
detailed information about the product.

The equivalent CLI commands are as follows.
* To get the timestamp of the licenses to be reserved:
LUMbTt -Tp -i -v "'IBM Corporation'" -p "DataMaster 21 instrumented"
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* To reserve one DataMaster license for the user Paula in group staff on node

Touise.rome.tivoli.com using the license password identified by timestamp
112407185449612:

LUMb1t -R r -v "'IBM Corporation'" -p "DataMaster 21 instrumented"
-t 112407185449612 -g 11/10/2005 -H 16:44 -u "Paula staff
lTouise.rome.tivoli.com"

* To display information about the users of unreserved licenses:
LUMbTt -s -Tru -v "'IBM Corporation'" -p "DataMaster 21 instrumented"

* To display detailed information about the product, including the number of
reserved and unreserved licenses:

LUMb1t -Tp -i -v "'IBM Corporation'" -p "DataMaster 21 instrumented"

Exercising Customer-Controlled Policies

The scenarios in this section explain how to exercise the customer-controlled
policies outlined in [‘Customer-Managed Use Products” on page 4| The scenarios
show how to:

* Use per-seat licenses (“Scenario 6: Using Per-Seat Licenses”)

* Use the hard stop/soft stop policy (“Scenario 7: Using the Hard Stop/Soft Stop]|
[Policy” on page 76)

* Update the number of licenses of a customer-managed use product (“Scenario 7]
[Using the Hard Stop /Soft Stop Policy” on page 76)

 Control the set of users who are permitted to use a specific application
(“Scenario 8: Restricting User Access” on page 78)

Scenario 6: Using Per-Seat Licenses

The Telephon dialer product, version 2 with the European model feature, from the
vendor TeleSoft is enabled with per-seat licenses. The administrator enrolls the

per-seat license certificate for this product (telephon.lic) as described in
l4: Managing a Licensed Product” on page 67

1. Install the per-seat license, importing the per-seat enrollment certificate
telephon.lic and enrolling 50 licenses. The enrollment process is the same as for

customer-managed concurrent licenses, as described in [“Enrolling the Product’]

2. One user, internally identified as 800900800, starts the "Telephon dialer” that is

connected to its application server running on the node pbarattl. The

application server successfully requests a license on behalf of user 800900800,
thus he can use the license.

3. Open the details of the Telephon dialer product and click on the Per Seat Users

tab. The Details notebook showing the summary of usage by the Application
server is displayed, as shown in

Details of Telephon dialer

| View  Help

Application servers:1 |App|icati0n clients:1 Per Seal |

 [Ber Seal Users |

£
o
2
2
£
=8

PEarettt Made ID Group Mame

PBaratt! Addministr ators administrator

[l
I3
£

Figure 40. Per Seat Users Page
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4. Clicking on the + at the left of the Application server expands all the
application clients connected to that application server as shown in

50 Details of Telephon dialer
[ ——— ~ Produrd
Application servers. 1 Applicalion chenls. 1

Figure 41. Per Seat Users Page Showing Expanded Application Clients

5. The user 800900800 has allocated a license for himself and will keep it for the
lifetime of per-seat licenses that is specified by the ValidityPeriod tag in the
Tum_ini.txt file (15 days by default).

Only the administrator can decide to revoke a license in order to make it available
for other users:

1. Right-click on the Per Seat Users page to switch to the By application clients
view, as shown in

EM Details of Telephon dialer

Figure 42. Per Seat Users Page - Application Clients View
2. Highlight an application client and select Remove from the Selected menu.

Command-Line Equivalent
The GUI scenario shows how to enroll and request the Telephon dialer product
with per seat licensing.

The equivalent command line interface commands are as follows.
* To enroll the per-seat licenses for Telephon dialer:
Tumb1t -a -f /telephon.lic -T 2 -R "'Keith Hogson'"

Scenario 7: Using the Hard Stop/Soft Stop Policy

In [“Scenario 4: Managing a Licensed Product” on page 67,|the administrator
enrolled the SMARTJava product and distributed five licenses from a network
compound password. Now the administrator has distributed the remaining 15
enrolled licenses. Because the vendor enabled this product to use the hard
stop/soft stop policy, and the administrator is running it with soft stop set, it is
possible that more than 20 licenses are being used at any given time.

In this scenario, the administrator:

* Checks the current number of licenses in use and the maximum number of
licenses that have been granted beyond the 20 enrolled (the high-water mark,
which in this example is 10)

* Decides to acquire ten more licenses
* Updates the number of enrolled licenses to 30
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* Resets the high-water mark to 0
* Distributes ten more licenses from the compound password

Follow these steps:
1. Check the current license usage in the main window (Figure 43).

R LUM Basic License Tool v5
Fia Selected Repoi Servers View  Cplions  Help

CRELYT T

neel nede: ENLCESE 8640 romeist & lbes. com Prosuces 3

Proues Versen, 1 Vand Fastiens | Learass inLita Licansan

| Je— n e S St hoa :

Mg Lot rest s h b Tet vensar rooon

Figure 43. Main Window with Soft-Stop Licenses in Use

The window shows that ten licenses beyond the 20 enrolled are in use.

2. Check the longer-term license usage:

Select SMARTJava in the main window. Select Update licenses... from the

Selected menu. The Details notebook is displayed.

3. Go to the Concurrent page, right-click an entry for the product, and select
Selected » Update licenses... from the pop-up menu. The Update Licenses

window is displayed (Figure 44).

Update
HardiSoft stop

[] Dizakle soft stop

l Feset HAM licenses ]

High Water Mark IicensesiE

nrolled licenses ki

[ Ok l [ Cancel l [ Help l

Figure 44. Update Licenses Window with High-Water Mark

The High Water Mark licenses field shows that 10 is the maximum number of
soft-stop licenses ever in use at one time since the high-water mark was last

reset.
4. Decide to acquire ten more licenses, and pay the vendor for them.

5. Returning to the Update Licenses window, enter 30 in the Enrolled licenses
field. At the same time, reset the high-water mark to 0 by clicking on Reset

HWM Licenses.
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6. Click OK. A confirmation message is displayed.

7. Distribute the ten newly enrolled licenses (see [‘Distributing the Licenses” on|
page 69). In the main window (Figure 26 on page 66)), the Licenses column for
SMART]Java is updated to 30.

Command-Line Equivalent
The GUI scenario shows how to check usage of soft stop licenses for SMART]Java,
enroll and distribute an additional ten licenses, and reset the high-water mark to 0.

The equivalent command line interface commands are as follows.
* To display information about usage of soft stop licenses of SMART]ava:
LUMbTt -Tp -p "SMARTJava 23 'Simple Configuration'" -i

* To update the enrollment, enrolling ten more licenses on the central registry
license server:

— LUMb1t -U -v "'IBM Software Group'" -p "SMARTJava 23 'Simple
Configuration'" -T 30 -I "'Margaret using root'"

* To reset the high-water mark to 0:
LUMb1t -U -v "'IBM Software Group'" -p "SMARTJava 23 'Simple Configuration'" -M
» To distribute the ten licenses to network license server IBM-CB4812B86A2:

LUMb1t -E -n 1ab15099 -v "'IBM Software Group'" -p "SMARTJava 23 'Simple
Configuration'" -A 10 -w IBM-CB4812B86A2

Scenario 8: Restricting User Access

There are two methods for restricting user access;

* [“Restricting User Access Using the BLT (Concurrent Licenses)”|

* [“Restricting User Access Using the BLT (Concurrent-Offline Licenses)” on page|

51]

+ |“Restricting User Access With the User File” on page 85|

Restricting User Access Using the BLT (Concurrent Licenses)
This scenario explains how to restrict user access using the basic license tool. This
scenario is applicable only to concurrent licenses. This scenario shows you how to:

* Modify the default authorization.

* Create authorization records for a specific concurrent license. This allows the
authorized users to take the license.

* Modify a created authorization.

To manage this kind of license:

1. Double-click the product in the administration tool main window, then click the
Concurrent tab. The Concurrent Licenses - Details window is displayed
(Figure 45 on page 79).
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Figure 45. Concurrent Licenses - Details window

2. To modify the default authorization, from the Concurrent Licenses - Details
window, right-click on the product and select Selected » Authorizations. The
Authorization window is displayed . The default setting is for all
licenses to be allowed.

Authorizations

rDefault Authorization
Add

© Bl llowed

O Al not dllowed

Authorizations: 0

User CGFOUR tocte

Figure 46. Authorization window

For the selected license, the window shows the mode in which each user can
use the license. There are two different modes for license use:

* All allowed. Any user can start using the license.

* All not allowed. No users are allowed to use the license. A user requires
specific authorization to use the license.

3. You decide that users can use the license only if they have a specific
authorization, so you click All not allowed. Create the first authorization
record for a specific user. From the Authorization window (Figure 46), click
Add. The Add Authorization window is displayed (Figure 47 on page 80). Fill
in the details for the new User and Group (alone, or in any combination). Set
the Mode for the use of the license for this specific user. The modes are similar
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to the modes in the Authorization window (Figure 46 on page 79), except that

they are for the individual user and group being authorized. Click OK.

Add Authorization

=er Sandra

Group  |(Guest

Mode: (&) Allowed () hot allovwed

|_ QI I | icancel | | Help |

Figure 47. Add Authorization window

The authorization record has now been created (as shown in [Figure 48).

Authorizations

rDefault Authorization

O Ml sllowed

() &1 not allowed

Authorizations: 1

Al

User LR

Mode

Figure 48. Authorization window — showing new authorization

4. When you have created an authorization record, you can change the settings
for the authorization record. Select the authorization record file in the
Authorization window (Figure 49 on page 81) and click on Modify. The Modify
Authorization window is displayed. You decide to change the Group for the
user Sandra from Guest to System. Type in the new group, then click OK.
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Modify Authorization

L=zer Sandra

Group  [System

Mode: (33 Bllowed () Mot allowed

| ] 4 | | Cancel | | Help |

Figure 49. Modify Authorization window
The authorization record has now been modified.

Restricting User Access Using the BLT (Concurrent-Offline

Licenses)

This scenario explains how to restrict user access in case of upgrade installation

using the basic license tool. This scenario is applicable only to concurrent-offline

licenses. This scenario shows you how to:

* Modify the default authorization.

* Create authorization records for a specific concurrent-offline license. This allows
the authorized users to take the license.

* Modify a created authorization.

To manage this kind of license:

1. Double-click the product in the administration tool main window, then click the
Concurrent-Offline tab. The Concurrent-Offline Licenses - Details window is
displayed below (Figure 50 on page 82).
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Figure 50. Concurrent-Offline Licenses - Details window

2. To modify the default authorization, from the Concurrent-Offline Licenses -
Details window;, right-click on the product and select Selected »
Authorizations. The Authorization window is displayed (Figure 51). The
default setting is All concurrent allowed.

rDefault Autharization
Change Passtword | >
1 Al nt allovwed [~ Moty
() &ll concurrent sllovwed
Pazawvord | | BEEs
Authorizations: 0
User Group | Ciffline Target [0 Offline Password Mode

Figure 51. Authorization window for Concurrent-Offline licenses

For the selected license, the window shows the mode in which each user can
use the license. There are three different modes for license use:
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* All allowed. Any user can start using the license either as concurrent or as
offline (i.e. disconnected from the network).

* All not allowed. No users are allowed to use the license. A user requires
specific authorization to use the license.

* All concurrent allowed. Any user can start using the license either as
concurrent but not as offline (i.e. disconnected from the network).

3. You decide that users can use the license only if they have a specific
authorization, so you click All not allowed. Create the first authorization
record for a specific user. From the Authorization window (Figure 51 on page]
@, click Add. The Add Authorization window is displayed 1|Eigure 52|D. Fill in
the details for the new User and Group, Offline Target ID, Offline Password .
Set the Mode for the use of the license for this specific user. The modes are
similar to the modes in the Authorization window (Figure 51 on page 82),
except that they are for the individual user and group being authorized. Click
OK.

Add Authorization

Lizer =andra

Group uest

Cffline Target ID 1846000564287 61

Offline Password  abdSdaH]

Mo (o) Allowed () Mot allowed () Concurrert allovwed
[ ox | | cancel | [ rep |

Figure 52. Add Authorization window for Concurrent-Offline licenses

The authorization record has now been created (as shown in [Figure 53 on page]
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Figure 53. Authorization window for Concurrent-Offline licenses— showing new authorization

4. When you have created an authorization record, you can change the settings
for the authorization record. Select the authorization record file in the
Authorization window (Figure 53) and click on Modify. The Modify
Authorization window is displayed (Figure 54). You decide to change the
Group for the user Sandra from Guest to System. Type in the new group, then
click OK.

=,

Modify Authorization

User Sandra|
Graup uest
Offling Target [0 1846000565257 6f

Offline Password  abxd34aH

Mol (o) Allowed () Mot allowed () Concurrent allovwed

| Ok | | Cancel | | Help |

Figure 54. Modify Authorization window for Concurrent-Offline licenses.

The authorization record has now been modified.
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Restricting User Access With the User File

This scenario explains how to create a user file to designate that certain users
might or might not use certain products. You could also use a previously created
user file as a base. To create a user file, follow these steps:

1.

Using a text editor, open a file named:

* user_file on AIX

* userfile on Windows

Within the file, to restrict access to a product, use the VENDOR keyword,
followed by the name of the vendor, followed by either ALL (meaning all
products of this vendor) or the name of a product. Enclose vendor names and
product names in quotation marks if they contain embedded blanks. For
example:

VENDOR "IBM Software Group" SMARTJava
VENDOR Grafix,Inc. all

You need one VENDOR statement for each product of the same vendor, unless ALL
is sufficient for your purposes.

After each vendor statement, code either an ALLOW or a DISALLOW statement.
ALLOW and DISALLOW are mutually exclusive.

e ALLOW
Specifies that the user names that follow this keyword are allowed to use the
product. If no user names follow this keyword, no users can use the product.
The user name is the login user name. For example:

VENDOR "IBM Software Group" SMARTJava
ALLOW fritz harry monique penny

This specifies that only four users can use the SMART]Java product: Fritz,
Harry, Monique, and Penny. ALLOW and DISALLOW are mutually exclusive.

e DISALLOW
Specifies that the user names that follow this keyword are not allowed to use
the product. If no user names follow this keyword, all users can use the
product. The user name is the login user name. For example:

VENDOR Grafix,Inc. all
DISALLOW heather jason

This specifies that all users except Heather and Jason can use all Grafix, Inc
software products.

4. Store the file in the /var/LicenseUseManagement/ directory on AIX and the

Documents and Settings\A11 Users\Application Data\IBM\License Use
Management directory on Windows. Store it on the workstation where the
licenses to be restricted are installed. In this example, the complete user file is:

% This line is a comment
% kkkkk*

VENDOR "IBM Software Group" SMARTJava
ALLOW fritz harry monique philip

% kkkkkk

VENDOR Grafix,Inc. all
DISALLOW heather jason

For a consistent user authorization policy, store the same user file on all
network license servers in your environment, including the central registry
license server.

When adding a new product, remember to update user files at all the license
servers accordingly.
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Note: You cannot use the User File to restrict access when you extract nodelocked
offline licenses from concurrent offline licenses.

Managing High-Availability Licensing (HAL)

The scenario in this section shows how to set up and manage a cluster of network
license servers to ensure high availability of concurrent licenses.

When you create a cluster, License Use Management Runtime generates the cluster
ID. For a software vendor to create passwords that are bound to a cluster rather
than to a single server, you must provide the cluster ID to the vendor. Therefore,
you must create the cluster before you can request licenses bound to the cluster
from a software vendor.

Scenario 9: Creating and Managing a Cluster
In this scenario, the administrator:
* Creates a cluster consisting of three network license servers (members)
» Activates all the servers in the cluster
* Adds a fourth server to the cluster
* Deactivates a cluster member

Creating a Cluster
To create a cluster:

1. Before you begin, be sure all the servers you intend to put in the cluster are
configured to communicate with each other through direct binding.

2. In the main window (Figure 26 on page 66), select Servers from the menu bar
and the Clusters... option from the menu. The Clusters window is displayed, as

shown in

Clusters
Clusters Help

Name D Status Infial Murber | Whin[..|

Figure 55. Clusters Window

3. Select Clusters from the menu bar and Create... from the menu. The Create
Cluster window is displayed.

4. Use the Initial Number spin box to specify how many servers you intend to
put in the cluster. Make sure that this number is what you want, because it
determines the maximum number of members the cluster can ever have and
the minimum number of activated members necessary to run the cluster. In this
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example, as shown in the administrator specifies that the initial
number of members is 3.

Create Cluster

FY
Initial numker |3
by
Marme |Peanut
[ Ok H Cancel H Help ]

Figure 56. Create Cluster Window

Use the Name field to give the cluster a unique name. You will use the name to
specify the cluster in GUI and command-line operations. In this example, the
administrator names the cluster Peanut.

5. Click OK. A pop-up message gives you a chance to change the initial number
of members.

6. After you confirm your choices, the Define Cluster Members window is
displayed.
Potential members of the cluster are shown in the Available NetworkLS box.
These are network license servers that are up and running, and are not
activated in any other cluster.

Select a server from the Available NetworkLS list and use the Add>> push
button to move it to the Cluster Members list. Continue until the Cluster
Members list has exactly the number of servers you specified in Initial
Number. You can move servers between the Available NetworkLS and Cluster
Members boxes until your selections are final. In the example shown in

the administrator adds servers 1ab132028, 1ab132041, and 1ab237141.

Define Cluster, Members EI

Availahle Metwarkls Cluster Members

ip:lab237141 romelab. it om.com ip: 3k 32028 romelab i ibm.com

ip:labi1 32041 romelab it ibm.com

Figure 57. Define Cluster Members Window

7. Click OK. A pop-up window is displayed to give you the chance to change
your selections. The Clusters window is redisplayed with an entry for the
newly-defined cluster, as shown in
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Figure 58. Clusters Window with New Cluster Added

Note that the status of the cluster is Incomplete, because not enough servers
have been activated yet.

Note: Due to incompatibility between HAL cluster members 5.1.1 and HAL cluster
members 5.1.0 of License Use Management Runtime, creating a cluster using
a mixed server environment is not recommended. The mixed mode
environment results in unstable HAL operation. All HAL cluster members
have to be 5.1.1 or higher.

Activating Cluster Members

For a cluster to be able to serve licenses, a minimum number of servers must be
activated, and more than half of the activated servers in the cluster must be
available. When you create a cluster, only the first server (in this example,
1ab132028) is activated. To activate the other servers, follow these steps:

1. In the Clusters window, highlight the cluster Peanut. Select Selected from the
menu bar and Open As Details... from the menu. The Details of Peanut

window is displayed, as shown in

Details of Peanut E‘
Selected  Help

Servers: 3

ncom  Waiting

in:lak132041 romelab it ibm com Mot activated ul 23443000148 3fa7

_ﬁ ip:lah237141 romelab.it lm com Mot activated o 1126460006¢530755

Figure 59. Details of New Cluster

The status of server 1ab132028 is Waiting, because it has been activated but the
cluster does not yet have enough activated members to start serving licenses.
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Next to each activated server is displayed the number of the port on which the
server performs its high-availability licensing activities.

2. Select server lab132041. Right-click it and select Activate to activate the server.
Similarly activate the server 1lab237141.

While each activation is being processed and all the servers in the cluster are
being updated, the cluster goes into Change Pending status for a time that
depends on the number of activated servers in the cluster. While the cluster is
in this status, you cannot perform any administration on the cluster. Return to
the main window and use F5 to refresh the display, and then view the Clusters
window again until the cluster has exited from Change Pending status.

3. Return to the Details of Peanut window, where:
* The status of servers 1ab132028 and 1ab134041 has changed to Serving.
* Each server is serving 33% of the licenses, as shown in

* Server 1ab237141 is in Reserve status, ready to take over if 1ab132028 or
lab132041 goes down.

Details of Peanut. &‘
Selected  Help

Servers: 3

Ip:1ah132041 romelab ft ibm.com Serving 50 [2344300011483157

—@ ip:1ah237141 romelab it om.com Reserve o 1284B0006d530755

Figure 60. Details of Cluster after Three Activations

4. Return to the Clusters window (Figure 59 on page 88). The status of the cluster
has changed to Active. The cluster ID has been generated and is displayed.
The administrator can now give the cluster ID to software vendors who will
create passwords bound to the cluster.

Clusters @

Clusters  Selected Help

Matme 18] Status Initial Mumber M|

Peanut h9947d501941 .86... Active

Figure 61. Clusters Window with Cluster ID

5. Return to the main window, where the HAL test product has been enrolled on
the cluster. You can use it to test operation of the cluster.
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Adding a Cluster Member

If a cluster has fewer than its maximum number of members, you can add
members, one at a time, up to the maximum number. In this example, you can add
additional members to Peanut, as follows:

1. In the Clusters window, highlight the Peanut cluster. From the Selected menu,
select Add cluster member.... The Add Cluster Members window is displayed.
The window is similar to the Define Clusters window shown in

Potential members of the cluster are shown in the Available NetworkLS box.
They can already be members of a cluster.

Select a server (in this example, thelma) from the Available NetworkLS list
and use the Add>> push button to move it to the Cluster Members list. You
can move servers between the Available NetworkLS and Cluster Members
boxes until your selection is final.

2. Click OK. A pop-up window is displayed to give you the chance to change
your selection. The Clusters window is redisplayed. Return to the main
window and use F5 to refresh the display, and then view the Clusters window
again until the cluster has exited from Change Pending status. The number of
servers in Peanut is now 4, and the status of the cluster is Active. The newly
added server is automatically activated.

3. Open the Details of Peanut window (Figure 59). The status of servers
1ab132028, 1ab132041, and 1ab237141 is Serving, and each one is serving one
third of the licenses. The status of thelma is Reserve.

Deactivating a Server

If you want a server to stop functioning as part of a cluster, you can deactivate it.
You can then activate the server in another cluster. You cannot, however, substitute
another server for the deactivated server in the cluster where it is deactivated.

To deactivate a server in a cluster:

1. In the Details of Peanut window, select server thelma. Click it with the right
mouse button and select Deactivate to deactivate the server. While the
deactivation is being processed and all the servers in the cluster are being
updated, the cluster goes into Change Pending status for a time that depends
on the number of activated servers in the cluster. While the cluster is in this
status, you cannot perform any administration on the cluster. Return to the
main window and use F5 to refresh the display, and then view the Clusters
window again until the cluster has exited from Change Pending status.

2. Return to the Details of Peanut window. The status of server thelma has
changed to Not Activated.

Note: To delete a cluster, deactivate all its members. When you deactivate a
server, it must be up and running.

Viewing Licenses Being Served

For a view of a cluster by product, go to a high-availability product (in this case,
the HAL Test Product) in the main window. Open the product’s Details notebook.
On the Concurrent page, right-click the product and select the Selected — Show
Servers option. The Details of Cluster window is displayed with additional
information about the number of licenses being served by each server, as shown in
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Licenses - Details of Peanut

Mame Status Share Target ID Shared Licenses Share in Use

liplak 32041 romelab it.... |Serving S0 2344300011483 a7 5000 0.00

i lab237141 romelsh it.... Reserve 0 1264600065307 55 ) 000

Figure 62. Details of Servers Serving HAL Test Product

Enrolling and Removing Licenses on a Cluster

Checking the Clusters window, you can see the cluster ID of any cluster. Give the
cluster ID to the software vendor, who can use it to create passwords that are
bound to the cluster, rather than to an individual server. Enroll the licenses on only
one server of the cluster, as shown in [“Enrolling the Product” on page 67

If you later decide to remove licenses enrolled on a cluster, make sure that all
activated servers in the cluster be up and running at the time you do the removal.

Command-Line Equivalent

e To create a cluster named Peanut that has members 1ab132028, 1ab132041, and
lab237141:

LUMb1t -H c -N Peanut -T 4 -n "1abl132028 1ab132041 1abh237141"
e To activate the servers 1lab132041, and 1ab237141:

LUMbTt -H a -N Peanut -n 1abl132041
LUMb1t -H a -N Peanut -n 1ab237141

The server 1ab132028, which is the first in the list, is automatically activated.
* To add the server thelma to the cluster:

LUMbTt -H a -N Peanut -n thelma
* To deactivate the server thelma:

LUMbTt -H d -N Peanut -n thelma
* To get an overall report of cluster status:

LUMbTt -H s -N Peanut

* To get a report of cluster status from the perspective of one of the activated
servers in the cluster:

LUMbTt -H s -n 1ab132041

Scenario 10: Displaying Value Units

This scenario explains how to view the Value Units Policy outlined in Chapter [1f of
this book. This policy allows products to be priced by introducing a common unit
of a measure called Value Units.

This scenario shows you how to:

* View the information about the metrics used.
e Start the application and check the number of Value Units in use.

Chapter 5. Administering License Use Management Runtime 91



Viewing the Value Units

In the basic license tool main window select the line corresponding to the
MailVision product in the main window. For information on how to enroll the
product see [“Enrolling the Product” on page 67 for information on how to
distribute the licenses see |[’Distributing the Licenses” on page 69

To view the Value Units, perform the following steps:

1. Select the Open as Details option from the Selected menu. The Details
notebook is displayed.

2. Select the Concurrent tab. The Concurrent page is displayed (Figure 63).

'tk Details of I1cone
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i IEM-FAT1E... [April 26, 20...|Decemb.... alue Units value units ...|1146038287 ... Ves

<] I ' 2]

Figure 63. Concurrent Page

In this page the number of licenses represents the Value Units available, while
the capacity type is Value Units which indicates that this license uses the value
units policy.

3. Select Selected from the menu bar and Value Units details. The Value Units

Details window is displayed, as shown in

Value Units Details

Capacity type “alue Units Yalue Units Calculation

Within Range

Phy=sical Memory Wi 15 Linear Increment

Figure 64. Value Units Details Window

This table describes the different system capacity measurements used to
calculate the number of value units assigned for a capacity type.

The Capacity Type column shows a list of items for which a capacity type has
been assigned, such as:
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100 configured processors
101 online processors

103 Physical Disks

104 Physical Memory Mb
105 Value units

108 RISC 32-bit Processors
109 x64 Processors

110 RISC 64-bit Processors

For a complete list of possible values for capacity types, see the -F parameter
for the LUMact - Annotation Creation Tool, described in Using License Use

Management Application Developer’s Toolkit.

The Value Units column shows the number of units assigned to a specific

capacity type required for an application to start.

The Value Units Calculation column indicates the method by which the units

are calculated: Within Range specifies the allowable range. For example,
range is 4 to 28, 29 x 45 value units for RISC processors would be out o

if the
f range.

For Linear Increment, the number of needed value units is proportional to the

number of licenses required. For example, if one x64 processor is 6 valu
then two would be 12 value units.

e units,

Start the Application and Check the Number of In-use Value

Units

While running the product the Concurrent Users page is added to the Deta
notebook for e-MailVision product, as shown in Check the numb

Value Units in use: it is calculated as the sum of the different metrics used.

[ Details of 11conc

ils
er of

ﬁil

Licenses Selected Help ]

licenses:10 r\lot In-Use:10 'n-Use:D ISoﬂ Stop In-Use:0

Licenze Ser...| Start Date |Expiratio.. | Serial Mumber |Upgrade Index | Capacity Type| Annotation | Time Stargp |Multi Use Rul..| Soft £
i IBM-FAT1E... |April 26, 20... | Decemb... “alue Units value units . [1146038257 ... es
ip:EM-F47T1E.... |[April 27, 20... Decemb... Walue Units  walue units ... 1146127302, Yes

< | m | [zl

~  Concurrent

| Product

Figure 65. Concurrent Page with Value Units in use

Command-Line Equivalent

To accomplish the same results (viewing the annotation details, starting the
application), use the following commands.

To display the annotation table:

To show the table of the metrics:

LUMbTt -11 -Z -p "EmailVision 11 ="

The following table is shown

——————————————————————— Value Units - Details -------=-mmmmmmmmmmemmoo

Capacity Value Value Units

Type Units Calculation from to
On-line Processors 12.00 Within Range 1 10
Physical Disks 1.50 Linear Increment
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To show the number of Value Units in use:
LUMbTt -Tp -p "EmailVision 11 ="

Scenario 11: Managing Concurrent-Offline Licenses

This scenario explains how to manage the use of concurrent-offline licenses, as
outlined in [’Concurrent-Offline Licenses” on page 6] Using this type of license, an
administrator allows users to take a concurrent license for a certain number of
days and to use it on a portable computer. This scenario shows you how to:

* Reduce the maximum number of days a product can be reserved.

* Modify the default authorization.

e Add a password for the default authorization.

* Create authorization records for a specific concurrent-offline license. This allows
the authorized users to take the license.

* Modify a created authorization.
* Display details about the offline users.

In this scenario, 100 concurrent-offline licenses for DataMaster have already been
enrolled. For information on how to enroll the product see [“Enrolling the Product”]
After enrollment, the product is displayed in the administration tool
main window. Note that the icon indicates that the licenses are concurrent-offline.

To manage this kind of license:

1. Double-click the product in the administration tool main window, then click the
Concurrent-Offline tab. The Concurrent-Offline Licenses - Details window is
displayed (Figure 66). Note that the maximum offline period of the license is

120 days.

I Details of 11conc
Licenzes Selected Help l__lé[éc_!._ﬁ_c_,t__
: e ~  Concurrent |

Licenses:10 r\lot In-Use:10 'n-Use:D ISoﬂ Stop In-Use:0 i

Corpauncl
Licenze Ser...| Start Date |Expiratio...| Serial Mumber |Upgrade Index | Capacity Type| Annotation | Time Stamp  |Multi Use Rul...| Soft£

i IEM-FAT1E... |April 26, 20...|Decemb.... Walue Units value units ...|1146038287 ... Ves

ip:IBM-FAT1E.... April 27, 20... Decemb... value Uitz value units .. 146127302, Yes
£ N I | 2

Figure 66. Concurrent-Offline Licenses - Details window

2. To reduce the maximum number of days a product can be reserved, from the
Concurrent-Offline Licenses - Details window, right-click on the product and
select Licenses » Set maximum offline period. The Update Offline Period
window is displayed (Figure 67 on page 95). You can modify the maximum
number of days that a user can reserve a license. For example, you can change
the value from 30 to 5 days. Click OK to save the new value and close the
window.
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Update Offline Period

Max allowed value

hazx Offline Period

I ] 4 I I izancel I I Help J

Figure 67. Update Offline Period window

3. To modify the default authorization, from the Concurrent-Offline Licenses -
Details window (Figure 66 on page 94), right-click on the product and select
Selected » Authorizations. The Authorizations window is displayed (Figure 68

on page 96). The default authorization setting is for all concurrent licenses to be
allowed.
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% Authorizations

rDefault Authorization

() &l not allovwed
() &ll concurrent allovwed

Paszword

Autharizations: O

User Group Offline Target D Offline Password Modle

Figure 68. Authorizations window

For the selected license, the window shows the mode in which each user can
use the license. There are three different modes for license use:

* All allowed. A user can start using the license as a concurrent license or can
reserve it for nodelocked-offline use.

* All not allowed. The license cannot be granted in any mode. A user requires
specific authorization to be granted to use the license.

e All concurrent allowed. A user can take the license as a concurrent license,
but the license cannot be reserved in the nodelock directory.

4. To add a password to the default authorization, from the Concurrent-Offline
Licenses - Details window (Figure 66 on page 94), right-click on the product
and select Selected » Authorizations. The Authorizations window is displayed
. The default setting is All concurrent allowed, no password
assigned, and for Change Password to be disabled. Select All allowed. Change
Password is now enabled. Click Change Password and type in the new
password. Click OK to set the new password.

Note: You cannot define a password for the All not allowed and All
concurrent allowed authorizations. If you have set a password for the
All allowed authorization, and you change the authorization to one of
the other two settings, the password is deleted, and Change Password is
disabled.

5. You decide that users can use the license only if they have a specific
authorization, so you click All not allowed. Now create the first authorization
record for a specific user:

a. From the Authorizations window (Figure 68), click Add.
The Add Authorization window is displayed (Figure 69 on page 97).

b. Fill in the details for the new User, Group, and Offline Target ID (alone, or
in any combination), and the Offline Password.

c. Set the Mode for the use of the license for this specific user.

The modes are similar to the modes in the Authorization window
, except that they are for the individual user, group, offline
target ID, or offline password that is being authorized.
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d. Click OK.

Add Authorization
Lzer =andra
Group Zuest

Cffline Target 1D

Wiode:

1164600056a28761

Offline Password  abdSdaH]

(%) Allowed

) Mot allowed () Concurrert allowed

[ox | [Lconcet | [ tep |

Figure 69. Add Authorization window

The authorization record has now been created (as shown in [Figure 70).

Authorizations

rDefault Authorization

O Allallowsd
O Allnot allowed
(3 Al concurrernt allowed

Pazaward

Change Passward

Al

Authorizations: 1

User

Group

Offline Target 10

| Otiline Pagsword | Moce

Sandra

|1 1845000565267 5

[abizd3dat |&llowed

Figure 70. Authorizations window — showing new authorization

6. When you have created an authorization record, you can change the settings
for the authorization record. Select the authorization record file in the
Authorizations window and click on Modify. The Modify
Authorization window is displayed. You decide to add the Offline Target ID of
a specific machine (1fa460002fdf41al in this example) for the user Sandra. Click
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OK. The authorization record has now been modified (as shown in [Figure 71).

[ = -"|
Modify Authorization
User Sandra|
Graup uest
Offline Target ID 1548000262257 61
Offline Pazsword  abeod3daH
Mol (o) Allowed () Mot allowed () Concurrent allovwed
| Ok | | Cancel | | Help |

Figure 71. Modify Authorization window

7. User Sandra requires an offline-nodelocked license from her portable computer
and reserves it for five days. In the administration tool, the display changes to
show that there is a license in use (see [Figure 72).

Details of DataMaster

Users:1 Product
Node I Target ID MConolisnl;Otinel
i Bifing Users 3|

Start resery.. |End reservat.. | Capacity Trps Licenss =

acministrator Administrators IBM-CE4812... 2524600025... Mavember 2., Mavember 7... iR IBM-CE481

4 | b3

Figure 72. Administration tool, showing an in-use license

8. After three days, user Sandra decides that she no longer needs a license for her
portable. Using the hand back procedure, she releases the license.

The administration tool displays that the license is no longer in use.
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Note: If the user Sandra did not hand back the license, when the five-day
reservation period expires, the license is handed back. The
administration tool displays that the license is no longer in use.

Command-Line Equivalent
The equivalent CLI commands are as follows.

To update (to 50) the maximum number of days a product can be reserved.
LUMb1t -U -v "'IBM Corporation'" -p "DataMaster 31 '' " -0 50

To modify the default authorization for DataMaster licenses:

LUMbTt -A m -v "'IBM Corporation'" -p "DataMaster 31 '' " -t 112407185449783
-T no -w "password"

To create a reservation record for the DataMaster license for the user Sandra, for
any group and target ID:

LUMb1t -A a -v "'IBM Corporation'" -p "DataMaster 31 '' " -T yes
-u "Sandra * *" —w "Tum_group"

It is not possible modify using a unique command an authorization record other
than the default record. The administrator needs to delete the old record and create
a new record. To delete a reservation record for DataMaster licenses for the user
Sandra:

LUMb1t -A d -v "'IBM Corporation'" -p "DataMaster 31 '' " -u "Sandra * =*"
-t 1124071854496125

To create a authorization record for the DataMaster license for the user Sandra for
a specific machine with target id 1fa460002fdf41a1:

LUMbTt -A a -v "'IBM Corporation'" -p "DataMaster 31 '' " -T yes -u
"Sandra * 1fa460002fdf4lal" —w "Tum_group"

To list all the authorization records for the DataMaster 31 license:
LUMbTt -A 1 -v "'IBM Corporation'" -p "DataMaster 31 *"

To display information about the users of concurrent-offline licenses for the
DataMaster product:

LUMbTt -s =1 co -v "'IBM Corporation'" -p "DataMaster =* *"

Scenario 12 : Upgrading a Custom Configuration

The scenario in this section shows how to upgrade a custom configuration by
adding a set of products to a concurrent custom configuration.

To ensure that the products might are "up_to_date", funcionally suitable and
compatitive, you occasionally need to add new product components, increase the
number of licenses, extended the license period, or change the license version. To
do this you have to request from the vendor one or more custom configuration
passwords and supply the serial number for the concurrent license. This serial
number identifies your concurrent custom configuration so that you can install the
upgrade licenses as shown in the describing procedure below.

1. Double-click the product in the Basic License Tool main window (see
on page 66), then click the Concurrent tab of the Details notebook. The window
Details of TechDesign TaxEngine is displayed (Figure 73 on page 100).
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Details of Tech Design TaxEngine
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Figure 73. Details Window of TechDesign TaxEngine

To upgrade your Concurrent Licenses:

1. In the Basic License Tool main window (see [Figure 26 on page 66), select
import certificates from the File menu.

2. Look in the pull-down list, select the path to the directory where the enrollment
certificates are stored (for example /home/cert), and then from the File menu
choose the custom configuration enrollment certificates (for example
techdesignupdatel.lic; techdesignupdate2.1ic) as in (Figure 74 on page 101).
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Figure 74. Open window with custom configuration enrollment certificates

3. Click OPEN to save the selected values. The enrolled certificates windows
(Figure 75 on page 102|), (Figure 76 on page 103) are displayed.
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Figure 75. Enroll Certificate Window
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Figure 76. Enroll Certificate Window

4. In the Server name field , select the server number from the
pull-down list where the initial key was installed on. This is required, because
the product is vendor-managed and has a network license. The custom
configuration licenses are enrolled on the network license that has the target ID
for which licenses were created.

Note:

a. If a specific target ID is in the enrollment certificates, the licenses
must be enrolled on the network licenses server of that target
workstation.
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LUM Basic License Tool v5

b. If the target ID in the enrollment certificates is any, select a network

license server.

5. Click OK and the Main window is displayed .
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Figure 77. LUM Basic License Window

The concurrent page of the Details notebook contains the updated licenses
information. To display this page, double-click on the Product name, then click
the Concurrent tab of the Details notebook, scroll to the right to view the serial
number, subserial number, upgrade count and upgrade index.

Command-Line Equivalent

To upgrade a custom configuration license, using the license certificate files
techdesignupdatel.lic and techdesignupdate2.lic on server lab15099

LUMb1t -a -f 'techdesignupdatel.lic techdesignupdate2.lic' -n Tab15099

Note:

1. Each upgrade set is identified by a different subserial number.

2. An upgrade set with a lower subserial number cannot be enrolled if a set
with a higher subserial number has already been enrolled.

3. Concurrent and concurrent-offline licenses in use as concurrent will be
no longer in use after the upgrade.

4. Reserved offline licenses can still be handed back after an upgrade.

5. It is not possible to reserve offline licenses if licenses with a lower sub

serial number are currently reserved.

6. Authorizations are moved to the upgraded licenses with the following

algorithms.

Authorizations are moved to the upgraded certificates according to restrictive rules
that prevent granting extra access for a user.

If the license you are going to replace do not have the same default authorization
no transfer is done and ALL NOT ALLOWED is applied as the default

authorization.

If the default authorization is transferred then user authorization are transfer as

follows:
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* If the authorization level assigned to the user is equal or more restrictive then
the default one is transferred if it exists under any of the previously considered
license.

* If the authorization assigned to the user is less restrictive then the default one is
transferred only if it exists under all of the previously considered certificate.
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Chapter 6. License Use Management Runtime Command Line
Interface

This chapter describes how to use the License Use Management Runtime CLL

In the descriptions of command syntax, the following conventions are used:

Bold type Code this item exactly as shown.

Italic type Replace this item with your own value.

Brackets [] The item or items in brackets are optional.

Braces {} Choose one item from the list of alternative items inside the
brackets.

Vertical line | This OR sign separates the alternative items.

Three dots An ellipsis following an item means you can include more than
one of the item. For example, [filenamel... specifies an optional list
of files.

The following commands are available on all operating systems:

LUMDIt Basic License Tool (page
LUMcfg Configuration Tool (page
LUMtv Test Verification Tool (page
LUMtarget Target View Tool (page
LUMImd Network License Server (page
LUMgdb Central Registry (page
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LUMDIt - Basic License Tool

LUMDIt - Basic License Tool

Primary Command Options

ALL The LUMbIlt command has the following primary command options:

(No option)

[LUMDIt -a Enroll a Product]
[LUMDIt -A Authorize]
LUMblIt -C Clean Up Stale|

Licensegl
LUMDIt -d Delete a Product]

License|

LUMDIt -E Extract and Distribute]

License§|

[LUMDIt -h Display Help|

LUMblt -H Administer]
High-Availability Licensing]

[LUMDIt -1 Display a List]

LUMDbIt -m Monitor and Log]|
Threshold Events|

[LUMDIt -r Generate a Report]

LUMDIt -R Reserve Licenses;|
Delete or Update Reserved|

Licensegl
LUMDIt -s Display Product|
License Status|

LUMblt -S Set the Stress|

Thresh01d|

LUMDIt -T Activate or Deactivate|

Tracing]

[LUMbDIt -U Update a Product]

LUMDIt -x Delete Server Log]

Entries|

Start the basic license tool GUI.
Add products to a license database.
Authorize a concurrent or concurrent-offline license.

Update the number of concurrent; concurrent-offline
and reservable licenses in use.

Delete products from a license database, or delete
Application Client Identifiers from the central registry.

Extract and distribute licenses from a network
compound password of a given product to the servers.

Display command syntax and usage information about
the basic license tool CLI

Create a cluster of network license servers; add servers
to an existing cluster; display cluster status; activate
and deactivate servers in a cluster.

List license database information about servers,
vendors, products, and licenses.

Monitor and log the threshold messages.

Report on information recorded in the log file of a
license server.

Reserve reservable licenses for use by a specific user,
group, and node; delete reserved licenses; update
reservation status.

Gather status information about license usage.
Set the network license server load threshold.

Display information about current product usage on
specified license servers.

Update the number of licenses you enrolled, update
the hard stop/soft stop policy and high-water mark
when enabled on the product, set the threshold value
of a customer-managed product, and set the maximum
allowed period that a concurrent-offline license can be
reserved.

Delete license server and central registry log file
entries.

General Rules for the LUMbIt command
1. The root user (UNIX), or the administrator (Windows), can run the LUMDbIt

command with all its options.

Other users can run the -1 (Display a List), -s (Display Product License Status),
-r (Generate a Report), -Hs (check a cluster status), and -h (Display Help)
options and the equivalent GUI actions, allowing them to display the content of
the license and license users databases.
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LUMDIt - Basic License Tool

The parameters within any of the following name specifications are positional:
» vendor_information (vendor_name vendor_id vendor_password)

* product_information (product_name product_version product_features
license_password license_annotation)

* administrator_information (administrator_name company_name address
additional_info)

* user_information (user_id user_group user_node)

All the following name specifications must be enclosed within double quotation
marks (for example: "vendor_name vendor_id vendor_password”).

* vendor_information (vendor_name vendor_id vendor_password)

* product_information (product_name product_uversion product_features
license_password license_annotation)

* administrator_information (administrator_name company_name address
additional_info)

* user_information (user_id user_group user_node)

* signature_information

When a list of values (such as server names, vendor names, product names, or
user names) is entered as a parameter, the list must be enclosed in double
quotation marks. For example:

LUMb1t -r3 -u "katie dustin emily adam"

A name that contains character spaces must additionally be enclosed within
single quotation marks. For example:

-v "'IBM Corporation'"
-p "'Core - System' 11 feature"

The parameters you specify in any of the command options (for example,
server names, vendor names, and product names) are case-sensitive.

You can display help on LUMDbIt command options as follows:
* To get help on just the -a, -U, -E, -d, -m or -H option:
LUMb1t -option
* To get help on just the -R, -1, -r, or -x option:
LUMb1t -optionh
Examples
* Display the LUMbIt -E syntax:
LUMbTt -E
* Display the LUMbIt -r syntax:
LUMb1t -rh
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LUMDIt - Basic License Tool

LUMbIt -a Enroll a Product

This option adds a product to the license database on the license server that you
specify. Use the LUMb1t -a command to add a new product and its initial licenses
to a license server database. You can also use this command to add licenses for
existing vendor-managed products.

You get the product license information in the form of an enrollment certificate file.
You enroll the product by importing the enrollment certificate. You can enroll more
than one product at the same time.

Syntax:

LUMbDlIt -a

[ -n server_name | -f filename [filename]...

[ -R administrator_name [ company_name address additional_info | ]
[-T enrolled_licenses |

[ -I signature_information |

Parameters:

-n server_name
Specifies the name of the license server to which you intend to add the
product. If -n is omitted:

¢ If the product is customer-managed, and the licenses are network
licenses, they are enrolled on the central registry.

¢ If the product is vendor-managed, and the enrollment certificate file
specifies a target ID, the licenses are enrolled on that workstation.

* If the product is vendor-managed, and the enrollment certificate file
does not specify a target ID, the licenses are enrolled on the local
workstation.

-f filename [ filename |...
The complete path and file name of the enrollment certificate file
containing the product license information that you intend to add.

-R administrator_name [ company_name address additional_info ]
(for customer-managed use products only)

administrator_name
The name of the administrator who performs the operation. This
parameter is required.

company_namne
The name of your company.

address The address of your company.

additional_info
Comments, notices to future users, or other information about the
initial enrollment of this product.

If you enroll several products, the value you specify for these options
apply to all the license certificates.

-T enrolled_licenses
(for customer-managed use products only) The number of licenses you
have acquired from the software supplier. This parameter is required.

If you enroll several products, the value you specify for this option applies
to all the license certificates.
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LUMDIt - Basic License Tool

-1 signature_information
(for customer-managed use products only) Information about the user
issuing the command, to be stored with the signature stamp.

Examples: Add a customer-managed use product:

LUMbTt -a

-f license_certificate_name
-R "Alex IBM Rome" -T 100

-1 "'Alex using root userid'"

Add a vendor-managed use product:

LUMbTt -a -n thelma
-f Ticense_certificate_name
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LUMDIt - Basic License Tool

LUMbDIt -A Authorize

Use this option to create an authorization for either a concurrent, or a
concurrent-offline license. LUMbIt must be run on the same machine where the
license is enrolled.

Note: To add an authorization for a high-availability license, you must repeat the
command on each license server in the cluster.

Syntax:
LUMDIt -A action_type

{ { a -v "vendor_name" -p "product_name product_version product_features”
-u "user_name user_group target ID" [ -w "password” ]| -T mode [-t timestamp]}
|

{ 1 -v "vendor_name" -p "product_name product_version product_features"
[-t timestamp]}

|

{ d -v "vendor_name" -p "product_name product_version product_features”
-u "{ user_name | *} { group_name | * } { target ID | *}"

-t timestamp)

|

{ m -v "vendor_name" -p "product_name product_version product_features"
-t timestamp -T mode [ -w "password” ] } }

Parameters:

action_type
Specifies the action to be taken:

a Adds an authorization for a product. With action type a, the -v, -p,
-u, and -T parameters are all required. The -t and -w parameters
are optional.

To add an authorization for a high-availability license, you must
repeat the command on each license server in the cluster.

1 Lists the authorizations for a product. With action type 1, the -v
and -p parameters are required. The -t parameter is optional.

d To delete an authorization for a product. With action type d, the -v,
-p, -u, and -t parameters are all required.

To delete an authorization for a high-availability license, you must
repeat the command on each license server in the cluster.

m To modify an authorization for a product. With action type m, the
-v, -p, -t, and -T parameters are all required. The -w parameter is
optional.

You can modify only the default authorization from the CLIL To
modify any authorization that is already created, you must use the
GUL

-u " { user_name | *} { group_name | *}{ target ID | *}"
The user name and user group for the user to be authorized, and target ID
of the machine where the license is to be authorized. The target ID applies
only to concurrent-offline licenses that are to be used in the offline mode.
The target ID is ignored for concurrent licenses, and also for
concurrent-offline licenses that are used as concurrent licenses.
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The wildcard character (*) can be used to denote any.

-w "password”
The password for the authorized user. This is for concurrent-offline licenses
only. The password must be enclosed in double quotation marks. It is for
concurrent-offline licenses that are to be used for offline mode. The
password is ignored for concurrent licenses, and also for concurrent-offline
licenses that are used as concurrent licenses.

The wildcard character (*) can be used to clear (unset) the password.

-v "vendor_name"
The vendor of the licensed product that you intend to update. Enclose the
vendor_name with single quotation marks (") when the vendor_name contains
spaces, for example "'IBM Corporation'".

-p "product_name product_uversion product_features”
The information on the licensed product that you intend to update.

product_name
The name of the product that you intend to update. Enclose the
product_name with single quotation marks (") when the
product_name contains spaces.

product_version
The version of the product that you specified in the product_name
parameter.

product_features
The features of the product that you specified in the
product_features parameter. Enclose the product_features with single
quotation marks () when the product_features contain spaces.

-T mode
Set to one of:

yes A user can start using the license as a concurrent license or can
reserve it for nodelocked-offline use.

no The license cannot be granted in any mode.

concurrent
This is for concurrent-offline licenses only. A user can start using
the license in a concurrent mode only. The user cannot reserve the
license for nodelocked-offline use.

-t timestamp
Unique timestamp of the product license that you intend to create, modify,
list, or delete. To get the timestamp, issue the following command:

LUMbTt -Tp -p "product_name product_version product_features" -i

Examples: To create an authorization record for the DataMaster license, version
31, with the instrumented feature, for the user Sandra, for any group and target ID:

LUMb1t -A a -v "'IBM Corporation'" -p "DataMaster 31 instrumented" -T yes
-u "Sandra * *" —w "Tum_group"

To create an authorization record for the DataMaster license, version 31, with the
instrumented feature, for the user Sandra for a specific machine with target id
1fa460002fdf41al:

LUMb1t -A a -v "'IBM Corporation'" -p "DataMaster 31 instrumented" -T yes
-u "Sandra * 1fa460002fdf4lal" —w "Tum_group"
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LUMDIt -C Clean Up Stale Licenses

Use LUMBDIt -C to update the number of in-use concurrent, concurrent-offline, and
reservable licenses.

When you issue this command, License Use Management Runtime polls all the
license servers that have granted licenses of these types and verifies that the
licenses are still in use. If any stale licenses are found, they are removed from the
number of in use licenses.

Syntax:

LUMDIt -C

[ -n server_names |

[ -v vendor_name ]

-p product_name product_version product_features
[ -t license_timestamp |

Parameters:

-n server_names
The names of the servers where the products are enrolled.

-v vendor_names
The name of the vendors that manufactured the products whose licenses
are in use.

-p "product_name product_uversion product_features”
The information on the licensed product that you want to clean up.

product_name
The name of the product whose stale licenses you want to clean
up. Enclose the product_name with single quotation marks (') when
the product_name contains spaces.

product_version
The version of the product whose stale licenses you want to clean

up.
The wildcard character (*) can be used to denote any.

product_features
The features of the product whose stale licenses you want to clean
up. Enclose the product_features with single quotation marks (")
when the product_features contain spaces.

The wildcard character (*) can be used to denote any.

-t license_timestamp
Use the optional -t license_timestamp argument to clean up the user for a
specific license

Examples: Clean up stale licenses for the Graphics product, version 31, with the
additional plug-ins feature, of vendor Alpha on servers Thelma, Hall, and Louise:

LUMb1t -C -n "Thelma Hall Louise" -v "Alpha" -p "Graphics 31 'additional plug-ins'"

Clean up stale licenses for the Graphics product, version 31, with the additional
plug-ins feature, of vendor Alpha.

LUMb1t -C -v "Alpha" -p "Graphics 31 'additional plug-ins'"
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LUMDIt -d Delete a Product License

This option deletes a product license from the license database on the license
server that you specify, or an Application Client Identifier from the central registry.

Syntax:

LUMblt -d

[ -n server_name |

-v vendor_name

-p product_name product_version product_features
{ -t timestamp | -A ACID }

[ -I signature_information |

Parameters:

-n server_name
Either of the following:

* The name of the license server from which you intend to delete the
product license.

* To delete a high-availability license, the name of one of the servers in the
cluster on which the license is enrolled.

To delete a high-availability license, issue the command:

LUMbTt -d -n server_name -v vendor_name -p "product_name
product_version product_features" -t timestamp

where server_name identifies one of the servers in the cluster on which the
license is enrolled. You must repeat the command for each license server in
the cluster.

-v vendor_name
Name of the vendor whose product license you intend to delete.

-p "product_name product_uversion product_features”
The information on the licensed product whose licenses you intend to
delete.

product_name
Name of the product whose license you intend to delete. Enclose
the product_name with single quotation marks (') when the
product_name contains spaces.

product_version
Version of the product whose license you intend to delete.

product_features
The features of the product whose license you intend to delete.
Enclose the product_features with single quotation marks () when
the product_features contain spaces.

-t timestamp
Unique timestamp of the product license that you intend to delete. To get
the timestamp, issue the following command:

LUMbTt -Tp -p "product_name product_version product features" -i

Do not specify the timestamp when you delete an Application Client
Identifier.

-A ACID
Unique identifier of the Application Client Identifier of an application
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client you want to delete from the central registry. After deletion the
application client no longer has the license to use the specified product. To
get the Application Client Identifier, issue the following command:

LUMbTt -s -1pt -v "vendor_name" -p "product name product version
product_features"

Do not specify -A when you delete a product.

-1 signature_information
(for customer-managed use products only) Information about the user
issuing the command, to be stored with the signature stamp. Use this
parameter when deleting a product license.

When the last license for the only remaining product of a vendor is deleted, the
vendor is automatically deleted from the license database. Vendor-managed
compound passwords and use-once licenses cannot be deleted until they expire.

Examples: Delete an expired license for a VectorComp Corporation product called
EZ-Vectors Version 10, with the raster export feature. The unique timestamp of the
license to be deleted from the database on server saturn is 1124071854456984:

LUMb1t -d -n saturn -v "'VectorComp Corporation'" -p
"EZ-Vectors 10 'raster export'" -t 1124071854456984

Delete an application client whose Application Client Identifier is thelma from the
central registry. After this command the application client will no longer have
licenses for the product EZ-Vectors Version 10, with the raster export feature, of
VectorComp Corporation vendor:

LUMbTt -d -v "'VectorComp Corporation'" -p "EZ-Vectors 10 'raster export'"
-A thelma

116 Using License Use Management Runtime



LUMDIt - Basic License Tool

LUMDIt -E Extract and Distribute Licenses

Use the LUMbIt -E command to extract licenses from an installed network
compound password and distribute them to the network license servers.

Syntax:

LUMDIt -E

-n origin_server_name

-v vendor_name

-p product_name product_version product_features
-A license_number_per_server

-W target_server_names

[-I signature_information |

Parameters:

-n 0rigin_server_name
The name of the server where the network compound password is
enrolled.

-v vendor_name
The name of the vendor that manufactured the product whose licenses you
want to distribute.

-p "product_name product_uversion product_features"
The information on the licensed product whose licenses you intend to
distribute.

product_name
The name of the product whose licenses you want to distribute.
Enclose the product_name with single quotation marks (") when the
product_name contains spaces.

product_version
Version of the product whose licenses you want to distribute.

product_features
The features of the product whose licenses you want to distribute.
Enclose the product_features with single quotation marks () when
the product_features contain spaces.

-A license_number_per_server
The number of licenses for the specified product you want to distribute on
each of the servers specified after the -w parameter.

-w target_server_names
The servers on which you want to distribute the licenses.

-1 signature_information
(For customer-managed use products only) Information about the user
issuing the command, to be stored with the signature stamp.

Examples: Extract and distribute 10 licenses to each of the servers Louise and
Hall, for the Test Compiler product, Version 11, with the special function library
feature, of vendor Psychosync, installed on server Thelma:

LUMb1t -E -n "Thelma" -v "Psychosync" -p "'Test Compiler' 11 'special function
library'" -A 10 -w "Louise Hall" -I "'Paula'"
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LUMDIt -h Display Help

This option displays general syntax information for the basic license tool CLL
Syntax:
LUMbDIt -h

Examples: Display the LUMblIt syntax:
LUMbTt -h
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LUMDbIt -H Administer High-Availability Licensing

This option creates a cluster of network license servers; adds servers to an existing
cluster; displays cluster status; and activates and deactivates servers in a cluster.

Syntax:

LUMDIt -H action_type

{ { ¢ -N cluster_name -n "server_names" -T initial_number_of_servers }
|

{al d} -N cluster_name -n "server_names" }

|

{ s { -N cluster_name | -n "server_names" } } }

Parameters:

action_type
Specifies the action to be taken:

C To create a cluster. With action type ¢, the -N, -T, and -n
parameters are all required.

a To add a server to a cluster, or to activate a server in a cluster.
With action type a, the -N and -n parameters are required.

d To deactivate a server in a cluster. With action type d, the -N and
-n parameters are required.

s To request cluster status. With action type s, the -N or -n
parameter is required. Use the -N parameter to get an overall view
of cluster status. If you are having problems with cluster operation
and you want to see a view of the cluster from the perspective of
an individual server, use action type s with the -n parameter. In
either case, the cluster status display includes the following
information about the cluster:

¢ Cluster name
¢ Cluster ID
¢ Cluster status:

Active Running, serving licenses
Change Pending

Waiting for a change in the status of a server, or
of the cluster, to be propagated to all the servers

Inactive Not enough servers up and running

Incomplete Not enough servers activated
* Initial number of servers

¢ Minimum number of members, maximum number of members,
and minimum up and running for the cluster to work

¢ For each server in the cluster:
— Server name
— Server status:

Serving Running, serving licenses

Waiting Server is ready, but cluster is in incomplete or
inactive state
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Unavailable  Not started or not reachable

Reserve In reserve in case a serving server becomes
unavailable

Not activated Defined as a member of the cluster but
administrator has not yet activated the server
or has deactivated the server

— Percentage of licenses being served
— Target ID

-N cluster_name
The name of the cluster to which the command is directed. The -N
parameter is required if action type is ¢, a, or d, and it is recommended
when action type is s.

-T initial_number_of_servers
The initial number of servers in the cluster that you are creating. The -T
parameter is required if action type is ¢, and is not valid if action type is
not c. The -n parameter must specify a number of servers equal to the
value of -T.

-n server_names
The names of the servers to which the command is directed. The -n
parameter is required if action type is ¢, a, or d, and it can be used when
action type is s. If action type is ¢, this is the list of initial members of the
cluster. You must specify a number of servers equal to the value of -T.
After this command has been processed, the first server in the list is
automatically activated. Issue LUMb1t -H again, using action type a, to
activate each additional server. At the time the LUMb1t -H ¢ command is
processed, all the servers specified must be up and running. If not, the
command fails. If action type is a or d, this is the name of the server to be
activated or deactivated. You must specify exactly one server. If action type
is a, the server must be up and running when the command is processed.
If not, the command fails. If action type is s, this is the name of any server
that is currently activated in the cluster. The command returns cluster
status from the perspective of this server.

Note: When the cluster is in Change pending status, different servers
might return different data.

Examples: Create a cluster named ruth that has three members: anthony,
germaine, and costanza:

LUMbTt -H ¢ -N ruth -T 3 -n "anthony germaine costanza"
Activate the servers germaine and costanza:

LUMb1t -H a -N ruth -n germaine

LUMbTt -H a -N ruth -n costanza

Add the server sandra to the cluster:
LUMbTt -H a -N ruth -n sandra

Deactivate the server germaine:
LUMbTt -H d -N ruth -n germaine

Get an overall report of the status of the cluster nobel:
LUMbTt -H s -N nobel
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Get a report of the status of the cluster nobel from the perspective of one of its
activated members, pirandello (recommended only for troubleshooting purposes):

LUMbTt -H s -n pirandello
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LUMDIt -1 Display a List

All users can use this option to display a list of servers, vendors, products, or
licenses. You can also use it to display details about individual products or
individual licenses.

Syntax:

LUMDIt -1 list type {n | v | p[-i] | 1[-k] [-Z]}
[ -n server_names |

[ -v vendor_names |

[ -p product_name product_version product_features |

[ -u user_names |

[ -t license_timestamp |

Parameters:

list_type
Indicates the type of information that you want to list. You can specify any
one of the following list types:

-In or -Is

To display a list of active license servers. Also displays information
about trace level, load percentage and load threshold percentage.
The load percentage and load threshold percentage are not
applicable for a central registry license server.

-lv To create a vendor list.

Filters:

* To list vendor information gathered from servers that you
specify, use the -n filter option followed by one or more server
names.

* Do not specify the -v, -p, or -u filter option with this parameter.
-11 To display detailed information about each license.
-lp [-i] To create a product list.

Filters:

* To list product information gathered from servers that you
specify, use the -n filter option followed by one or more server
names.

* To list product information on products from particular vendors,
use the -v filter option, followed by one vendor name.

* To list product information on particular products, use the -p
filter option, followed by one product name, version, and
feature.

* To list information on users who are currently using the
products that you specify, use the -u filter option, followed by
one Or more user names.

* Specify the -k option to remove expired licenses from the list.

Specify the -i option to display detailed information about each
product (for example, the number of reserved and unreserved
licenses) in a product list.

-11 [-k][-Z]
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To create a list of individual licenses. The output includes all the
information you get by specifying lp with the -i option, plus, for
products with concurrent licenses that are administered in a
high-availability environment, information about the cluster and
servers within the cluster.

Filters:

To list license information gathered from servers that you
specify, use the -n filter option followed by one or more server
names.

To list license information on products from particular vendors,
use the -v filter option, followed by one vendor name.

To list license information on particular products, use the -p
filter option, followed by one product name, version, and
feature.

To list information on users who are currently using the licenses
that you specify, use the -u filter option, followed by one or
more user names.

Specify the -k option to remove expired licenses from the list.

Specify the -Z option to display a table containing value units
annotation information.

Value Units Output:

Capacity Type. Shows a list of items for which a capacity type
(metric) has been assigned.

Value Units. Shows the number of value units assigned to a
specific capacity type.

Value Units Calculation. Indicates the method by which the
value units are calculated from capacity units:

— Within Range. Specifies the same value units for all capacity
units in the specified range.

— Linear Increment. The number of value units required is
proportional to the number of capacity units requested.

From. Indicates the beginning of the range.
To. Indicates the end of the range (if any).

High-Availability Output:

Cluster name
For each server in the cluster:
— Server name
— Server status:
Serving
Running, serving licenses
Waiting
Server is ready, but the cluster is in incomplete or
inactive state

Unavailable
Server is unavailable to other members of the cluster

Reserve
In reserve in case a serving server becomes
unavailable
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Not activated
Defined as a member of the cluster but the
administrator has not yet activated the server or has
deactivated the server

Percentage of licenses being served by this server
Target ID
Number of licenses served by this server

Number of in-use licenses served by this server

-n server_names
Names of the servers about which you want to display information in a
vendor or product list.

-v vendor_name
Name of the vendor about whose products you want to display
information in a product list.

-p "product_name product_version product_features”
The names of the product, version, and features about which you want to
display information in a product list:

product_name
The name of the product for which you want to display
information. Enclose the product_name with single quotation marks
(") when the product_name contains spaces.

product_version
The version of the product that you specified in the product_name
parameter.

The wildcard character (*) can be used to denote any.

product_features
The features of the product that you specified in the
product_features parameter. Enclose the product_features with single
quotation marks (") when the product_features contain spaces.

The wildcard character (*) can be used to denote any.

-u user_names
Names of users about whom you want to display license usage
information in a product list.

-i Specify the -i option in conjunction with a product list (LUMDIt -1p) to
display the following detailed license usage information about an
individual licensed product in a product list:

* Vendor name
* Vendor ID
* Product name
* Product version
* Product features
* Product ID
* Licenses (total on all the selected servers)
* In-use licenses (total on all the selected servers)
* For each license instance:
— Number of licenses
— License type
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— Capacity type

— Server on which the license is installed
— License annotation

— Serial number

— Subserial number

- Upgrade Count

- Upgrade Index

— Customer site

— Country usage

— Start date

— Expiration date

— Time stamp

— Password use control level

For products with customer-managed use control and per-seat licenses,
the following information is also displayed:

High-water mark licenses
Threshold value
Soft stop

— Soft stop enabled

For reservable licenses, the following information is also displayed:
— Number of reserved licenses

— Number of unreserved licenses

For reserved licenses, the following information is also displayed:
— User for whom licenses are reserved

— Group for which licenses are reserved

— Node for which licenses are reserved

For concurrent licenses, the following information is also displayed:
— Multiuse rules

— RDK Enabled

— Serial number

— Subserial number

- Upgrade Count

- Upgrade Index

For try-and-buy licenses, the following information is also displayed:
- Try-and-buy flag

For concurrent-offline licenses, the following information is also
displayed:

— The maximum offline period for offline licenses

— RDK Enabled

—  Multiuse rules

— Serial number

— Subserial number

- Upgrade Count

- Upgrade Index

For compound passwords, the following information is also displayed:
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— Derived license type

- Aggregate duration

— Derived start type

— Derived expiration date

— For products with customer-managed use control and concurrent or
reservable licenses, the following information is also displayed:

- Enrolled licenses

- Distributed licenses

- To be distributed licenses
- High-water mark licenses
- Threshold value

- Soft stop

— For products with customer-managed use control and use-once
licenses, the following information is also displayed:

- Enrolled licenses
- Distributed licenses
- To be distributed licenses
- Threshold value
-t license_timestamp

Use the optional -t license_timestamp argument to list information about a
specific license.

Examples: List all servers:
LUMbTt -Tn

List all vendors on all servers:
LUMb1t -1v

List all vendors on server Hall:
LUMb1t -1v -n Hall

List all products on server Hall:
LUMb1t -Tp -n Hall

List all products on server mercury provided by vendor Opticon, Inc.:
LUMbTt -Tp -n mercury -v "'Opticon, Inc.'"

List detailed information for the product PsychoSynch, with any version and any
feature, on server venus:

LUMb1t -Tp -n venus -p "PsychoSynch * *" -i

List information for the 12 version only, with any feature, of the product
PsychoSynch:

LUMb1t -1p -p"PsychoSynch 12 ="

List all of the products on the server neptune that are currently being used by the
user Alex:

LUMb1t -Tp -n "neptune" -u Alex
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LUMDbIt -m Monitor and Log Threshold Events

This option displays the threshold messages and logs them if the threshold logging
option is specified.

Syntax:

LUMDIt -m

[ -T percentage [ 1..100 ] ]

[ -A periodic_mode [ yes | no ] ]
[ -X frequency [ 1..1440 ] ]

[ -1log [ yes | nol]]

Parameters:

-T percentage
Specifies the level of threshold value. It can be any number between 1 and
100. The default is 80. This is the percentage over which you want to log
the level of usage of each product installed on all the servers. For instance,
if you have 100 licenses of the product Icon Editor Version 15, with the
clipart feature, and you set the level of threshold to 10, a message appears
in the vendor messages report only if more than 10 licenses are in use. If
20 licenses are being used, the message will say:

The 20% of licenses of Icon Editor 15 clipart is in use.

Note that a customer-managed product might have its own threshold
value, set with the LUMDbIt -U command. Such a threshold value overrides
the -T value.

-A periodic_mode
Specifies whether to check the license usage of the products only once, or
periodically. Its values can be:

* no To check the threshold conditions on the products once, immediately.
If -A is omitted, this is the default.

* yes To check the threshold conditions on the products periodically, with
the frequency specified with the -X parameter.

-X frequency
Specifies the number of minutes between one license usage check and the
next. Enter a value between 1 and 1440. It is mandatory if you set the A
parameter to yes.

-1log  Specifies whether or not the threshold messages must be logged on the
license server to be reviewed with the report function.

Examples: Set the threshold percentage to 50% and set the check on the products’
usage to every 4 hours:

LUMbTt -m -T 50 -A yes -X 240

Chapter 6. License Use Management Runtime Command Line Interface 127



LUMDIt - Basic License Tool

LUMDIt -r Generate a Report
All users can use this option to list server, event, vendor, product, and user
information on specified license servers.

Syntax:

LUMDIt -r report_type [1 | 2 1 3 1 4 1 51 6]
[ -b start_date |

[ -g end_date ]

[ -e event_filter ]

[ -n server_names |

[ -v vendor_name ]

[ -p product_name product_version product_features |
[ -u user_names |

Parameters:

-1 report_type
Specifies the type of report to generate. The following report types are
available:

1 - Standard Event Report
Displays detailed information about significant events occurring on
the license servers that you specify. Available for all license types.

2 - License Request by Product Report
Displays statistical information about the use of the licenses of a
product, on the license server that you specify, for the time interval
you specify. For each product, it reports the licenses requested, the
licenses granted, and the percentage of rejections. Not available for
simple nodelocked or use-once licenses. You can specify only one
server for each report.

3 - License Request by User Report
Displays statistical information about the use of products by users,
on the license server that you specify, in the time interval you
specify. For each user, it reports the licenses requested, the licenses
granted, and the percentage of rejections for each product the
person is using. Not available for simple nodelocked, reserved, or
use-once licenses. You can specify only one server for each report.

4 - License Use by Product Report
Displays statistical information about the use of the licenses of a
product, on the license server that you specify, in the time interval
you specify. For each product, it lists the maximum number of
concurrent nodes that used the product, the maximum number of
concurrent users, and the average time of use of the product.
Statistical information about events appears after the license
release. Not available for per-seat, simple nodelocked, reserved, or
use-once licenses. You can specify only one server for each report.

5 - License Use by User Report
Displays statistical information about the use of the licenses of a
product, on the license server that you specify, in the time interval
you specify. For each user, it lists the number of times each product
was invoked, and the average time the user used each product.
Statistical information about events appears after the license
release. Not available for per-seat, simple nodelocked, reserved, or
use-once licenses.You can specify only one server for each report.
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6 - Customer-Managed Use Audit
Reports the following information for customer-managed use
product transactions:

-b start_date

Vendor name

Product name

Product version

Product features

Administrator information

Time stamp of the event

Number of licenses involved in the transaction

Event list (product enrolled, license distributed, license deleted,
license updated)

Signature stamp (user, group, and node)
Signature information

Available for all license types.

Specifies the start date of a report. Be sure to express the date using the
mm/dd/yyyy format. If you specify a start date and do not specify an end
date, the report will include all information logged from the specified start
date until the present.

-g end_date

Specifies the end date of a report. Be sure to express the date using the
mm/dd/yyyy format. If you specify an end date and do not specify a start
date, the report will include all information logged prior to (and including)
the specified end date.

-e event_filter

You can use the event_filter argument to generate a Standard Event report
on the following types of events which you specify, by number, on the
command line. (Separate multiple event type arguments with a comma.)

1

2
3
4
5

- serover_names

All events

License-related events

Database-related events

Errors — general errors, but not including unrecoverable errors

Server-related events — start/stop events, threshold events, vendor
events, unrecoverable errors

Names of the servers about which you want to display information. If you
want to generate a report for report types 2, 3, 4, or 5, you can specify only
one server name.

-v vendor_name

Name of the vendor about whose products you want to display
information.

-p "product_name product_uversion product_features”
The information on the licensed product about which you want to display
information.

product_name
The name of the product for which you want to display
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information. Enclose the product_name with single quotation marks
(") when the product_name contains spaces.

product_version
The version of the product that you specified in the product_name
parameter.

product_features
The features of the product that you specified in the
product_features parameter. Enclose the product_features with single
quotation marks (') when the product_features contain spaces.

-u user_names
Names of users about whom you want to display license usage
information.

Examples: Standard Event Report:

Report on license-related events (2) and server start and stop events (5) that were
logged on server neptune since May 21, 2005:

LUMbTt -rl -n "neptune" -b 05/21/2005 -e 2,5
License Use by Product Report:

Report current license usage information on server saturn for the product LUM
Test Product, version 10, with the debug feature:

LUMb1t -r4 -n "saturn" -p "'LUM Test Product' 10 debug"
License Request by User Report:

Report current license usage information on server mercury for users alex, ann,
mary, christine, paul, and alby:

LUMbTt -r3 -n "mercury" -u "alex ann mary christine paul alby"
Customer-Managed Use Audit Report:

Report information about customer-managed use product transactions on all
network license servers from May 1, 2005 to July 31, 2005:

LUMbTt -r6 -b 05/01/2005 -g 07/31/2005
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LUMDbIt -R Reserve Licenses; Delete or Update Reserved
Licenses

Use LUMBDIt -R to reserve reservable licenses and to delete or update the
reservation status of reserved licenses.

Syntax:

LUMDIt -R action_type [ r | d | u ]

-n server_name

-v vendor_name

-p " product_name product_version product_features
[ -t timestamp |

[ -g end_date ]

[ -H end_time |

[ -u user_id user_group user_node ]

"

Parameters:

action_type
To reserve licenses, r; to delete reservation, d; to update an existing
reservation, u.

-n server_narme
The name of the server where the product license is enrolled.

-v vendor_name
The name of the vendor that manufactured the product.

-p "product_name product_uversion product_features”
The information on the licensed product whose licenses you intend to
reserve, delete, or update.

"product_name’
The name of the product whose licenses you intend to reserve, delete, or
update. Enclose the product_name with single quotation marks (") when the
product_name contains spaces.

product_version
Version of the product whose licenses you intend to reserve, delete, or
update.

product_features
The features of the product whose licenses you intend to reserve, delete, or
update. Enclose the product_features with single quotation marks (') when
the product_features contain spaces.

-t timestamp
Unique timestamp of the product license from which you intend to reserve,
or that you intend to delete or update. To get the timestamp, issue the
following command:

LUMb1t -Tp -p "product_name product_version product_features" -i

If you are reserving licenses (option -R 1), the timestamp is optional. If it is
omitted, the first usable reservable license is used.

-g end date
The end date of the new or updated reservation (mm/dd/yyyy). The latest
allowed expiration date of a reservation is 12/31/2037. If you are deleting
licenses (-R -d), do not specify -g.
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-H end time
The end time of the new or updated reservation (hh:mm). If you are
deleting licenses (-R -d), do not specify -H.

-u user_id user_group user_node
The identification of the user, group, and node for which a license is being
reserved or a reservation is being changed. If you are deleting licenses (-R
-d), do not specify -u.

Examples: Reserve one license for the Test Compiler product, taken from the
reservable license identified by the timestamp 1124071854496125, Version 11, with
the special function library feature, of vendor Psychosync for the user alex of the
testers group, on the node venus. They expire March 2, 2007, at 11:00.

LUMb1t -R r -v "Psychosync" -p "'Test Compiler' 11 'special function Tibrary' "
-t 1124071854496125 -g 03/02/2007 -H 11:00 -u "alex testers venus"
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LUMDbIt -s Display Product License Status
All users can use this option to display information about current product usage
on specified license servers.

Syntax:

LUMDIt -s

[ -1 list_type [ ¢ | co | pt | ru]]

[ -n server_names |

[ -v vendor_name ]

[ -p " product_name product_version product_features " ]
[ -u user_names |

[ -t license_timestamp ]

Parameters:

-1 list_type
Indicates the type of license usage you want to list. You can specify one of
the following list types:

c To display information related to concurrent users of concurrent
and concurrent-offline licenses. Because concurrent-offline licenses
can also be used as a concurrent license, you can see which users
are using concurrent-offline licenses in a concurrent mode.

co To display information related to users who have reserved
concurrent-offline licenses in offline mode.

pt To display information related to application clients that use
per-seat licenses.

ru To display information related to users of unreserved reservedly
licenses

-n server_names
The name of each of the license servers for which you want to display
product usage information.

If you omit the -n parameter, the display defaults to all servers in your cell.
This parameter is not used if you use pt as the list type.

-v vendor_name
The name of the vendor about whose products you want to display
information.

-p "product_name product_uversion product_features”
The information on the licensed product for which you want to display
information.

product_name
The name of the product for which you want to display
information. Enclose the product_name with single quotation marks
(") when the product_name contains spaces.

product_version
The version of the product that you specified in the product_name
parameter.

The wildcard character (*) can be used to denote any.

product_features
The features of the product that you specified in the
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product_features parameter. Enclose the product_features with single
quotation marks (") when the product_features contain spaces.

The wildcard character (*) can be used to denote any.

Note: If you use LUMbIt -s without any option the usage of concurrent
licenses will be displayed.

-u user_names
Use the optional -u user_names argument to display product usage
information for the specified products that are currently in use by the
named users.

-t license_timestamp
Use the optional -t license_timestamp argument to list information about a
specific license.

This command displays the following information for the servers, vendors,
products, and users that you specify:

* Vendor name

* Product name

* Product version

* Product features

» Total number of installed licenses

* Number of licenses currently in use

* Number of soft stop licenses currently in use
e Number of licenses not in use

For each user who currently holds a license, the following information is
displayed:

¢ User name

* Node name

* Group name

* Number of licenses the user has been granted

* Check-out date for each granted license

Examples: Display current license availability and usage information for
concurrent licenses of the Monolith Inc. product Megamail/2, any version, any
features, on server uranus:

LUMbTt -s -1c -n "uranus" -v "'Monolith Inc.'" -p "Megamail/2 x ="
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LUMDIt -S Set the Stress Threshold

Use this option to set the network license server load threshold.
Syntax:
LUMDIt -S threshold_value -n server_name

Parameters:

threshold_value
Indicates the level of the load threshold. The range for this parameter is
from 1 to 100.

-n server_name
The name of the license server for which you want to set the load
threshold.

Examples: Set the workload threshold to 70% for network license server uranus.
LUMbTt -S 70 -n uranus
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LUMDbIt -T Activate or Deactivate Tracing

Use this option to set the trace level on a specified network license server, or to
change to a different level of tracing. Traces are written to output files whose file
names have the format:

LUMImd. trcxx

where xx identifies a particular file in the sequence. For example, the first file
would be named LUMImd.trcl, the last file would be named LUMImd.trc99. When
LUMImd.trc99 is full, the license server begins writing traces to LUMImd.trcl again.
The current trace file has an underscore appended (for example, LUMImd.trc4_. By
default the trace files are stored in the following directories:

AIX /var/LicenseUseManagement/trace

Windows
Documents and Settings\A11 Users\Application Data\IBM\License Use
Management\trace

Syntax:
LUMDIt -T level-of-tracing -n  server_name

Parameters:
level-of-tracing
Indicates the level of tracing, as follows:
0 — No trace
1 — High (high level trace). Server logic and database transactions.
2 — Low (low level trace). Network communication.
3 — Low & high (low and high level trace)
-n server_name
The name of the network license server for which you want to activate or
deactivate the trace. You can activate or deactivate tracing for one server at
a time. If you omit the -n server_name parameter, the tracing will be

activated or deactivated on the local network license server (if there is
one).

Examples: Set a high trace level for the network license server uranus.
LUMbTt -T 1 -n uranus
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LUMbiIt -U Update a Product

Use this option for the following purposes:

* To update the number of licenses you enrolled. Use it when you acquire new
licenses for an already enrolled customer-managed use product, to update the
total number of licenses you are entitled to use. In the case of a network
compound password, the licenses must be distributed after the update to make
them available to end users. This option is valid only for customer-managed use
products.

* For a product with the hard stop/soft stop policy enabled, to change the hard
stop/soft stop policy and to reset the high-water mark. This option is valid only
for customer-managed use products.

* To update the threshold value of a product. This option is valid only for
customer-managed use products.

* Set the maximum allowed period that a concurrent-offline license can be
reserved.

Syntax:

LUMbIt -U

-v vendor_name

-p "product_name product_version product_features
[ -n server_name ]

[ -T enrolled_licenses |

[ -H hard_soft_mode [ yes | no ] ]

[ -M hwm_reset |

[ -t threshold [ 1...100 ] ]

[ -I signature_information |

[ -O MaxOfflinePeriod ]

”

Parameters:

-v vendor_name
The name of the vendor that manufactured the product that you intend to
update.

-p product_name product_version product_features
The information on the licensed product that you intend to update.

product_name
The name of the product for which you have acquired the new
licenses. Enclose the product_name with single quotation marks (")
when the product_name contains spaces.

product_version
The version of the product that you specified in the product_name
parameter.

product_features
The version of the product that you specified in the product_name
parameter. Enclose the product_features with single quotation marks
(") when the product_features contain spaces.

-n server_name
Name of the license server on which you want to update product
information. If the product has network licenses, this parameter need not
be specified, because the server is the central registry license server.
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-T enrolled_licenses
The total number of licenses you have for the specified product; that is, the
number of licenses you had, plus the new ones.

-H hard_soft_mode
Use this parameter to switch the product behavior from hard stop to soft
stop and vice versa. You can do it only on products the vendor has
enabled to allow hard stop/soft stop switching. Allowed values for -H are:

no Set the soft stop
yes Set the hard stop

-M hwm_reset
Use this parameter to reset the high-water mark to 0. You can do it only on
products the vendor has enabled to soft stop.

-t threshold
Use this parameter to set a specific value for the threshold value of a
customer-managed product. Allowed values are 1 to 100.

-1 signature_information
Information about the user issuing the command, to be stored with the
signature stamp. Use this parameter with the -T parameter.

-O MaxOfflinePeriod
The maximum allowed period that a concurrent-offline license can be
reserved. Use this parameter with the -v and -p parameters.

Examples: The Test Compiler product (version 11, with the special function
library feature, vendor Psychosync) has network licenses. Update the number of
licenses to 50.

LUMb1t -U -v "Psychosync" -p "'Test Compiler' 11 'special function Tibrary' "
-T 50 -I "'Paula'"

For the same product, set the soft stop policy and reset the high-water mark.

LUMbTt -U -v "Psychosync" -p "'Test Compiler' 11 'special function Tibrary' "
-H no -M

For the ScreenPic product (version 2, high resolution feature, vendor ArtTools),
update to 5 the number of nodelocked licenses on server Virginia:

LUMb1t -U -n Virginia -v "ArtTools" -p "ScreenPic 2 'high resolution' " -T 5

To update (to 50) the maximum number of days a product can be reserved:
LUMb1t -U -v "'IBM Corporation'" -p "DataMaster 31 instrumented" -0 50
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LUMDbIt -x Delete Server Log Entries

This option deletes all entries before a specified delete date from the log file of the
license servers that you specify. If one of the specified license servers has the
central registry, the central registry log entries are also deleted.

Syntax:

LUMDIt -x delete_date
[ -n server_names |

Parameters:

-x delete_date
Specifies an end date for the delete operation. All log entries recorded
before the delete date are removed from the log file. You must specify a
delete date in the mm/dd/yyyy format. If you do not specify a delete_date
value, all entries in the log file are deleted.

-n server_names
Specifies the license servers from whose log file you want to delete the
entries.

Examples: Delete all the log file entries recorded on server neptune before August
25, 2005:

LUMb1t -x 08/25/2005 -n neptune

Delete all the log file entries recorded on all network license servers before August
25, 2005:

LUMb1t -x 08/25/2005
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LUMcfg - Configuration Tool

ALL Use the LUMcfg command as an alternative to the Configuration Tool GUI to
configure your workstation. Before coding the LUMcfg command, see
[Configure” on page 52|to plan your configuration requirements. If issued with no
options, the LUMcfg command starts the Configuration Tool GUL

Syntax

LUMcfg [-a{{c¢sr} | {CSR}}]
[ -b "binding_list" ]

[ -d { option_string | all } ]

[ -e { a | { ertrcrngrmIP:S } } ]
[ -h ]

[ -1 logfile_path ]

[ -list ]

[ -R{as}]

[-S{as}]

[ -start ]

[ -stop |

[ -t "listening_ports” |

[ -g group_name ]

(&]

Parameters

E

-a The roles the workstation is to play in your licensing environment. Code
any combination of these values, optionally separated by commas:

c Reset the current role of the workstation to network license client.

s Reset the current role of the workstation to network license server.

r Reset the current role of the workstation to central registry license
server.

C Update the current role of the workstation to include network

license client.

S Update the current role of the workstation to include network
license server.

R Update the current role of the workstation to include central
registry license server.

-b "binding_list"
The complete list of servers (network license servers and central registry
license server) with which this workstation will communicate in a direct
binding environment. Enclose the complete list in double quotes. Specify
the network license servers and central registry license server as follows:
"network ip:network addressl [ port_numberl ] ip:network_address2

[ port_numberz ] ...
'registry ip:network address [ port_number ]'

-d option_string
Display the current configuration settings for the LUMcfg options specified
in option_string. Code all to see the current settings of all the options.

For example, LUMcfg -d elS requests a display of which events are being
logged, the path to the log databases, and a list of startup options showing
which are enabled and which are disabled.
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The list of events you want to be logged. Code a to log all events, or any
combination of these values, optionally separated by commas:

¢ - License checkin
Tells you when a licensed product has sent a check-in call to the
server to notify that the product is running. This is not logged by
default.

t - License timeout
Tells you that the server has canceled the request for a license
because the check period expired. This is not logged by default.

e - Errors
Describes all types of server errors that do not stop the server. This
is logged by default.

g - License grant/release
Tells you when a license was granted or released. This is not
logged by default.

v - Vendor added/deleted
Tells you when a product of a new vendor was registered or
deleted. This is logged by default.

m - Vendor messages
Provides the log messages the vendor inserted in the enabled
product. This is logged by default.

p - Product added/deleted
Tells you when a new product was registered or deleted. This is
logged by default.

s - Server start/stop/threshold
Logs the successful start or stop of the license server, and when the
threshold on the workload is exceeded or regained. This is not
logged by default.

Displays command syntax and usage information about the Configuration
Tool CLIL

-1 logfile_path

-list
-R

The path in which you want log files to be stored.
Displays a list of active subsystems.

Startup options that you want to disable. Code any combination of these
values, optionally separated by commas:

a Automatic startup of subsystems at system startup (disabled by
default).

s Remote administration of network license server (enabled by
default).

Note: This parameter is not valid for network clients.

Startup options that you want to enable. Code any combination of these
values, optionally separated by commas:

a Automatic startup of subsystems at system startup (disabled by
default).

s Remote administration of network license server (enabled by
default)

Chapter 6. License Use Management Runtime Command Line Interface 141



LUMcfg - Configuration Tool

Note: This parameter is not valid for network clients.

-start  Starts all the subsystems you have configured to run on the workstation.

Note: If you are running in a Solaris environment and are using a
non-Korn shell, you can start the server using LUMcfg -x -start.
This will close the terminal window from which this command was
run and the server will continue to work in background.

-stop  Stops all the subsystems that are running on your workstation.

-t "listening_ports”
Use this parameter to change the default port numbers, as follows:
"ip 'netls port,crls port'"

The two subparameters for port numbers are positional. If you omit one,
its value is reset to the default. For example:

ip
“ip '2216,10998'"
"ip ’,11998’"

E -g group_name

The name of the group to which the user of this workstation belongs.

E

Examples

1. Configure a network license server (thelma). Specify automatic startup of the
server, and customize the path to the log files and the selection of events
logged. Configure to communicate with:

* Network license server louise
* Central registry license server speedy
With direct binding on AIX:

LUMcfg -a s -S a,s -e cegvp -1 /home/maveret -b "'network
ip:thelma ip:Touise' 'registry ip:speedy'"

With direct binding on Windows:

LUMcfg -a s -S a,s -e cegvp -1 c:\LUM\1og

-g Infotech -t "ip" -b "'network ip:thelma ip:louise’
'registry ip:speedy'"

2. Configure a network license client that will communicate with a workstation
named thelma that is configured as both a network license server and the
central registry license server. For Windows specify the user group.

With direct binding on AIX:
LUMcfg -a ¢ -b "'network ip:thelma' 'registry ip:thelma'"
With direct binding on Windows:

LUMcfg -a ¢ -g Infotech -b "'network ip:thelma’
'registry ip:thelma'"

3. Configure a workstation named thelma as the central registry license server
and a network license server. Configure to communicate with a network license
server named hydra. Specify automatic startup of the servers, and for Windows
specify the user group.

With direct binding on AIX:

LUMcfg -a s,r -S a,s -b "'network ip:thelma ip:hydra’
'registry ip:thelma'"

With direct binding on Windows:
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LUMcfg -a s,r -S a,s -g Infotech -b "'network ip:thelma ip:hydra’
'registry ip:thelma'"

4. Display the command syntax and usage:
LUMcfg -h
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LUMtv - Test Verification Tool

ALL

E

Use the LUMLtv tool after the license servers are started to verify that they are
running properly.

A message describing a completed license transaction and a list of all license
servers will be displayed. If an HAL cluster has been configured and activated,
LUMtv tries to request all the 10,000 licenses of the HAL Test Product in order to
contact all the servers in serving state.

Syntax
LUMtv { [ -n hostname 1 [ -z ] [ -v ] | { -h | -usage | -version }

[ -p number_of_transactions ]
[ -d ] (Windows only)}

Parameters

-n hostname Checks that the specified workstation is running a network license
server. It returns O if the hostname is running a network license
server and 1 if the hostname is not running a network license
server.

-z Turns on NCS remote procedure call (RPC) tracing messages,
which can be used to diagnose problems.

-v Displays progress messages during the license request operation.

-h Displays command usage information (same as -usage). This
parameter is valid only when issued without other parameters.

-usage Displays command usage information (same as -h). This parameter
is valid only when issued without other parameters.

-version Displays command version information. This parameter is valid

only when issued without other parameters.

-p [number_of_transactions]
Specifies the number of transactions to be completed before
performance information is displayed. This information provides
averages for the specified period. It can be used for tuning the
system and for troubleshooting performance problems. The default
value is 1000.

-d Windows only. Checks whether you can exploit offline
functionality on this computer.

Examples
Run the LUMtv test and verification tool:
LUMtv

Check for the presence of the license server pluto:
LUMtv -n pluto

Measure license server performance:
LUMtv -p
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LUMtarget - Target View Tool

ALL

Use the LUMtarget tool to display the target ID of your workstation.

Syntax
LUMtarget [ -V | -0 | -h | -d devicename | [ -z ] [ -v ]
(on Windows)

Parameters

-V Displays command version information.

-0 Displays the operating system name of your workstation.

-h Displays command usage information.

-v Displays information in verbose mode. On Windows, the information that

this parameter displays includes the NDIS level of the device driver.

-d devicename
Specifies that the device driver devicename is to be used to retrieve the
target ID (Windows only).

-z Displays all the available network cards with their names; use it to check
the available network devices before using the -d parameter to select a
device driver manually (Windows only).

For Windows, the target ID is retrieved from the device driver that controls the
network adapter, rather than from the operating system. This mechanism results in
the highest level of security and makes it possible for the target ID to work even
when the workstation is not connected to the network.

For this mechanism to work, the following must be installed on the workstation
where the license will be installed:

* A device that complies with NDIS 4.

 The latest level of the device driver. For IBM device drivers, you can check at
[http:/ /www.networking.ibm.com| to determine the latest level.

* TCP/IP.

* If License Use Management Runtime is not yet installed on the workstation, you
can download it from the License Use Management Web site
(http: / /www.ibm.com /software /lum), or the vendor of the license-enabled
products can supply it to customers.

The target ID is retrieved from the device driver that controls the network adapter.
You might want to specify explicitly the device driver to be used to determine the
target ID. You would do this if either of the following points were true:

* Your workstation has multiple network adapters and you prefer to use an
adapter other than that automatically selected as the basis for the target ID.

* The LUMtarget command did not return a target ID.

Perform the following steps:

1. Get the device identifier of the adapter you want to use by entering the
command LUMtarget -z. This displays all the devices on the workstation and
card description. Make sure the network device you want to use is listed. For
example:
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LUMtarget Version 5.1.1 Windows -- LUM Target ID Tool

(c) Copyright 1995-2006, IBM Corporation, A1l Rights Reserved

US Government Users Restricted Rights - Use, duplication or disclosure
restricted by GSA ADP Schedule Contract with IBM Corp.

(c) Copyright 1991-1997, Gradient Technologies Inc., All Rights Reserved
(c) Copyright 1991,1992,1993, Hewlett-Packard Company, A1l Rights Reserved

{1802COF6-8412-4377-97DA-24D39C637683} (Intel(R) PRO/Wireless
2200BG Network Connection)

{48EB1820-FD5A-4512-983C-9902364E3BBD} (Bluetooth LAN Access
Server Driver)

2. Enter the command:
LUMtarget -d device_identifier

For example, LUMtarget -d {CDEE7F7A-A2F9-4CEE-907B-F689DOEBF52D}
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LUMImd - Network License Server

ALL

The LUMImd subsystem starts the network license server on the local node. If the
workstation is not configured to run the network license server, LUMImd has no
effect.

The parameters of LUMImd override the corresponding settings in the lum_ini.txt
file.

Syntax

startsrc -s LUMImd [ -a " [ -no event_list | [ -v ] [ -z ] [ -1 log_name ]
[s][r][=<][-p]"

] (on AIX)

LUMIs [ -no event_list | [ v ] [-z][-1logname ][ -s][-r][-<][-p]
(on Windows)

Parameters

-no event_list Turns off logging of the events specified in event_list. Any
combination of events is valid, but items in the list of events must
not be separated by spaces or other characters. Following are the
event types that you can specify:

1 Grant and release licenses.

c Check in licenses. (Licensed products usually check in with
the license server at regular intervals while a user is using
the product.)

v Vendor events: a vendor was added, renamed or deleted.

P Product events: a product was added, renamed, or deleted.

e Errors.

m Messages.

s Logs the successful start or stop of the license server, and
when the threshold on the workload is exceeded or
regained.

t License timeout events. (When a licensed product fails to
check in with the license server, it might stop running after
it times out. The vendor of the product sets the timeout
interval, which is how long a product can run after it has
lost contact with the license server.)

-v License Use Management Runtime library verbose mode.
-z Debugging flag. Prints RPC debugging information.
-1 log_name Overrides the default name and location of the file used to store

log information. This allows the I/O activity to the files used by
the license server to be spread across multiple file systems that
might become important for large installations.

-s Instructs the license server to ignore attempts from administrators
on remote systems to modify the license database. Records in the
database remain readable by all instances of the License Use
Management Runtime Administration Tool.

-r Recovers files from the automatic backup version.
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-c Specifies that this is a cold start, meaning that the license server
restarts from scratch, as if it had granted no licenses before
stopping.

S Specifies that LUMImd is to display performance information at

specified intervals. The default and maximum interval is 1000 calls
received from clients. To change the frequency of reporting, change
the environment variable LUM_POLL_FREQ. This option is linked
to the DebugProc tag in the lum_ini.txt file.

Examples
Start a license server on AIX and do not log checkin, vendor, product, timeout, or
message events:

LUMstartprc LUMImd -no cvptm

To start a license server, changing the default log-file on AIX:
startsrc -s LUMImd -a "-1 /home/smith/my_Tog"

To start a license server, changing the default log-file on Windows:
LUMIs -1 C:\my_log
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LUMgdb - Central Registry License Server

ALL

The central registry is a License Use Management Runtime subsystem that
provides a mechanism for storing data pertaining to licensing information.

The basic license tool requires a central registry license server up and running to
administer customer-managed use products.

You must double-check that you have started one and only one central registry
license server in your licensing environment by issuing the following command on
every License Use Management Runtime server:

LUMcfg -Tist

If the workstation is not configured to run the central registry license server,
LUMgdb has no effect.

The parameters of LUMgdb override the corresponding settings in the lum_ini.txt
file.

Syntax
startsrc -s LUMgdb [ -a " [ -no event_list | [ -v | [ -1 log_name ]
[tr][-c][-z]"] (on AIX)

LUMIs -a [ -no event_list ] [ -v | [ -1 log_name ] [ -r ] [ -c ]
[ -z ] (on Windows)

Parameters

-no event_list  Turns off logging of the events specified in the event list. Any
combination of events is valid, but items in the event list must not
be separated by spaces or other characters. Following are the event
types that you can specify:

1 Grant and release licenses.

c Check in licenses. (Licensed products usually check in with
the license server at regular intervals while a user is using
the product.)

v Vendor events: a vendor was added, renamed or deleted.

P Product events: a product was added, renamed, or deleted.

e Errors.

m Messages.

s Starts and stops of this license server.

t Time out.

-v License Use Management Runtime library verbose mode.
-1 log_name Overrides the default name and location of the file used to store

log information. This allows the 1/O activity to the files used by
the license server to be spread across multiple file systems that
might become important for large installations.

T Recovers files from the automatic backup version.
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LUMgdb - Central Registry License Server

-c Specifies that this is a cold start, meaning that the license server
restarts from scratch, as if it had granted no licenses before
stopping.

-z Debugging flag. Prints RPC debugging information.
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Chapter 7. Hints and Tips

This chapter provides information that is intended to help you manage your
licensing environment better.

Managing the Time Zone

E To display the correct time in administration tool panels:

1. Click Start --> Settings --> Control Panel --> System --> Advanced -->
Environment Variables.

2. In the System Variables box, click New to open the New System Variable
dialog. In the Variable Name entry field, type TZ.

3. In the Variable Value entry field, type:
XXXsnnYYY
where:

XXX and YYY
Characters you choose to remind you of the setting

s A sign: + or -

nn The difference in hours from Greenwich mean time (GMT). A positive
difference means the Greenwich is west of your location; a negative
difference means that Greenwich is east of your location. For example,
you might specify Italian standard time (one hour east of Greenwich
mean time, or GMT+1) as:
IST+1GMT

4. Click OK.

Remember to adjust this time to account for standard time and daylight savings
time in different countries.

Using the Built-In Backup and Recovery Procedure

ALL Because the breakdown of license servers might have a potentially severe impact
on production, it is important to be prepared in case definitions and database files
are corrupted.

The minimum backup activity the administrator should do is to keep the
enrollment certificate files (or e-mail or hard copy equivalents) received from the
license provider in a secure place.

License Use Management Runtime implements a backup procedure of all databases
on license server workstations.

Causes for Corrupted Definition or Database Files

There are many situations that can cause the definition or database files to become
corrupted. The most common causes are License Use Management Runtime-related
issues.

© Copyright IBM Corp. 1995, 2006 151



License Use Management Runtime-Related Issues

Because License Use Management Runtime uses the database files dynamically,
any disk-related problems such as the following might cause the database files to
become corrupted:

* Hardware failures (media surface errors)
* File-system problems (for example, file system full)

* Synchronization errors during writing of data (that is, loss of electrical power)

When a License Use Management Runtime database is corrupted, after the
database has been recovered, try to find out the real cause of the problem.

The contents of the definition and database files used by NCS and by License Use
Management Runtime are changed only by defined administrative commands and
tools.

Automatic Backup Procedure

License Use Management Runtime does an automatic periodic backup on license
servers by copying all files and databases to the following file system:

e /var/LicenseUseManagement/backup on AIX

e c:\Documents and Settings\A11 Users\Application Data\IBM\License Use
Management\backup on Windows

You can choose to get the backup on any other device by changing the
BackupPath parameter in the configuration file (Tum_ini.txt). You can set the
automatic backup to occur daily, at a certain time, (the default), or weekly, on a
certain day, or at every change on the license database, according to the
BackupMode and BackupParm parameters specified in the configuration file. You
can also disable the automatic backup procedure by setting the BackupMode
parameter to none.

For detailed information on the configuration file (Tum ini.txt) seelgppendix A,|
[‘License Use Management Runtime Configuration File,” on page 179

Be sure that the BackupMode and BackupParm parameters have the same value
on all servers in the licensing environment.

The objects listed in /var/LicenseUseManagement/scripts/db_back.sh on AIX are
backed up if found.

Recovery Procedure

To recover the files and databases saved with the automatic procedure described in
[“Automatic Backup Procedure”}

1. Identify the workstation that has corrupted files or databases.

2. Stop the License Use Management Runtime services by issuing the following
command:

LUMcfg -stop

or alternatively on Windows by selecting Stop from the Service pull-down
menu of the service manager tool.

3. Issue the following command:
* LUMImd -r on AIX
* LUMIs -r on Windows
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4. Start services by issuing the following command:

LUMcfg -start

This replaces the current objects with those saved with the backup procedure.

Important: In case of corruption, run this command according to the following

rules:

¢ If the BackupMode in the configuration file (Tum_ini.txt) is set to changes,

run the recovery command only on the server where corruption occurred.

* If the BackupMode is set to daily or weekly, first check that the backup

copies have the same date on all the servers of your licensing environment,

then run the backup command on all the servers.

Manual Backup

You can run the backup procedure manually by running:

/var/LicenseUseManagement/scripts/db_back.sh on AIX

On supported Windows platforms, use the ntbackup tool (ntbackup.exe) to
perform backup and recovery of the following directory and files:

— c\Documents and Settings\ All Users\ Application Data\IBM\License Use

Management\nodelock\

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\lum_ini.txt

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\licdb.dat

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\licdb.idx

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\crpdb.dat

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\crpdb.idx

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\log\logdb01.dat

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\log\logdb01.idx

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\log\logdb00_.dat

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\log\logdb00_.idx

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\log\crlog01.dat

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\log\crlog01.idx

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\log\crlog00_.dat

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\log\crlog00_.idx

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\usrdb.dat

c:\Documents and Settings\ All Users\ Application Data\IBM\License Use
Management\usrdb.idx
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Note: The list contains the file names from the default configuration. If you
change the file names from those used in the default configuration,
substitute the new file name for the one shown in the list. You can also
add additional files as needed, according to your environment.

On a workstation configured only as a network license client, only manual backup
is available.

This command copies the files and databases:
* to the backup file:
/tmp/1um_bak_DATE_SERVERNAME on AIX
* to a backup diskette:
the a: drive on Windows XP and Windows Server 2003

Manual Recovery

To start the recovery procedure in case of corruption, use the following command
on the failing workstation:

/var/LicenseUseManagement/scripts/db_recov.sh Tum_bak_DATE_SERVERNAME for
AIX

This command restores the files and databases that were saved by the db_back
command and lum_bak_DATE_SERVERNAME is the name of the backup file.

Managing the Reports Log Files

'Y

=

When you ask for a report, the Basic License Tool reads the current log files:

On AIX:
/var/LicenseUseManagement/1og/1ogdbnn_ (network license server)
/var/LicenseUseManagement/1og/crlognn_ (central registry license server)

On Windows:

c:\Documents and Settings\All Users\Application Data\IBM\License Use
Management\log\logdbnn_ (network license server)

c:\Documents and Settings\A11 Users\Application Data\IBM\License Use
Management\log\crlognn_ (central registry license server)

The names of the current log files end with an underscore.

The files 1ogdbnn, crlognn, and 11mlgnn contain all the collected License Use
Management Runtime events. You can specify which events are to be collected
when you configure each license server. See the example in |"Scenario 1:|
[Configuring a Network License Server” on page 55/nn can assume values from 00
to 99. When a file is full, a new one is started. You determine the maximum value
nn can assume and the maximum size of each file by setting the
NumberOfLogFile and MaxLogFileSize parameters in the configuration file,
(Tum_ini.txt). When the maximum value for nn is reached, License Use
Management Runtime wraps to 00. The filled log files are retained so that you can
archive them if you wish before the numbering wraps. For details see |Appendix A,|
[License Use Management Runtime Configuration File,” on page 179
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The numbering of log files starts from 00. Suppose you have the following files on
the workstation:
Togdb00

Togdb01_
Togdb02

The second file is the current, the first is the previous, and the third is the oldest.

On the machine where the basic license tool is run, the space needed for logfiles is
given by the formula Space needed = (NumberOfLogFile * MaxLogFileSize) *10,
measured in kilobyte units.

If the current files, marked with the underscore, get too big, do not delete them.
You can decrease the size of the current files with the following command:

LUMbTt -x delete_date -n server_name

where:

delete_date Specifies an end date for the delete operation. All log entries
recorded up to the delete date are removed from the log files. If
you do not specify a date all the entries are deleted.

server_name Specifies the license server where you want to delete the entries of
Togdbnn_, crlognn_, and 11mlgnn_ if they exist on the server.

When user displays reports using both CLI and GUI, the LUMDIt tool creates a
temporary file in a default directory. The location of the default directory is
dependent on the operating system (for example, C:\ for Windows platforms, /tmp
for AIX). The size of the temporary file depends on the information stored in the
LUM database. Use the following formula to calculate if you have enough free
space to store the temporary file:

For each server contacted: Space needed = (NumberOfLogFile *x MaxLogFileSize)
*10, measured in kilobyte units.

Tuning the Environment to Manage the Workload

ALL

When a high volume of client/server interactions reaches the server in a short time
frame (for example, 100 license requests per second), the server might not be able
to keep up with the volume of workload. The external symptom is that the server
seems to hang.

To optimize the license server daemon throughput and better balance its workload,
use the information in the following sections:

+ [“Monitoring Your Environment”|

* [“Tuning Your Environment” on page 159

Monitoring Your Environment

The basic license tool Active License Servers window displays the load percentage
and the load threshold percentage for the each license server. The LUMDbIt -In
command also displays load percentage and load threshold percentage in the list
of active license servers.

Server workload can be directly monitored in four ways:
* [“Using the Basic License Tool GUI” on page 156|
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. sing the Basic License Too
“Using the Basic Li Tool CLI”
* |“Using Standard Reports” on page 157

+ ["Using the Server Tracing Service” on page 157

Using the Basic License Tool GUI
Use the following procedure to monitor the environment using the basic license
tool GUIL:

1. From the basic license tool main window (Figure 26 on page 66)), select: Servers
* Active License Servers

The Active license servers window is displayed.

Active License Servers
Zelected  Help

Target type Target ID Server type Annotation

i RDEGAETA romelab.ft.ibm.c.. Windows 220460008df01... Metwork LUMLS 5.1.0Windoves ... [Mull or MNis,

Figure 78. Active license servers window

2. For active license servers, two columns display the load threshold that is
currently set and the percentage of server workload:

Load %
An indicator of the server workload, in the range 0-100%.

Load Threshold %
The workload threshold set by the administrator, in the range 1-99%.
(see [“Setting the Load Threshold” on page 160).
When the value of Load % exceeds the Load Threshold % value, an alert
message is displayed indicating that at least one of the network license servers
is overloaded. You can now take action to reduce the load on the license server.

Note: In order to see the most up-to-date data, you must refresh the basic
license tool main window.

Using the Basic License Tool CLI

To monitor the environment using the basic license tool CLI, you can use the
LUMDlIt -In command to display additional information in the list of active license
servers. For example, use the following command to display a list for the server
louise:

LUMbTt -Tn -n Touise

The command displays a list of active license servers, an example is shown below:
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Server Name: ip:Touise.rome.tivoli.com
Target ID: 1fa460002fdf4lal

Target Type: Windows

Server Type: Network

Load: 1

Load Threshold: 85

Trace: none

Using Standard Reports

Use the following procedure to monitor the environment using standard reports:

1.

Ensure that the Server start/stop/threshold checkbox is selected in the
Configuration Tool Notebook - Log Page, or use the LUMcfg -es command (see
['LUMcfg - Configuration Tool” on page 140). Setting the logging of server and
threshold events causes events that exceed the load threshold or regain the load
threshold to be logged as Event Type = SERVER and Event Subtype = Threshold
Exceeded or Event Subtype = Threshold Regained. An example report is shown

below:

Sequence : 695 Event Type : SERVER

Time Stamp : Feb 25 2005 3:09:32 PM Event Subtype: Threshold Exceeded
Server Name : Network License Server: ip:louise.rome.tivoli.com

Sequence : 696 Event Type : SERVER

Time Stamp : Feb 25 2005 3:15:46 PM Event Subtype: Threshold Regained
Server Name : Network License Server: ip:Touise.rome.tivoli.com

2. Use either the basic license tool GUI (“Generating Reports” on page 70) or the
LUMDIt command (“LUMblt -r Generate a Report” on page 128) to view the
events.

Using the Server Tracing Service

Use this service when you have been asked by IBM Support to provide traces, or
you want to further investigate traces. The trace level can be customized at
runtime. It can be customized using either of the following:

* |“Using the Basic License Tool GUI to Customize the Trace Level” on page 158|

+ |“Using the Basic License Tool CLI to Customize the Trace Level” on page 15§

You must be logged in with administrator privileges to be able to use of traces.

Trace levels: The trace level can be set to:
* None (CLI value is 0)

No tracing of activity for the selected license server.
* High (CLI value is 1)

High level tracing. Server logic or database transactions. This consists of
entering/exiting major pieces of code, timestamps, the trace level itself, load
threshold (displayed in hexadecimal format), and load percentage.

* Low (CLI value is 2)
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Low level tracing. Network communications. This consists of time stamps,
entering/exiting minor pieces of code, and thread identifiers (Windows only).

* Low & High (CLI value is 3)

Selects both the low level and the high level of tracing. This is the maximum
level of information

Using the Basic License Tool GUI to Customize the Trace Level: Use the
following procedure to start or stop tracing:

1. From the Active license servers window (Figure 78 on page 156), right-click on
the server that you want to set the trace level.

2. From the pop-up menu, select Tracing, then the required trace level as shown
below (see also [“Trace levels” on page 157|for more information on the levels
of traces that are available). The example below shows a trace level being
changed from Low & High to High.

Active License Servers
Selected  Help

Marne Target type Target D Server type Annotation Load % Load Threshold... Trace

:ROEGAETA, romelab RLibm.c .. Windows 2204600054101, Network LUMLS 510 Wndo'% one
L —

Lo
Lonw & High

Using the Basic License Tool CLI to Customize the Trace Level: To monitor the
environment using the basic license tool CLI, enter the following command:

LUMb1t -T level-of-tracing -n server_name

where:

level-of-tracing
is the value of the level of tracing. See [“Trace levels” on page 157

server_name
is the name of the network license server for which you want to activate or
deactivate the trace. You can activate or deactivate tracing for one server at
a time.

If you omit the -n server_name parameter, the tracing will be activated or
deactivated on the local network license server (if there is one). For more
information on the LUMbIt -T command, see ["LUMblIt -T Activate or Deactivate]
[Tracing” on page 136.|
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For example, to activate low & high tracing on the server louise, enter the
following;:

LUMb1t -T 3 -n louise

Managing Trace Files

Because the trace function can produce a large amount of output, you might find it
helpful to have a procedure to store only the most recent trace files. These files can
then be periodically removed in their chronological sequence, starting with the
oldest files. If the DebugToFile tag is set to yes in the (Tum_ini.txt) file, the server
starts in tracing mode and trace files are stored in directory set by the
DebugToPath parameter.

Note: You can change the default trace location by manually editing the
(Tum_ini.txt) file and changing the value of the DebugToPath parameter.
* Trace files are automatically split by the license server. The output files are
written in the format
LUMTmd. trcxx

where xx identifies a particular file in the sequence. For example, the first file
would be named LUMImd.trcl, the last file would be named LUMImd.trc99. When
LUMImd.trc99 is full, the license server begins writing traces to LUMImd.trcl
again. The current trace file has an underscore appended (for example,
LUMImd.trc4_). By default the trace files are stored in the following directories:

AIX /var/LicenseUseManagement/trace

Windows
Documents and Settings\A11 Users\Application Data\IBM\License Use
Management\trace

To periodically remove the oldest files, set up a cron job. Use the crontab
command to add to the crontab file a line similar to this:

0,15,30,45 % * % » yrm -f '1s -1r /tmp/LUMImd.trc* | tail -n +4'

Note that the characters 1s -1r........ +4 are enclosed in single quotation marks

()-
This cron job deletes all but the three most recent trace files.

Tuning Your Environment

To determine the maximum number of client sessions that are supported by your
servers, and to prevent the servers from going into an overload condition, see the
following sections:

* |[“Displaying Performance Information”|
* |“Setting the Load Threshold” on page 160|
* |“Determining the Minimum RPC Rate” on page 161

Displaying Performance Information

To display performance information, use the LUMtv test verification tool. Enter the
command LUMtv -p. This command can be used only when License Use
Management Runtime has been installed. This tool shows the maximum number of
RPCs that are being handled by the server at that instance. It can be used for
tuning the system and for troubleshooting performance problems.

To use the LUMtv -p command, perform the following procedure:
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1. Change the configuration of the license server so that it is the only one in the
direct binding list.

2. Restart the server

3. Run LUMtv -p several times on the same computer where you have started the
license session in order to have an average of the RPC rate supported by the
License Use Management server. An example report is shown below:

LUMtv -p

Completed license transaction on node 1fa460002fdf4lal running LUM 5.1.1 AIX
issued RPCs rate: 200 per second

Active License Servers:
ip:louise.rome.tivoli.com. (IBM/AIX) running LUM 5.1.1 AIX

Setting the Load Threshold

Administrators can set the threshold on the license server to prevent it from
reaching an overload condition. When the load threshold percentage is exceeded,
no more license requests will be accepted by the server. The server will continue to
serve existing clients and HAL cluster synchronization will continue to work: No
additional clients will be accepted. If the load threshold percentage is set too low,
then the Load % indicator will be constantly high. You should monitor these
values over a period of time and adjust them to suit your needs. You can set the
load threshold using either the basic license tool GUI, or the basic license tool CLI.

Setting the Load Threshold Using the Basic License Tool GUI: Use the following
procedure to set the load threshold:

1. From the Active license servers window (Figure 78 on page 156), highlight the
server that you want to set the load threshold.

2. Right-click to display the pop-up menu.
3. Select Change threshold. The Change Load Threshold dialog box is displayed.
Type the new threshold level that you require and click OK.

Change Load Threshold

Load threshold al:l

| Ok || Cancel || Help |

Setting the Load Threshold Using the Basic License Tool CLI: Set the load
threshold using the following command:

LUMb1t -S threshold value -n server_name

For example, to set the load threshold on the license server louise to 75%, enter the
following:

LUMb1t -S 75 -n Touise
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Determining the Minimum RPC Rate

The minimum RPC rate required will depend on the number of client sessions that
can be simultaneously active. A License Use Management server performing x
RPCs per second can support approximately 10 times x client sessions. For
example, a server performing 200 RPCs per second can support approximately
2000 client sessions. Over short periods of time the License Use Management
server will be able to support more client sessions, but over prolonged periods the
10 times x client sessions value should be used.

However, these values can be influenced by other factors, such as hardware (CPU
performance and the amount of installed RAM), and the configuration of the
environment.

Conditions which Affect Licensing System Performance
The following information can be useful when tuning your environment:

e Trace Level

There is a license server performance degradation when the trace level is
changed to a more detailed level of tracing. The worst case is when the trace
level is changed from None to Low&High. For example, on a 1.65 GHz, with 1
GB of RAM and AIX 5.3, passing from trace level None to trace level Low&High
caused a decrease in performance of approximately 55%.

* Heavy administrative tasks
Heavy administrative tasks can degrade license server performance. Examples of
heavy administrative tasks are:
— Making the license server produce large standard reports while serving client

sessions

— Running frequent batch jobs of LUMbIt commands

* Level of logging
Producing many large log files causes a degradation of license server
performance. The levels of logging which most degrade performance are "license
grant” and "license check in”. Up to a 30% degradation can be experienced when
these two levels of logging are active.

* Hardware configuration

From the tests that IBM has made, results have shown that, for example, on a
AIX 5.3 with 1 GB of RAM and 1.65 GHz CPU, the average RPC rate is 620
RPCs per second. Therefore, the license server can support approximately 6200
client sessions.

* Resource sharing

It is recommended that the license server runs on a dedicated computer. Any
other resources running on the license server will degrade its performance.

¢ Too many client sessions

The performance of the license server will be reduced when the number of client
sessions greatly exceeds the suggested 10 x RPCs per second rate and the load
on the license server approaches maximum. If this occurs, the administrator can:

— Change the load threshold (seq”Setting the Load Threshold” on page 160)
— Reduce the number of requesting client sessions

— Improve the performance of the license server
There is no possibility for the license administrator to revoke active licenses.

The Load Threshold value (corresponding to MaxActivitiesThreshold parameter
in the Tum_ini.txt file) keeps account of the speed of the network connecting
servers with clients and the number of requesting client sessions. When the
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value of this parameter is set too high for the particular licensing system, the
server might become easily overloaded. The solution is to reduce the value of
the threshold (using the basic license tool, either with the GUI (“Using the Basid
License Tool GUI to Customize the Trace Level” on page 158) or the CLI (“Using]|
the Basic License Tool CLI to Customize the Trace Level” on page 158). You can
also edit the value of the MaxActivitiesThreshold parameter in the Tum_ini.txt
file, then stop and restart the server. In the case of HAL licensing, this action
should prevent the cluster from entering a possible instable condition.

Tuning the Timeout To Detect a Non-Responding server

ALL You can increase or decrease the timeout using a scaling factor. You can modify the
timeout for connections between client and server by changing the
LUM_TIMEOUT_FACTOR environment variable on the client side of the
connection.

The default value of LUM_TIMEOUT_FACTOR is 1000; values greater than 1000
increase the timeout interval, while values below 1000 decrease it.

Managing a Custom Configuration

This section gives advice about custom configurations and their licenses.

Before Requesting the License Upgrade

Before you request an upgrade to your current custom configuration license,
double-check the serial number.

Deleting Keys

The initial key is always required. Do not delete it form either the network license
server or the nodelock directory.
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Chapter 8. Troubleshooting

ALL This chapter provides suggestions for problem determination, and debugging
when you use products managed with License Use Management Runtime.

Checking the Version of License Use Management Runtime

The suggestions in this chapter pertain only to License Use Management Runtime
Version 5.1.X, not to earlier versions of License Use Management Runtime. If you
are in doubt about which License Use Management Runtime version is installed on
your system check the file:

» /var/LicenseUseManagement/VERSION (on AIX)

e c:\Documents and Settings\A11 Users\Application Data\IBM\License Use
Management\version (on Windows)

Checking License Details

Before you proceed, be sure you know the following details about the product that
is not starting properly. Check the product enrollment certificate file for all these
details.

¢ Product name (ProductName parameter)

¢ Product version (ProductVersion parameter)
* Vendor name (VendorName parameter)

¢ Product features (ProductFeatures parameter)
¢ Target ID

* Whether the product implements customer-managed or vendor-managed use
control (RegistrationLevel parameter; CMU= customer-managed, VMU=
vendor-managed)

* Whether the product is enabled for a custom configuration policy (SerialNumber
parameter)

* Whether the password is simple or compound (LicenseStyle parameter=
compound, or LicenseStyle parameter= license type if the password is simple)

* License type (LicenseStyle parameter if the password is simple;
DerivedLicenseStyle parameter if the password is compound)

* Whether the product is enabled for the hard stop/soft stop policy (SoftStop
parameter)

* When the license becomes valid and when it expires (LicenseStartDate and
LicenseEndDate parameters)

This is an example of an enrollment certificate file:

[LicenseCertificate]

CheckSum=103C2B48A901E15A48838007BBF4ED4B

CreatorID=220460006df010a9

TimeStamp=1128697865812000 (Oct 07 2005 15:11:05 GMT )
PasswordVersion=1

CustomerSite=

CountryOfUsage=

VendorName=IBM Coproration
VendorPassword=vttpDuzNpSTmEPTzgzj7qb2kuzxJVT7CFxH114qtel105/DBYDJILhmg5p
Q6paze3MGK/P53p3BLF1ANN1USLTS3f4+swzZE7VW179L1EW8mc4QJHgkaBQp6jrIAXItK2
9WbA5Laed0f2APwk2ZfjKIVNpS1hdebFhOBKxuv/SD7Y/kZRGmEayxvkt67h1tI8xM/K2a9
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35uduY0/wjiBCim/TsqSWknvEUNOO/EVCPMT i IDpWUd7pctBlxpjpIMkZT1nnY6/UCcBQJpAL
TitXRI0oZnkTZh44xVjbXIiAMXOxPRvy8gBQrxYC8KJhaRBrIRL0o9SnYXGCIMU2UasLZROAN
XuEb5m5mUizzHj3b0/9pTOY=

VendorID=b8e01c44c5f4.03.09.84.€2.17.00.00.00

ProductName=DataWare

ProductID=2222

ProductVersion=21

Features=

ProductPassword=ET1GNRnAvF4mr3Hdf1rURO/1z1 fSwgbyPraUtNRYKHatzvIHMcGysMIc
PzW7PcABtOW+99uOrdql/1TVT5keFhmzh6MDuj60C1KcCtwIZHZnmx1gANK4 /UOU9yORyXs
KcjG19Q3GNRVAk3WKRDOANVpeRMPxqdpq0JnuyYDD5vKQbzeQ9zpXrTS/6T1hBOtP4AI7MUJ
XPTOBK8LJVX99RLb11iS4/0LncE1kb+fYtdLNqMFZZHH

ProductAnnotation=

LicenseStyle=concurrent

LicenseStartDate=11/01/2005

LicenseDuration=11414

LicenseEndDate=01/30/2037

LicenseCount=24

MultiUseRules=User/Accessor

RegistrationLevel=VMU

CapacityType=Processors configured

TryAndBuy=No

SoftStop=No

CustomAttributel=No

CustomAttribute2=No

CustomAttribute3=No

MaxOfflinePeriod=

TargetID=ANY

TargetType=Open Target

TargetSource=open

ExtendedTargetType=

ExtendedTargetID=

SerialNumber=

Upgrade=No

SubSerialNumber=

UpgradeCount=

UpgradeIndex=

DerivedLicenseStyle=

DerivedLicenseStartDate=

DerivedLicenseEndDate=

DerivedLicenseAggregateDuration=

Troubleshooting Licenses (All Types)

If a user tries to start a license-enabled product and it does not start, some of the
first things to check are:

First, check the product documentation.

Check to be sure the license for the application you are running is installed, and,
if not, install it. See [“Enrolling the Product” on page 67| for information on how
to install a license.

Check that the license you have installed is the correct license for the version of
the software you are running.

Check that the date and time on the workstation are set correctly. Each license
has a start date and an end date built in. If the date or time is set incorrectly on
the workstation where you are running the product or on a license server, the
license might not be recognized as active.

Check that the time zone and daylight saving time settings are correct.

Check that the start date of the enrolled license is not later than the current date,
and that the license has not expired.
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Troubleshooting Nodelocked Licenses

If a workstation with a nodelocked license does not allow an end user to use a
license-enabled product, check the product documentation to determine whether
the product was enabled for License Use Management Runtime Version 5.

If the product uses non-runtime-based enabling:

* Check that the enrollment certificate file is in the path specified by the vendor of
the product and that its permissions are set so that all users can read it.

* Check that the license is correctly installed in the nodelock directory specified by
the vendor and that its permissions are set so that all users can read it.

The default location of the nodelock directory is:
— /var/LicenseUseManagement/nodelock (on AIX )
— c:\'COMMON_APPDATA'\IBM\License Use Management\nodelock (on Windows)
where:
COMMON_APPDATA
is the initial part of the path that is returned by the SHGetFolderPath API

An example of a typical path for the nodelock directory on a Windows
operating system is as follows:
c:\Documents and Settings\A11 Users\Application Data\IBM\License Use
Management\nodelock
If the file is not in the default directory, check your product documentation or
contact the product vendor.

Troubleshooting Network Licenses (All Types)

If a user tries to start a product with a network license and the product does not
start, do the following steps. These suggestions apply to concurrent, use-once,
reservable/reserved, and per-seat licenses.

* Use the LUMtv command from the client workstation to verify the connection to
the license server where you have the licenses installed.

— If the LUMtv output shows no active servers, check that the network license
server is running on the server workstations where you have the licenses
installed.

- If LUMtv does display active servers, check that they include a workstation
where licenses for the product are installed. Use LUMb1t -1p to display the
licenses installed on each server. You might need to reconfigure the client to
connect to the proper servers.

— In direct binding, verify that the client is configured to connect to the correct
servers.

* If you get the error message:
Time disparity is too large
check that the date and time on the servers and client are synchronized. If server

and client are in different time zones, be sure that time zone and daylight saving
time have been set correctly.

¢ If an enabled application requests more than one license to run, be sure the
requested number of licenses is available on one server.

License Use Management Runtime does not combine licenses installed either on
different servers, or on the same server but with multiple enrollment actions, to
satisfy the same request, unless the capacity policy applies.
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Similarly, if you received the licenses in a compound password, check that you
have distributed, in one single distribution, on one server, at least the number of
licenses requested.

For the same reason, if the product is enabled for soft stop, you might see soft
stop licenses in use even if there are still some available licenses.

Troubleshooting Reservable and Reserved Licenses

Reservable licenses are enrolled on a network license server. When reserved they
are moved to the central registry license server. If a license has been reserved for a
user but, when that user tries to use the product, it does not start:

FiN .

Check that the central registry license server is up and running (see
[Required Subsystems” on page 171).

Check that the client workstation can reach the central registry.

Check that the date and time set on the central registry are the same as that set
on the network license client. It is possible that, according to the date and time
set on the central registry, the license is not yet valid or has expired.

Double-check the name of the user, group, and node for which licenses are
reserved. Be careful with leading and trailing blanks. Note that the domain is
part of the node specification.

Check the local host name specification of the client workstation in the
/etc/hosts file. Make sure it is in the form:

ip_address hostname_including_domain hostname_without_domain
For example:
69.100.67.70 1ab67070.rome.tivoli.com 1ab67070

Troubleshooting Per-Seat Licenses

If an application with per-seat licenses fails to start:

Be sure the central registry license server is up and running.
Be sure the per-seat license is enrolled.

Be sure the workstation where the application server runs can reach the central
registry.

Troubleshooting Concurrent-Offline Licenses

If you are having problems with concurrent-offline licenses:

If you are unable to reserve an offline license, check with the license
Administrator that you have been correctly authorized for that license, and
check that your password is correct.

If you are unable to use an offline license that you reserved, check if the
reservation period has expired. If the reservation period has expired, the
handback has been automatically made. If you still have problems with
reservation and handback, check permissions on the nodelock directory. Write
permissions should be set for all users of the nodelock directory.

If you are unable to use a license you have reserved, check that the system date
on your machine is consistent with the system date on the machine where the
reservation was made.

If you still are unable to work with offline licenses, check that you have enough
free space:

— On AIX platforms, check that /var and /opt have at least 10 Mb free.
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— On Windows platforms, check that there is at least 10 Mb free on the disk
drive where the operating system is installed.

* A reboot might be needed on Windows in order to refresh the system
environment.

* Using a mixture of concurrent licenses and concurrent-offline licenses for the
same product is not recommended, because it could lead to some inconsistent
data being displayed by the basic license tool (in both the CLI and the GUI).

* If you have tried everything and still cannot resolve your problem, contact
License Use Management support.

Troubleshooting Licenses of Customer-Managed Use Products

If you are unable to enroll, update, or distribute licenses for a customer-managed
product, a customer-managed use product fails to start, if soft stop does not work,
or the high-water mark does not work:

* Be sure that the central registry license server is up and running, and that you
have defined only one central registry license server in the direct binding servers
list.

* Be sure the workstation where you are working can reach the central registry.

* If you received the licenses in a compound password, make sure you have
distributed the licenses. See [“Distributing the Licenses” on page 69| for
information on how to distribute licenses.

* If soft stop does not work, be sure the soft stop policy is enabled.

Troubleshooting Licenses of Vendor-Managed Use Products

If enrollment of a vendor-managed use product fails, check that the target ID and
the target type in the license match the target ID and target type of the workstation
where the license is installed. To get the target ID of the workstation, run the target
view tool (LUMtarget - Target View Tool) on that workstation.

If there is a mismatch, one of the following is possible:
* The vendor put the wrong target ID or target type into the license.
* You are using the license on the wrong workstation.

 The target ID of your target workstation has changed (see [“Troubleshooting the]
[Hardware” on page 173).

Troubleshooting Custom Configuration

If for a custom configuration, you are unable to install concurrent or
concurrent-offline licenses, or nodelocked licenses from the nodelock directory:

¢ Check the SerialNumber
e Check the SubSerialNumber:

— If you are installing the initial key, no other key with the same serial number
and product ID can already be installed

— If you are installing a replacement key, another key with the same serial
number, product ID and lower subserial number must be installed

* Check if the set of licenses you are going to replace is completed. (That is, there
are Upgrade Count licenses enrolled).
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Troubleshooting HAL Licenses

ALL An application cannot have its HAL license granted even if it was successfully
enrolled. In this case, check the status of the cluster using the basic license tool.
The status must be active. If the status is not active, do one of the following;:

e If the status is Change pending, wait for the state transition to finish.
e If the status is inactive, restart the servers that are listed as unavailable.

 If the status is incomplete, activate the server members that are listed as not
activated.

An application cannot have its HAL license granted even if the cluster is active. In
this case, using the basic license tool, go to the product details notebook, select the
license and right-click on Show Servers. If one of the servers in the list has a
non-zero "share” but has zero "shared licenses”, try to start that server again. If the
problem persists delete the license and enroll it again.

An application that had its license granted stops working when one of the cluster
members goes down. A possible reason for a failure in the automatic re-granting of
the license is that another instance of the same application has started before the
first application instance was notified of the change and the total number of
available licenses is not enough to satisfy this second request. In this case, install
additional licenses.

Troubleshooting License Database

If the basic license tool displays frequent non-recoverable error messages when
enrolling or deleting license certificates, or when trying to clean up stale licenses,
you should refresh the license database. To do this, use the -clean option of the
license server, as follows:
1. Stop the license services by entering the command:

LUMcfg -stop
2. Back up the following files:

e On AIX/var/LicenseUseManagement/1licdb.dat and /var/
LicenseUseManagement/1icdb.idx

* On Windows:

C:\Documents and Settings\A11 Users\Application Data\IBM\License Use
Management\1icdb.dat
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and c:\Documents and Settings\A11 Users\Application Data\IBM\License
Use Management\licdb.idx

3. Edit the Tum_ini.txt file and set the CleanStart parameter to yes.
4. Restart the license services by entering the command:
LUMcfg -start

Defining Rules for Multiple-Use Concurrent Licenses

Multiuse rules define the conditions under which multiple invocations of a product
require only a single license. These rules are applicable only to concurrent and
concurrent-offline licenses.

See [“Multiuse Rules” on page 8| for general information about multiuse rules.

Multiuse rules are specified for individual passwords when the software vendor
runs LUMIct, rather than in calls from the product to the license server. This
means that rules are applied to individual licenses, rather than to the product
itself. The vendor can therefore specify multiple use rules for each customer,
without making any changes to the product itself, and without affecting other
customers’ licenses for the product.

Scenarios

The following scenarios describe how the multiuse rules work when:

* A license with same group rule is installed on the server (10 licenses are
available on the server).

* Two clients are in the same group.

When the second request in a scenario is higher than the first, License Use
Management Runtime adds the requests, ignoring the multiuse rule.

e Scenario 1

1. Clientl requests 1 license; License Use Management Runtime shows 1 license
in use

2. Client2 requests 1 license; License Use Management Runtime still shows 1
license in use

* Scenario 2

1. Clientl requests 5 licenses; License Use Management Runtime shows 5
licenses in use

2. Client2 requests 2 licenses; License Use Management Runtime still shows 5
licenses in use

e Scenario 3

1. Clientl requests 2 licenses; License Use Management Runtime shows 2
licenses in use

2. Client2 requests 5 licenses; License Use Management Runtime shows 7
licenses in use

Troubleshooting Performance Problems

Read this section for assistance with optimizing performance.
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Basic License Tool Performance

In a network with many users, or when you are creating large reports, if
performance is consistently slow when you use the Basic License Tool graphical
user interface, consider switching to the command line interface.

Performance in a Direct Binding Environment

In a direct binding environment, careful configuration can help you to optimize
formance. See the performance notes under [“Planning Direct Binding” on page|

Troubleshooting Heavy Server Workloads

ALL

When a License Use Management server is overloaded, performance could
deteriorate to the point that the server can no longer manage licenses. Use the
tools described in [“Monitoring Your Environment” on page 155/ to determine if the
server is being overloaded.

License Server Startup Time

[=

On Windows platforms, the license server might need a lot of time at startup in
order to populate its cache, possibly because of a high number of licenses enrolled,
or on a high number of transactions. An environment variable, LUMTIMESERV,
extends the standard timeout period that the service waits for the notification that
the license server is working,so you can determine if the license server has been
able to start correctly or not. The default value of LUMTIMESERV is 30 seconds. This
can be altered as follows:
1. Open Start --> Settings --> Control Panel --> System --> Advanced -->
Environment Variables.

The Environment Variables dialog is displayed.

2. In the System Variables box, click New. In the New System Variable dialog,
add the following information:

* In the Variable Name field, type:
LUMTIMESERV

* In the Variable Value field, type the timeout period (in seconds) that the
service waits for the notification; for example, 45.

3. Click OK.
4. Reboot the computer.

Troubleshooting Network Connections

If connections to license servers seem not to be working properly, use the test
verification tool (LUMLtv) tool to verify that the license servers are up and running,
or use the LUMbIt -In command to get a list of active servers (network license
servers and the central registry). For more information about these commands, see

Chapter 6, “License Use Management Runtime Command Line Interface,” on page]

107]

If servers and clients are not communicating correctly in a direct binding
environment (the LUMtv command reports No servers found), check that exactly
the same server names and direct binding port numbers were configured for each
client, each network license server, and the central registry license server.
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For example, if you have a server called louise running the network license server
and the central registry license server, and clients connected to louise, the direct
binding configuration for each workstation, including louise itself, must contain the
entries:

ip:Touise[10998]
ip:louise[2215]

The port numbers must match the values of the ipPort and ipGDBPort parameters
in the configuration file of louise. louise and its clients all must have TCP/IP
installed.

Troubleshooting License Use Management Runtime Servers

¢

This section covers problems that could arise if License Use Management Runtime
is not started, or fails.

Starting Required Subsystems

When a license-enabled product fails to start, the problem might be that a required
License Use Management Runtime is not running.

To get a list of the License Use Management Runtime that are running on a
workstation, use the LUMcfg -1ist command or double-click the Service Manager
Tool icon in the License Use Runtime folder. The names of the subsystems are
shown in Table 11. For an overview of which license servers are required for each
license type, see Table 8.

Table 13. License Use Management Runtime Subsystems

Subsystem Name
Network License Server LUMImd
Central Registry License Server LUMgdb

To start the subsystems, either use the LUMcfg -start command, or select Start
from the Service pulldown menu to start all subsystems configured on a
workstation.

If the subsystem or process fails to start when you issue the command, check the
error messages in the LUMIs.log, LUMImd.log, and LUMgdb.log files in the
/var/LicenseUseManagement/1og directory on AIX or the c:\Documents and
Settings\A11 Users\Application Data\IBM\License Use Management\log directory
on Windows.

Automatic Startup of Subsystems

If the License Use Management Runtime and NCS subsystems do not start
automatically when you start your workstation, do the following:

1. Login with root authority.

2. Check if the file /etc/LUMTs.rc exists. If not, create a text file called
/etc/LUMIs.rc containing the following string:

"LUMcfg -start -nopause"

3. Check the permission on the file /etc/LUMIs.rc. If it is different from 744,
change it by running the following command:
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¢

chmod 744 /etc/LUMIs.rc

4. Check that the LUMIs entry is in the inittab file, by running the following
command:

Isitab -a

If not, add it by running the following command:
mkitab LUMIs:2:wait:"/etc/LUMIs.rc > /dev/console 2>&1 #Start LUMIs"

Restart and Recovery

 If a network license server or the central registry license server goes down, a
record of users who currently have licenses is kept on disk. When the server is
restarted, the record is reinstated and the licenses are still assigned to those
users.

If you want a cold start (that is, if you want the server to restart as if it had
granted no licenses before going down), use the -c parameter on the command
used to restart the server (LUMImd or LUMegdb, all described in |Chapter 6,
[License Use Management Runtime Command Line Interface,” on page 107). To
change the default permanently to cold start, edit this parameter of the
lum_ini.txt file:

ColdStart=yes

and then restart services (LUMcfg -start).

Cold start is not possible for per-seat licenses.

e If the client workstation goes down or the network fails, the licenses it was
using become stale (after a check period expires, if the application is enabled
using concurrent access or reservable licenses, and the application is
programmed to check in with the server after a specified check period). In this
case, the licenses are available to be granted to other clients. Note that those
licenses will still be displayed as in use until you perform the Clean up stale
licenses function or until a license is newly requested and none is available, in
which case the server does its own cleanup of stale licenses. The client behavior
depends on the software product that is in use.

License Server Startup

The License Server fails to start with the message "GRL-2050:Fatal error from
LUMLMD: expected VENDOR token in user file". If you get this fatal error from
LUMImd, do the following steps:

* Check if the user_file is correct

¢ Check the LANG variable

If you are using, for example en_US.UTE-8 change it to en_US on the field when
you are going to start the License Server.

Troubleshooting the Communication Protocol

If you have communication problems, first verify that the TCP/IP protocol is
installed on the workstation and configured properly.

Following is a brief checklist to help you make sure your TCP/IP system is
working correctly:

1. Check that the TCP/IP system is up and running.
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2. Check whether IP addresses or network interfaces have been changed.

3. Check whether normal TCP/IP communications are working between the
nodes you want to be connected (for example, using ping or FTP).

4. Make sure your routing setup definition is valid.
The netstat command shows the local definition. To see the hubs, use the route
print command.

5. Is name resolution working?

Name resolution is very often the reason for long startup times or many sorts
of problems in large networks. Use the DNS (Domain Name System), and
spend some time developing a good layout.

6. Is the MTU (Maximum Transmission Unit - Internet protocols) size equal on all
hosts?

7. Is the token ring speed equal on all hosts?

8. License Use Management Runtime is based on universal datagram protocol
(UDP). In a very highly loaded network, UDP connections might receive
time-outs before data is delivered. This is normal behavior; you need to reduce
the total network load.

9. If your License Use Management Runtime server is on a workstation
configured with the loopback facility of TCP/IP, when you use the LUMb1t -a
command to enroll a product on the server, you must specify:

-n ip:localhost

in the LUMb1t command.

Troubleshooting the Hardware

ALL The following is a brief checklist to help you make sure your hardware is working
correctly.

1. If you get the error message:
Invalid target ID

* On AIX: check that the CPU planar of your License Use Management
Runtime server has not changed.

Vendor-managed licenses on the License Use Management Runtime server
might be tied to the CPU ID, which changes after a CPU planar swap.

* On Windows: check that your target ID has not changed
2. Check that the cables are still where they should be.
3. Check whether you have reached the Ethernet length limitations on your LAN.
4. Check whether a security feature has been enabled on a router.

Some routers allow enabling of security features. It is possible to block certain
TCP/IP ports.

The ports are predefined in the configuration file.

If you are in a AIX environment the LUMImd, and LUMgdb programs use
runtime-assigned ports whose port numbers are predefined in the configuration
file.
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Troubleshooting Installation of License Use Management Runtime on
Windows XP

If, after installing License Use Management Runtime on a Windows XP
workstation, you have problems communicating with the server, reboot your
workstation, even if it is not required by the installer.

Collecting Error Log Data

In order to help IBM help you in problem determination, you should gather
additional information to send to your IBM representative when you request
support. License Use Management Runtime subsystems and tools can be run in
trace mode as explained in the following sections.

Running Servers in Trace Mode

To run License Use Management Runtime Servers in trace mode, see the section
[“Using the Server Tracing Service” on page 157,

0 Viewing the trace data on AIX:

The trace files produced by the Server Tracing Service are as follows:

¢ For the network license server, the files are named LUMImd.trc*, where * is a
number from 1 to 99 with a wrap around mechanism. The current trace file has
an underscore appended (for example, LUMImd. trc44 ).

* For the central registry server, the files are named LUMgdb.err and LUMgdb.out.

By default, all of the trace files are located in the /var/LicenseUseManagement/
trace directory on AIX. You can specify a different path using the DebugToPath
tag of the Tum_ini.txt file.

E Viewing the trace data on Windows using the GUI:
1. In the Service Manager Tool window, select Stop from the Service pulldown
menu.

2. Select the line corresponding to a specific process in the list.

3. Select View trace from the Selected pulldown menu. The View trace window
is displayed. It shows the trace messages.

The output trace information is collected in the files with a .trc extension.

See ["Managing Trace Files” on page 159 for information about managing the trace
files produced by the Server Tracing Service.

Running Enabled Applications in Trace Mode

To run enabled applications in trace mode, set the following environmental
variables:

« LUM_LIB_VERB=Yes
* LUM_LT_DEBUG=Yes
« LUM_RPC_DEBUG=Yes

On AIX use the export command, on Windows use the set command, then start
the enabled application from the same window.
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Trace messages will be displayed in the same window where you have set the
variable and from which you run the application. You can redirect the output of
the trace in a log file by setting the environment variable as follows:

e export LUM LOG_PATH=name file on AIX
* set LUM_LOG_PATH=name_file on Windows

Running Tools in Trace Mode

To run tools in trace mode use the flag -B as the first option when you invoke
LUMbIt and LUMcfg. The trace records will be displayed in the window where
you run the tools.

Set Windows Services Trace Mode

The environment variable LUM_TRACE_SERV enables the tracing of the start and stop
phases of Windows services on License Use Management servers. To set the
LUM_TRACE_SERV variable, follow these steps:

1. Open Start --> Settings --> Control Panel --> System --> Advanced -->
Environment Variables.

The Environment Variables dialog is displayed.

2. In the System Variables box, click New. In the New System Variable dialog,
add the following information:

a. In the Variable Name field, type:
LUM_TRACE_SERV
b. In the Variable Value field, type Y.

c. Click OK.
The Environment Variables dialog is redisplayed.
3. Click OK.

4. Reboot the computer.

The output LUM_TRACE_SERV logfile is stored in: C:\Documents and Settings\AT1
Users\Application Data\IBM\License Use Management\trace\LUMlogservices.txt.

Collecting Other Data on AIX

Other information concerning License Use Management Runtime servers is
automatically collected by the license server subsystems (LUMImd, and LUMgdb).
This data is stored in the following files:

/var/LicenseUseManagement/1og/LUMIs.Tlog

Most of the messages you find in these files and the related return codes are not
documented.

Also provide IBM with:
» /var/LicenseUseManagement/lum_ini.txt (the configuration file)
* License Use Management Runtime Databases
— License Databases
/var/LicenseUseManagement/1licdb.dat
/var/LicenseUseManagement/1icdb.idx
/var/LicenseUseManagement/crpdb.dat
/var/LicenseUseManagement/crpdb.idx
/var/LicenseUseManagement/usrdb.dat
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/var/LicenseUseManagement/usrdb.idx

— Log Databases
/var/LicenseUseManagement/1og/Togdbnn_.dat
/var/LicenseUseManagement/1og/Togdbnn_.idx
/var/LicenseUseManagement/log/crlognn_.dat
/var/LicenseUseManagement/1og/crlognn_.idx

Collecting Other Data on Windows

Other information concerning License Use Management Runtime servers is
automatically collected by the license server processes (LUMImd, and LUMgdb). This
data is stored in the following files:

c:\Documents and Settings\A11 Users\Application Data\IBM\License Use
Management\Tog\LUM1s.Tog

c:\Documents and Settings\A11 Users\Application Data\IBM\License Use
Management\1og\LUMImd.10g

c:\Documents and Settings\AT1 Users\Application Data\IBM\License Use
Management\1og\LUMgdb.1og

Most of the messages you find in these files and the related return codes are not
documented.

Also provide IBM with:
e The default location of the configuration file, Tum_ini.txt, is as follows:
c:\'COMMON_APPDATA'\IBM\License Use Management\lum_ini.txt
where:
COMMON_APPDATA
is the initial part of the path that is returned by the SHGetFolderPath API

An example of a typical path for the Tum_ini.txt file on a Windows operating
system is as follows:

c:\Documents and Settings\A11 Users\Application Data\IBM\License Use
Management\lum_ini.txt

If the file is not in the default directory, use the SHGetFolderPath API to
retrieve it.

* License Use Management Runtime databases
— License databases

c:\Documents and Settings\A11l Users\Application Data\IBM\License
Use Management\licdb.dat

c:\Documents and Settings\A11 Users\Application Data\IBM\License
Use Management\Ticdb.idx

c:\Documents and Settings\A1l Users\Application Data\IBM\License
Use Management\crpdb.dat

c:\Documents and Settings\A1l Users\Application Data\IBM\License
Use Management\crpdb.idx

c:\Documents and Settings\A11l Users\Application Data\IBM\License
Use Management\usrdb.dat

c:\Documents and Settings\A11 Users\Application Data\IBM\License
Use Management\usrdb.idx

— Log Databases
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c:\Documents and Settings\A11 Users\Application Data\IBM\License
Use Management\log\logdbnn_.dat

c:\Documents and Settings\A11 Users\Application Data\IBM\License
Use Management\Tog\logdbnn_.idx

c:\Documents and Settings\A1l Users\Application Data\IBM\License
Use Management\log\crlognn_.dat

c:\Documents and Settings\A11l Users\Application Data\IBM\License
Use Management\log\crlognn_.idx

Troubleshooting the Java GUI

¢

AIX

Refer to the following sections or to the readme.jgui file if you are having trouble
with the License Use Management Runtime Java GUL

If you have trouble with the LUM Runtime Java GUI:
* Run LUMDIt with the -B option to collect debugging information.

* Make sure Java Runtime Environment 1.4.1 or later is installed on your
workstation.

* Make sure that the PATH variable is properly set to find the Java interpreter. (To
identify the Java interpreter in use, use the java -version command.)

* Make sure the DISPLAY environment variable is properly set in the format
"hostname':0

Troubleshooting the lum_ini.txt Configuration File

If the lum_ini.txt configuration file becomes corrupted, destroyed or lost, or the file
is the wrong file, the customer can try to recover the file using the LUMcnvini
command. The LUMcnvini file is an executable located in one of the following
directories:
AIX  /opt/LicenseUseManagement/bin
Windows

C:\Program Files\IBM\License Use Management\bin

The LUMcnvini command performs the following tasks:

* Creates a new Tum_ini.txt file if it is missing

* Updates an old Tum_ini.txt file (for example it is called during migration)
* Repairs a corrupted Tum_ini.txt file.

Syntax:

¢ On AIX there are no parameters, the syntax is:
LUMcnvini

* On Windows, the syntax is:
LUMcnvini c:

where c: is the drive where License Use Management was installed
(LUM_INSTALL_DRIVE). It is followed by the component that was installed:

Note: If the LUMcnvini command fails to recover the Tum_ini.txt file, the
suggested procedure is to manually delete the Tum_ini.txt file and then run
the LUMcnvini command again. This recreates a brand new configuration
file. The machine must then be configured.
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Appendix A. License Use Management Runtime Configuration
File

This appendix describes the License Use Management Runtime configuration file
(lum_ini.txt).

The default location of the configuration file, lum_ini.txt, is as follows:
AIX  /var/LicenseUseManagement/

Windows
c:\'COMMON_APPDATA'\IBM\License Use Management\Tum_ini.txt

where:

COMMON_APPDATA
is the initial part of the path that is returned by the SHGetFolderPath
API

An example of a typical path for the Tum_ini.txt file on a Windows
operating system is as follows:

c:\Documents and Settings\Al1 Users\Application Data\IBM\License Use
Management\Tum_ini.txt

You should normally use the configuration tool to configure License Use
Management Runtime. In case you have no access to the configuration tool or you
just want to change a few parameters in your configuration, the information in this
appendix will enable you to modify the parameters by editing the file. Also, some
parameters (designated in this appendix) can only be changed by editing the
configuration file. The default Tum_ini.txt can be overidden by setting the
environment variable LUM_CONFIG.

If a parameter has a default value, it is shown with the parameter name (for
example, BackupMode=daily).

[LUM Server Startup]

RunLMD=no All platforms

Whether the network license server is to be started on this workstation.
Possible values are yes and no.

RunGDB=no All platforms

Whether the central registry license server is to be started on this
workstation. Possible values are yes and no.

ColdStart=no All platforms

Whether the license servers restart from scratch, with no record of
licenses in use granted before stopping (yes), or not (no). Cold start is
not possible for reserved and per-seat licenses. This parameter can be
changed only by editing the configuration file.

CleanStart=no All platforms

By default, this is set to no. If set to yes, the server performs a database
refresh before starting to listen.

[LUM Server Startup]

© Copyright IBM Corp. 1995, 2006 179



ipPort=2215

ipGDBPort=10998

ipHALPort=11998

ipAuthPort=

UseHostTable=no

PassiveTime=300

MaxActivities=1024

All platforms

The TCP/IP port number that the license server listens to when
supporting its clients.

All platforms

The TCP/IP port number that the central registry license server listens to
when supporting its clients.

All platforms

The TCP/IP port number used for internal communication between
servers in a cluster. Change this number only if 11998 is already used for
some other purpose. If you change this value, change it on cluster
members too.

All platforms

By default, the port number is randomly chosen, but if a specific value is
set then the authentication server port is fixed to that value. This
parameter can be changed only by editing the configuration file. Setting
this parameter to a specific value will disable remote administration of
the server.

All platforms

Change this parameter to yes on a workstation with multiple network
interfaces if you want to control on which network interface (such as
token ring or Ethernet) the network license server and the central
registry license server will start. The first entry in the /etc/hosts file on
the local workstation will be used.

All platforms

Specifies the length of time in seconds that an activity is to be kept in
the server activity pool after the activity has been completed. You can
change this parameter only by editing the configuration file.

All platforms

Specifies the maximum number of activities that any server can manage.
The actual maximum for any particular server depends on the server’s
capabilities. The actual maximum could therefore be lower. You can
change this parameter only by editing the configuration file. Allowed
values are in the range 1—2048 (1024 is the only value allowed on
Windows). The default value is 1024.

MaxActivitiesThreshold=90 All platforms

HALFrequency=30

DebugNCS=no
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Specifies the percentage of activities beyond which license requests are
rejected. Licenses can still be checked and released beyond this
threshold.

This parameter is updated every time the LUMDbIt -S command is run.
All platforms

The length, in seconds, of the interval at which servers in a cluster
synchronize data among themselves. You can increase this number if
you have performance problems, but doing so delays synchronization
between members of a cluster.

All platforms

Specifies whether or not the License Use Management Runtime
subsystems must be started in debug traced mode and additional
communication-related information collected. For UNIX operating
systems it also specifies whether the NCS subsystems must be started in
debug traced mode. Possible values are yes and no.



[LUM Server Logging]
NumberOfLogFile=2 All platforms

The number of log files License Use Management Runtime writes. For
example, if Togdb is the log file name, and NumberOfLogFile is set to 2,
License Use Management Runtime changes the name to 10gdb00_. When
it is full, it starts logging events on 1ogdb01_. When this is full, it restarts
writing on 10gdb00_. This parameter can be changed only by editing the
configuration file.

MaxLogFileSize=10 All platforms

The maximum length of the log files, in tens of kilobytes. After that size
is reached, License Use Management Runtime starts writing on another
log file. This parameter can be changed only by editing the configuration
file.

LogAllEvents=no All platforms

Whether or not all the events are to be logged on the license servers.
Possible values are yes and no.

LogPath=/var/LicenseUseManagement/log AIX

LogPath=C:\Documents and Settings\ All Windows

Users\ Application Data\IBM\License Use

Management\log
Log file path of the license server subsystem log (UNIX) or process log
(Windows).

LogGrant=no All platforms
Log when a license was granted or released. Possible values are yes and
no.

LogCheckin=no All platforms

Log when a licensed product has sent a check-in call to the server to
notify it that the product is running. Possible values are yes and no.

LogVendor=yes All platforms
Log when a new vendor was added or deleted. Possible values are yes
and no.

LogProduct=yes All platforms
Log when a new product was registered or deleted. Possible values are
yes and no.

LogTimeout=no All platforms

Log when the server has canceled the request for a license because the
check period has expired. Possible values are yes and no.

LogErrors=yes All platforms

Log server errors that do not stop the server, but return a status code
and a message. Possible values are yes and no.

LogVendorMsg=yes All platforms

Log error messages the vendor inserted in the product. Possible values
are yes and no.

LogSvrStartStopThr=no All platforms

Log the successful start or stop of the license server and workload
threshold-related events. Possible values are yes and no.

[LUM Server Miscl]
DisableRemoteAdmin=no All platforms
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Whether the administration of this network license server is to be
disabled when using the administration tool started on a different server.
Possible values are yes and no.

ValidityPeriod=15 All platforms

Internal period, in days, to validate per-seat licenses stored on the
central registry. This parameter can be changed only by editing the
configuration file.

BackupMode=daily All platforms

The mode of the License Use Management Runtime database backup
procedure. Possible values are:

daily The backup is started at the time specified in the
BackupParm parameter.

weekly The backup is started at approximately midnight
(00:00) of the day specified in the BackupParm
parameter.

changes The backup is made each time the database is changed,
such as when an object is added or deleted.

none No backup takes place.

BackupParm=0 All platforms

If BackupMode is daily, the hour when the backup occurs (midnight=0).
If BackupMode is weekly, the day of the week when the backup occurs
(Sunday=0).

This parameter value must be the same on all servers within your
licensing environment. It can be changed only by editing the
configuration file.

BackupPath=/var/LicenseUseManagement/backup AIX
BackupPath=C:\Documents and Settings\ All Windows
Users\ Application Data\IBM\License Use

Management\backup

The path where the server files and databases are copied during the
automatic backup procedure. This parameter can be changed only by
editing the configuration file.

DebugProc=no All platforms

Specifies whether or not the License Use Management Runtime
subsystems (UNIX) or processes (Windows) must be started in debug
traced mode. Possible values are yes and no.

DebugToFile=no All platforms

Specifies whether or not the License Use Management Runtime
processes are started in debug trace mode and the output is redirected to
a file. Possible values are yes and no.

DebugToPath=/var/LicenseUseManagement/trace AIX
DebugToPath=C:\Documents and Settings\ All Windows
Users\ Application Data\IBM\License Use

Management\trace

The path where the trace files are copied. This parameter can be
changed only by editing the configuration file.

[LUM Server Tools]
Threshold_Automatic=0 All platforms
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Whether the threshold is automatically checked periodically. Possible
values are 0 (no) or 1 (yes).

Threshold_Level=80 All platforms

The default value of the threshold level used in the Basic License Tool
GUL Used for vendor-managed use products, and for
customer-managed use products when no specific threshold value is
specified.

Refresh_Automatic=0 All platforms

Whether the Basic License Tool is to do a periodic automatic refresh.
Possible values are 0 (no) or 1 (yes).

Refresh_Frequency=60 All platforms
The frequency, in minutes, of the automatic refresh.
Cleanup_Automatic=no All platforms

Whether the Basic License Tool automatically cleans stale licenses.
Possible values are yes and no. You can change this parameter only by
editing the configuration file.

[LUM Client]
GroupName=DefaultGroupName Windows

The name of the group to which the user of this workstation belongs.
GDBServer= All platforms

The format isip:servername[port] or not found.
NumDirectBindServers= All platforms

The number of direct binding servers the client applications are
configured to point to directly, using just transport family protocol,
name, and port number.

DirectBindServerX= All platforms

Where X is a value between 1 and NumDirectBindServer. The format is
ip:servername[port]. Specify the DirectBindServer keyword for each
server the client points to. If you need to contact the central registry
license server, there must also be an entry for it. The default ip port
numbers are 2215 for the license server and 10998 for the administration
server. Make sure you insert the correct ones if you are not using the
defaults.
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Appendix B. Environment Variables

This appendix describes the environment variables used by License Use
Management Version 5.1.1

To run enabled applications or License Use Management tools (for example,
LUMtv, LUMDbIt) in trace mode, set the following environment variables:

LUM_DEBUG = Yes

LUM_LIB_VERB = Yes

LUM_RPC_DEBUG = Yes

LUM_LT_DEBUG = Yes

LUM_THR_VERB = Yes

LUM_LOG_PATH = path_name file_name
LUM_CONFIG = path_name file_name
LUM_RPCLOG_PATH = path_name file_name

where:

path_name file_name
Is the absolute path and file name of the file in which traces will be
written.

For the LUM_LOG_PATH variable, you can redirect the output of the traces to a
log file by setting the environment variable to the name of the file. For the
LUM_CONFIG variable, you can use an alternative configuration file. For example,
LUM_CONFIG = /tmp/lum.config. For the LUM_RPCLOG_PATH variable, you set the
absolute path and file name of the file in which traces will be written. The file will
be used to store License Use Management communication traces for License Use
Management enabled applications.

Use the following variables to override the indicated tags in the Tum_ini.txt
configuration file:

* On AIX:

LUM_MAX_ACTIVITIES
Specifies the maximum number of activities that any server can manage.
The actual maximum for any particular server depends on the server’s
capabilities. The actual maximum could therefore be lower for some
servers. Allowed values are in the range 1--2048. The default value is
1024.

LUM_MAX_ACTIVITIES_THRESHOLD
Specifies the percentage of activities beyond which license requests are
rejected. Licenses can still be checked and released beyond this
threshold. This parameter is updated every time the LUMblIt -S
command is run.

LUM_PASSIVE_TIME
Specifies the length of time in seconds that an activity is to be kept in
the server activity pool after the activity has been completed.

LUM_LOG_TRACE = YES
Enable the tracing of the activities on the license server.
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¢ On Windows:

LUM_TIMESERV
Specify the timeout the system waits for the service to start. The default
value is 30 (seconds).

LUM_TRACE_SERV
This variable enables the tracing of the start and stop phases of
Windows services on License Use Management servers. To set the
LUM_TRACE_SERYV variable, follow the instructions in "Set Windows
Services Trace mode” section.

* On all operating systems

LUM_POLL_FREQ
Specify the frequency of sampling of the performance of the license
server. The default value is 1000.

LUM_TIMEOUT_FACTOR
You can increase or decrease the timeout using a scaling factor. You can
modify the timeout for connections between client and server by
changing the LUM_TIMEOUT_FACTOR environment variable on the
client side of the connection. The default value is 1000. Values greater
than 1000 increase the timeout interval, while values below 1000
decrease it.
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Appendix C. Using the Nodelock Directory

This appendix explains how to manually prepare the nodelock directory and how
to use it. The nodelock directory is a repository that contains nodelock certificates
and is managed automatically. However you can perform some limited tasks.

To manually create the nodelock directory:
1. On a Windows workstation, log in as administrator.

On an AIX workstation, log in as root, or use the su command.
2. Create the nodelock directory:

* On a Windows workstation, the default directory (unless specified by the
product) is:

c:\'COMMON_APPDATA'\IBM\License Use Management\nodelock
where:
COMMON_APPDATA
is the initial part of the path that is returned by the SHGetFolderPath API

An example of a typical path for the nodelock directory on a Windows
operating system is as follows:

c:\Documents and Settings\Al1 Users\Application Data\IBM\License Use
Management\nodelock

* On an AIX workstation:
/var/LicenseUseManagement/nodelock

* Assign the necessary permissions to the nodelock directory.

To enroll a nodelock license, move the nodelock certificate to the nodelock
directory. The directories nested under the nodelock directory will not checked by
License Use Management. Do not remove the license certificates from the nodelock
directory.
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Appendix D. Operating Systems and License Use
Management Support

This appendix identifies the operating systems supported by the various versions
of License Use Management. The tables also indicate which versions have been
tested and the level of support provided.

* Version 5.1.0 (Table 14)
* Version 5.1.1 (Table 15)

Table 14. Operating Systems and License Use Management Version 5.1.0 Support

Operating System

License Use Management Version 5.1.0

Application Runtime |Application Java GUI
Developer’s Developer’s Toolkit Native Java
Toolkit 64-Bit APIs
AIX 5.2, and 5.3 Yes Yes Static link only Yes Yes
HP-UX 11.i Yes Yes Static link only Yes Yes
IRIX 6.5 Yes Yes No Yes Yes
Solaris 8, 9, and 10 Yes Yes Static link only Yes Yes
Windows 2000 Yes Yes No Yes Yes
Windows XP and Windows Yes Yes Static link only (AMD | Yes Yes
Server 2003 32-bit and 64-bit Opteron)
* Version 5.1.1 (Table 15|
Table 15. Operating Systems and License Use Management Version 5.1.1 Support
Operating System License Use Management Version 5.1.1
Application Runtime | Application Java GUI
Developer’s Developer’s Toolkit Native Java
Toolkit 64-Bit APIs
AIX 5.2, and 5.3 Yes Yes Static link only Yes Yes
HP-UX 11.i Static link only | No No No Yes
Solaris 8, 9, and 10 Static link only | No No Yes Yes
Windows XP and Windows Yes Yes Static link only (AMD | Yes Yes

Server 2003

Opteron)
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Appendix E. Accessibility

Accessibility is a product feature that helps anyone who has a physical disability,
such as restricted mobility or limited vision, to use the software product
successfully.

The major accessibility features in License Use Management Runtime include:

Keyboard accessibility features
Object information

Sound and multimedia
Display

Documentation

Using License Use Management Runtime, you can:

Use accessibility technologies such as screen-reader or screen-magnifier software.
Perform tasks or actions by using only the keyboard.

Customize display attributes, such as color and font size.

In addition, the License Use Management Runtime product documentation aids
accessibility by providing:

Accessible documentation formats, such as Hypertext Markup Language
(HTML) or convertible Portable Document Format (PDF). You can access HTML
documents using screen-reader software.

Alternative text for all graphics so that any documentation user with vision
impairments understands the contents of the images.

Keyboard Accessibility Features

License Use Management Runtime supports these keyboard accessibility features:

Keyboard equivalents for all mouse actions.

For each software platform, there are standard keys and key combinations for
doing common actions. See [‘Keys Help” on page 193 for a list of the keyboard
equivalents so that, if you are unable to use the mouse, you can access all
product functions using the keyboard.

Access to the accessibility features of the operating system.

License Use Management Runtime does not provide keyboard sequences for the
shortcut keys that are reserved for the accessibility features of the operating
system. The Windows operating system, and AIX system have a set of
accessibility options. These accessibility options allow anyone with a disability to
customize system-wide keyboard settings to improve accessibility. For example,
you can customize Windows systems using the Windows Accessibility Options
on the Control Panel. On AIX systems, accessibility options are part of the
AccessX package.

Java Interface and Object Information

License Use Management Runtime uses a Java-based graphical user interface,
which provides object-oriented accessibility features, such as:
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Implementing the Java Accessibility programming interfaces, or adhering to
guideline for building custom components when extending the Java Foundation
Classes.

Setting the focus. In an application, access devices, software, and users need to
know where to direct the focus. For License Use Management Runtime, use the
Tab key to change the focus.

Setting the name and description on components, icons, and graphics such as
using an image to identify programmatic elements. All License Use Management
Runtime icons have alternate text for icons and graphics.

Associating labels with controls, objects, and icons, such as associating the text
label with an entry field control. License Use Management Runtime labels all
components that you can access with speech-reader software.

Sound and Multimedia

License Use Management Runtime uses the following sound and multimedia
accessibility functions:

An option to display a visual cue for all audio alerts. Typical alerts might be the
receipt of new mail, beeps to indicate system errors, or sounds to indicate a
change in status. License Use Management Runtime allows you to change your
user preference to turn on visual cues for audio alerts.

Use of the operating system volume setting to adjust the volume for the
application.

For the Windows operating system, you control the volume by selecting Start »
Programs » Accessories » Entertainment » Volume Control.

Display

License Use Management Runtime supports the operating system display settings
for color scheme, font size, and high contrast display. License Use Management
Runtime supports a variety of color selections.

On Windows systems, you can customize colors through the Microsoft®
Windows Accessibility Settings for High Contrast in the Control Panel. Or you
can customize colors through the License Use Management Runtime view
options.

When you customize colors, you can produce a range of contrast levels.

Color is not the only way that License Use Management Runtime conveys
information or indicates an action. License Use Management Runtime uses other
attributes, such as bold or italic, in addition to color, to distinguish the text.

To view a document or an application work area in an enlarged font, you can
use various magnifications of the Zoom option in Windows. Using
magnifications does not affect the actual document or work.

Documentation

License Use Management Runtime provides documentation in these formats:

Accessible HTML format. Accessibility tools, such as screen readers, can read
directly this format.

Accessible text. All License Use Management Runtime documentation with
graphics has alternate text that describes each illustration and graphic used in
the documentation.
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Even though License Use Management Runtime provides an accessible HTML
format, you can also create accessible Portable Documentation Format (PDF)
format. You can convert Adobe V4.0 PDF files to the accessible HTML format. Use
the Adobe PDF-to-HTML conversion program to create accessible PDF formats. For
information about converting PDF documents to HTML, refer to the Adobe book
Optimizing Adobe PDF Files for Accessibility

In addition, License Use Management Runtime provides documentation of all
keyboard access methods, such as accelerator keys.

Keys Help

License Use Management Runtime provides documentation on all accessibility
features, including keyboard access. In additional to this appendix, you can select
Help » Help Keys for online help.

Following are lists of keys that are available to you when using License Use
Management Runtime. These keys are grouped according to their function.

Note: When you see two keys that are joined by a plus sign (+), hold down the
first key while pressing the second key at the same time.

General Keys

Use the following keys to act on a window:

F1 Provide help for the panel.

F3 Exit the panel.

F5 Refresh the panel.

F10 or ALT Go to or from the action bar.

Arrow keys Move among choices on the action bar in menus, in dialog windows, or

in list boxes.
Underlined letter Move to a choice on the menu bar or menus.

Alt+F4 Close the window.

Alt+F5 Restore the window (only for supported Windows platforms).
Alt+F7 Move the window (only for supported Windows platforms).
Alt+F8 Size the window (only for supported Windows platforms).
Shift+Esc or Go to or from the system menu.

Alt+Spacebar

PgUp Scroll the contents of the window up one page.

PgDn Scroll the contents of the window down one page.
Ctrl+PgUp Scroll the contents of the window left one page.

Ctrl+PgDn Scroll the contents of the window right one page.

Esc Cancel the application menu or the system menu.

Keys for Dialog Window

Use the following keys to act on a dialog window.

Enter Perform the action indicated on the selected push button.

Spacebar Set a check box on or off or perform the action indicated on the selected
push button.

Tab Move to the next group of entry fields or check box.

Backspace (left Delete the character to the left of the cursor in input fields.
arrow delete)
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End or Move to the end of a field.
Ctrl+Right

Arrow Key

Home or Move to the beginning of a field.
Ctrl+Left Arrow

Key

Keys for Help
Use the following function keys to get help from the application or to get different
types of help within a help window.

F1 Help

Accelerator Keys for the Configuration Tool

You can use accelerator and command keys to navigate through License Use
Management Runtime. All accelerator keys have an underlined letter. For example,
F is the accelerator for the File menu. In Windows, press the ALT key, then the
accelerator key to trigger an action. For example, Alt+F shows the File menu. You
can show additional accelerators for bookmarks and task buttons by pressing and
holding down the ALT key.

Command keys directly trigger an action and usually make use of the CTRL
(Windows) keys. For example, to print, press CTRL+P.

License Use Management Runtime uses accelerator keys. The following sections list
the accelerator keys used for the configuration tool. Although the accelerator keys
listed are shown as they appear on the menus (both in uppercase and in
lowercase), the accelerator keys are not case sensitive.

Configuration Tabs
The following tabs are in the configuration tool:

* Configure As

e User

* Accessibility

* Direct binding
 Start up

* Direct binding ports
* Log

Each tab has its own accelerators.

Configure As Tab: Use the following accelerator keys in the Configure as tab:

ALT+C To select network license client.

ALT+S To select Network License Server (NetworkLS).
ALT+L To disable remote administration for Network LS.
ALT+R To select Central Registry License Server (CrLS).

User Tab: Use the following accelerator key in the User tab:

ALT+G To select Group name.
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Accessibility Tab: Use the following accelerator keys in the Accessibility tab.

ALT+F To open the Font Selection dialog.
ALT+L To open the Color Selection dialog.

Direct Binding Tab: Use the following accelerators in the Direct binding tab:

ALT+S To select the Servers list.

ALT+N To select the Name field.

ALT+K To select Network License Server.

ALT+C To select Central Registry License Server.

ALT+L To select the Network License Server port field.
ALT+P To select the Central Registry License Server port field.
ALT+A To add a server.

ALT+R To remove a server.

Start Up Tab: Use the following accelerator in the Start up tab:

ALT+U To start the Basic License Tool.

Direct Binding Ports Tab: Use the following accelerators in the Direct Binding
Ports tab:

ALT+N To select the Network License Server port.
ALT+C To select the Central Registry Server port.

Log Tab: Use the following accelerators for the Log tab:

ALT+A To log all events.

ALT+C To log license check-in events.

ALT+W To log license wait events.

ALT+T To log license timeout events.

ALT+E To log errors.

ALT+G To log license grant or release events.

ALT+V To log vendor added or deleted events.

ALT+M To log vendor message events.

ALT+P To log product added or deleted events.

ALT+S To log the successful start or stop of the license server, and when the
threshold on the workload is exceeded or regained.

ALT+L To select the log file directory field.

Font Selection Dialog Accelerators
Use the following non-standard accelerators for the Font Selection dialog:

ALT+D To reset the default font and font size.

Color Selection Dialog Accelerators
Use the following non-standard accelerators for the Color Selection dialog;:

ALT+F To change the foreground color.
ALT+B To change the background color.
ALT+D To reset the default background and foreground colors.
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Accelerator Keys for the Basic License Tool

You can use accelerator and command keys to navigate through License Use
Management Runtime. All accelerator keys have an underlined letter. For example,
F is the accelerator for the File menu. In Windows, press the ALT key, then the
accelerator key to trigger an action. For example, Alt+F shows the File menu. You
can show additional accelerators for bookmarks and task buttons by pressing and
holding down the ALT key.

Command keys directly trigger an action and usually make use of the CTRL
(Windows) keys. For example, to print, press CTRL+P.

License Use Management Runtime uses accelerator keys. The following sections list
the accelerator keys used for the basic license tool. Although the accelerator keys
listed are shown as they appear on the menus (both in uppercase and in
lowercase), the accelerator keys are not case sensitive.

Main Window Accelerators
Use the following accelerator keys in the main window:

ALT+P To open the Products menu.
ALT+S To open the Selected menu.
ALT+E To open the Report window.
ALT+R To open the Servers menu.
ALT+V To open the View menu.
ALT+O To open the Options menu.
ALT+H To open the Help menu.

File Menu: The File menu has the following accelerator keys:

I To import a certificate.
X To exit from the Basic License Tool.

Selected Menu: The Selected menu has the following accelerator keys:

To open the details window.
To distribute licenses.

To update licenses.

To clean up stale licenses.
To remove licenses.

A NCOo

Report Menu: The Report menu has the following accelerator keys:

p To get a report for the selected product.
a To get a report for all products.

Servers Menu: The Servers menu has the following accelerator keys:

A To view active license servers.
C To view clusters.

View Menu: The View menu has the following accelerator keys:

n To include servers, vendors, or products.
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F To refresh the view.

Options Menu: The Options menu has the following accelerator keys:

To open the system settings dialog.

To set the toolbar viewing mode submenu.
To open the Font Selection dialog.

To open the Color Selection dialog.

0w

Help Menu: The Help menu has the following accelerator keys:

G To open general help on the Basic License Tool.
K To open this keys help.
r To open information about the product version.

Details Window Accelerators
The Details window has the following tabs:

* Product

e Compound

* Concurrent

* Concurrent Users
* Reserved

* Reservable

The Product tab has no accelerators.

The other tabs have the following accelerators:

L To open the Licenses menu.
S To open the Selected menu.
H To open the Help menu.

Font Selection Dialog Accelerators
Use the following non-standard accelerators for the Font Selection dialog:

ALT+D To reset the default font and font size.
ALT+F To select the font list.

ALT+S To select the sizes list

ALT+T To select the styles list.

Color Selection Dialog Accelerators
Use the following non-standard accelerators for the Color Selection dialog;:

ALT+F To change the foreground color.
ALT+B To change the background color.
ALT+D To reset the default background and foreground colors.

Update Licenses Dialog Accelerators
The Update Licenses dialog has the following accelerators:

u To activate customer-managed use.
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To disable soft stop.

To set High Water Mark licenses.
To reset High Water Mark licenses.
To set the threshold.

To select enrolled licenses.

— H®wr g

Reserved Licenses Details Window Accelerators
The Reserved Licenses Details window has the following accelerators:

To select the licenses.

To set the name.

To set the group.

To set the node ID.

To set the year of license expiration.
To set the month of license expiration.
To set the day of license expiration.

To set the hour of license expiration.
To set the minute of license expiration.

merzZRAQZD

Include Dialog Accelerators
The Include dialog has the following accelerators:

ALT+A To select the All servers radio button.
ALT+S To select the Select servers radio button.
ALT+V To select the Select servers button.
ALT+L To select the All vendors radio button.
ALT+T To select the Select vendors radio button.
ALT+N To select the Select vendors button.
ALT+P To select the All products radio button.
ALT+Y To select the Currently in use radio button.
ALT+U To select the All users radio button.
ALT+E To select the Select users radio button.
ALT+R To select the Select users button.

Select Users Dialog Accelerators
The Select Users dialog has the following accelerators:

To move to the available users box.

To move to the selected users box.

To add a user to the selected users box.

To add all users to the selected users box.

To remove a user from the selected users box.
To remove all user from the selected users box.

oA W

Define Cluster Members Dialog Accelerators
The Define Cluster Members dialog has the following accelerators:

A To add a member to a cluster.
R To remove a member from a cluster.
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Active License Servers Window Accelerators
The Active License Servers window has the following accelerators:

ALT+S
ALT+H

To open the Selected submenu.
To open the general help for the Basic License Tool.

Selected Menu: The Selected menu has the following accelerators:

ALT+C
ALT+T

To change the threshold value.
To open the Tracing submenu.

Tracing Menu: The Tracing menu has the following accelerators:

N

i
L
g

To select the None tracing option.

To select the High tracing option.

To select the Low tracing option.

To select the Low & High tracing option.

Clusters Window Accelerators
The Clusters window has the following accelerators:

ALT+C
ALT+S
ALT+H

To open the Create menu.
To open the Selected menu.
To open the Help menu.

Create Menu: The Create menu has the following accelerators:

ALT+R

To open the Create Clusters dialog.

Selected Menu: The Selected menu has the following accelerators:

ALT+O
ALT+U
ALT+R

To show the selected servers.
To update the selected licenses.
To remove the selected licenses.

Help Menu: The Help menu has the following accelerators:

ALT+G

To show the Basic License Tool general help.

Server Details Window Accelerators
The Server Details window has the following accelerators:

ALT+A
ALT+D

To activate the selected server.
To deactivate the selected server.

Report Window Accelerators
The Report window has the following accelerators:

A

L
\Y%
D

To select all events.

To select license related events.

To select vendor message events.
To select LDM modification events.
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To select error events.

To select server start and stop events.

To select fatal error events.

To set the date range for the report.

To select a standard report format.

To select a license request by product report format.

To select a license request by user report format.

To select a license use by product report format.

To select a license use by user report format.

To select a customer-managed user audit report format.

85 <0 " 00T WMo M

Settings Dialog Accelerators
The Settings dialog has the following accelerators:

To set the default threshold default level.

To set the automatic refresh option.

To set the automatic refresh time in minutes.
To select the Refresh now button.

To enable threshold logging.

MR T > g

Update Offline Period Dialog Accelerators
The Update Offline Period dialog has the following accelerators:

ALT+M To set the maximum offline period.

Authorizations Dialog Accelerators
The Authorizations dialog has the following accelerators:

ALT+L To modify the default authorization to All allowed.

ALT+N To modify the default authorization to All not allowed.
ALT+R To modify the default authorization to All concurrent allowed.
ALT+E To modify the password of the default authorization.

ALT+A To add a new authorization.

ALT+M To modify an authorization.

ALT+D To delete an authorization.

Add/Modify Authorization Dialog Accelerators
The Add/Modify Authorization dialog has the following accelerators:

ALT+U To set the user name.

ALT+G To set the user group name.

ALT+P To set the password for the authorized user.

ALT+T To set the target ID of the machine.

ALT+A To authorize the use of the license as concurrent-offline.
ALT+N To deny the use of the license.

ALT+R To authorize the use of the license as concurrent.

Notices

References in this publication to IBM products, programs, or services do not imply
that IBM intends to make these available in all countries in which IBM operates.
Any reference to an IBM product, program, or service is not intended to state or
imply that only IBM’s product, program, or service might be used. Any
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functionally equivalent product, program, or service that does not infringe any of
IBM’s intellectual property rights might be used instead of the IBM product,
program, or service. Evaluation and verification of operation in conjunction with
other products, except those that are expressly designated by IBM, are the user’s
responsibility.

IBM might have patents or pending patent applications by covering subject matter
in this document. The furnishing of this document does not give you any license to
these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

P.O. Box 12195

3039 Cornwallis

Research Triangle Park, NC 27709-2195
US.A.

Such information might be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

Trademarks

The following terms are trademarks of the IBM Corporation in the United States,
other countries, or both:

AIX
IBM
The IBM logo

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Microsoft, Windows, Windows NT®, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

$

Jﬂﬁm Java and all Java-based trademarks are trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.

Linux® is a trademark of Linus Torvalds in the United States, other countries, or
both

Other company, product or service names might be trademarks or service marks of
others.
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Glossary
A

ACID. In License Use Management, a generic string
identifying the requestor of a license. Vendors can
define their own multiuse rule based on the ACID.

administrator. In License Use Management, the person
who is responsible for setting up the License Use
Management Runtime environment. The tasks of the
administrator include:

* Installing and configuring network license servers,
network license clients, and the central registry.

* Installing the software product licenses on the
servers.

* Monitoring the software products use through the
Basic License Tool.

* Configuring the network.

annotation. See |license annotation|

application client. A computer that runs a software
product and plays the role of the client in the
traditional client-server model.

application client identifier. In License Use
Management, the unique identifier of the application
client.

When a license is granted to a client, the ACID of the
client is recorded in the central registry, which is
checked at any new license request. This avoids
granting a license twice to the same application client.

application server. A computer where an enabled
product is installed, which provides shared access to
the product to workstations (the application clients)
over the network.

In License Use Management, the application server is
the License Use Management Runtime client. It
requests the licenses for all its application clients.

authorization. Defines the mode for which each user,
group, and target ID can use a concurrent or a
concurrent-offline license. The mode can be one of:

* For a concurrent license:
allowed or not allowed
* For a concurrent-offline license:

allowed, not allowed, or concurrent allowed

Basic License Tool. In License Use Management, the
administration tool included in License Use
Management Runtime, which enables the administrator

© Copyright IBM Corp. 1995, 2006

to add or delete licenses from the server database,
display the licenses installed, distribute the licenses
among the servers available on the network, and
generate reports on license usage and server events.

binding. In License Use Management, the method by
which a network license client can locate a server in
order to request a license. See [direct binding]

C

C language. A language used to develop software
applications in compact, efficient code that can be run
on different types of computers with minimal change.

C++ language. A programming language based on the
C language and developed by Bjarne Stroustrup. C++
defines data types called classes. Classes provide data
abstraction and are composed of data (data members)
and operations that operate on that data (member
functions). C++ also implements the object-oriented
programming concepts of inheritance through class
derivation and polymorphism through virtual functions
and overloading.

capacity type. In License Use Management, a number
that specifies the type of unit that a license applies to.
The type of unit can be defined by IBM or chosen by
the vendor. If no capacity type is specified by the
vendor, the license applies to users.

central registry. In License Use Management, a
database that contains information about:

* The enrollment and distribution of
customer-managed use control products.

* Which application clients already have a per-seat
license.

¢ Reservation of reservable licenses.

check period. In License Use Management, a time
period during which a product holding a concurrent or
unreserved reservable license must check in with the
network license server. If the product does not check in
during this period, the network license server assumes
that the product is not running, and might release a
granted license to another user.

cluster. In License Use Management, a group of
network license servers that jointly serve
vendor-managed concurrent licenses that are tied to the
cluster rather than to an individual server. While some
servers in the cluster are serving licenses, one or more
servers remain in reserve, ready to take over should an
active server fail.
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compound password. In License Use Management, a
password from which it is possible to extract multiple
simple passwords, each representing one or more
licenses.

Enabled applications cannot use the compound
password directly.

concurrent license. In License Use Management, a
type of license, administered by the network license
server, that can be used by different users from any
node that is connected to a network license server.
Concurrent licenses enable as many users to use a
particular software product concurrently as there are
licenses.

concurrent offline license. In License Use
Management, a concurrent-offline license is identical to
a normal concurrent license, but the concurrent-offline
license allows users to reserve a concurrent license for a
certain number of days and to use it on a portable
computer disconnected from the network. Only
authorized users can exploit this feature.

country usage. Identifies the country where the license
will be used.

custom configuration. In License Use Management, a
selected combination of products tailored by a vendor
to the needs of one or more users. Each custom
configuration is identified by unique serial number,
which is incorporated into the custom configuration.
See license.

custom configuration licenses. In License Use
Management, a special case of a concurrent,
concurrent-offline and nodelock license that contains a
unique serial number identifying a custom
configuration.

customer-managed use control. In License Use
Management, a level of password use control in which
the customer manages compliance with the terms of the
software product acquisition. It is the customer’s
responsibility to set the upper limit on the number of
licenses that can be extracted and distributed, based on
the terms of the software product acquisition.

customer site. Enables the user to identify the
customer who owns the license.

D

direct binding. In License Use Management, a type of
binding between network license servers and clients in
which client applications locate license servers by
means of a local text file that contains network
addresses of the license servers.

direct binding servers list. In License Use
Management, a set of network license servers and a
central registry license server that collectively serve a
set of network license clients.
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dynamic nodelocking. In License Use Management, a
way of using licensing APIs in which a compound
password installed on a network license server carries
simple nodelocked licenses. Upon first invocation of the
product at a client, a simple nodelocked license is
extracted from the compound password and installed
on the client workstation.

E

end user. In License Use Management, a user of
license-enabled software products. The tasks of the end
users might include:

¢ Installing License Use Management Runtime with the
help of the administrator.

¢ Configuring License Use Management Runtime as a
network license client.

enrollment certificate. In License Use Management, a
mechanism for the distribution of licenses to end users.
It is usually in the form of an electronic file, and
contains all the information that is related to the
licenses acquired for a license-enabled product.

F

features. In License Use Management, an optional
string that, with the product identity and product
version, is used to identify the product.

gdb server. See [central registry

H

hard stop. In License Use Management, a policy
according to which, if the end user starts the product
and there are no licenses available, the product does
not start.

high-availability licensing. In License Use
Management, an option that makes it possible for a
cluster of network license servers to jointly serve
concurrent licenses, with one or more servers in reserve
in case a server goes down. The software vendor must
create passwords to be enrolled on the cluster rather
than on an individual server.

high-water mark. In License Use Management, the
maximum number of soft stop licenses that have been
granted for a given product, over the number of
licenses enrolled for that product. It is updated when
the soft stop policy is set. In hard stop policy no
updating of the high-water mark occurs, since it is
assumed that the product stops its execution if no
licenses are available.



initial key. In License Use Management, the initial key
license for a custom configuration license generated
when using the Upgrade flag. It is an encrypted
character string that specifies some terms of the
acquisition of the selected combination of software
products in a customer initial custom configuration.
Contrast with replacement key. See replacement key.

internet. A set of two or more connected networks.
The networks in an internet do not necessarily use the
same communications protocol.

License Use Management Runtime supports the
UDP/IP protocol.

J

Java. An object-oriented programming language for
portable interpretive code that supports interaction
among remote objects. Java was developed and
specified by Sun Microsystems, Incorporated.

Java Development Kit (JDK). Software that Sun
Microsystems distributes for Java developers. This
software includes the Java interpreter, Java classes, and
Java development tools. The development tools include
a compiler, debugger, dissassembler, stub file generator,
and documentation generator.

K
key. See

L

license. Permission to use an instance of a licensed
software product or service, according to the basis on
which the vendor charges for the product or service.
Sometimes, a user needs more than one license to make
full use of a particular product features.

The term license as used in the context of License Use
Management does not refer to the license agreement
that governs use of and rights to a product.

license annotation. A string that the vendor can use
to modify the use of a license.

license database. In License Use Management, the
database of licenses that a license server maintains.

license-enabled product. A product that is enabled for
License Use Management.

A vendor provides a license-enabled product together
with a password that authorizes use of the product.
The password contains an encryption of certain terms
of the acquisition of the product (such as how many
licenses the customer can use, the expiration date of the
licenses, and the type of license).

license information. In License Use Management, the
information that describes licenses. This information
consists of product name, product version, product
features, number of licenses, license type, start and end
dates for the licenses, and a time stamp.

license key. See [password
license password. See [password

license server. A program that provides the license
services, administering licenses for software products.

licensed product. See [license-enabled product]

log file. A database that records messages and errors
from the license server, and sometimes also from
licensed products.

M

multiuse rules. In License Use Management, rules that
define the conditions under which multiple invocations
of a product require only a single license. These rules
are applicable only to concurrent licenses. The vendor
of the product defines multiuse rules.

N

NCS. A set of software components, developed by
Apollo Computer Inc., that conform to the Network
Computing Architecture. These components include the
Remote Procedure Call (RPC) runtime library and the
Location Brokers.

network. A group of nodes and the links that
interconnect them.

network license. In License Use Management, a
license that is maintained on a network license server
for use upon request by a License Use Management
Runtime client.

network license client. In License Use Management, a
node configured to make use of licenses by requesting
them from a network license server.

network licensed product. In License Use
Management, a licensed product that is enabled such
that the licenses are maintained on a server for use
upon request by a License Use Management Runtime
client.

network license server. In License Use Management, a
node in the network on which network licenses are
stored for use by License Use Management Runtime
clients.

node. A workstation in the network. In License Use
Management, it can be configured as a network license
client, a network license server, the central registry
license server, or a combination.
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nodelocked license. In License Use Management, a
type of license locked to a specific node, so that the
product can be used only at that node. The nodelocked
license is installed on the workstation for which it was
created.

non-runtime-based enablement. In License Use
Management, a type of license enablement for a
product with simple nodelocked licenses that does not
make use of License Use Management Runtime on the
end user’s workstation. The password is stored in a
special directory when the enabled product is installed.
When the enabled product is started, it checks the
directory to ensure that there is a valid license.

(0

object. In the Network Computing System, an entity
that is manipulated by well-defined operations.
Databases, files, directories, devices, processes, and
processors are all objects.

offline-nodelocked license. In License Use
Management, an offline-nodelocked license is the copy
of the concurrent-offline license that has been installed
on a portable computer that is disconnected from the
network. There cannot be more than one
offline-nodelocked license for the same product, same
product version, same product features, and same
nodelock directory on the same machine (same target
ID). There can be several nodelock directories on the
same machine. The offline-nodelocked license is local to
the portable computer where the application has been
installed.

offline period. The maximum number of days that a
user can reserve a concurrent-offline license.

P

password. An encrypted character string that specifies
some terms of the acquisition of a software product.
See also [simple password| and |compound passwordl

password use control level. In License Use
Management, a level of control of compliance with the
terms of the acquisition of a license-enabled product.
The password use control levels are:

* customer-managed use control

* vendor-managed use control

per-seat license. In License Use Management, a license
used to enable client/server applications that are
constructed for multiple-server solutions. Assignment
of a per-seat license to an application client is
permanent. Unused application client licenses are kept
in a central repository, which all the application servers
share. They also share a central list of application
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clients that have an assigned license. If an application
client connects to multiple application servers, only one
license is assigned to it.

product ID. In License Use Management, a number
that identifies a vendor licensed software product. By
means of product IDs, the license server can distinguish
between products from the same vendor.

R

(RDK) Relese Dependent Key . In License Use
Management, features which can offer the capatibility
to use the same license for different versions of the
product.

remote procedure call. remote procedure call (RPC) A
client request to a service provider located in another
node.

replacement key. A license key for a custom
configuration license generated using the Upgrade flag.
It is an encrypted character string that specifies some
terms of the acquisition of the selected combination of
software products in a customer upgraded custom
configuration. Contrast initial key.

report. In License Use Management, a summary of the
events related to the licenses that are installed on the
selected servers, filtered as the administrator specified.
Examples of events are:

¢ Requests for licenses for a product in a given interval
of time.

* Server startup.

reservable license. In License Use Management, a
network license that the administrator can reserve for
the exclusive use of a user, a group, and a node. The
reservation is for a specified time period.

reservation. In License Use Management, a
concurrent-offline license that is reserved (for a defined
offline period) for use as an offline-nodelocked license.

reserved license. In License Use Management, a
license that the administrator has reserved for the
exclusive use of a user, a group, and a node.

RPC. See [remote procedure call}

runtime-based enablement. In License Use
Management, a type of license enablement for a
product with nodelocked licenses that use License Use
Management Runtime on the end user’s workstation to
manage the licenses.

S

selected servers. In License Use Management, the
servers that the administrator is working with through
the Basic License Tool. All the products whose licenses



are installed on the selected servers are displayed in the
Basic License Tool main window.

serial number. In License Use Management, a unique
number that identifies a specific custom configuration.

subserial number. In License Use Management, a
unique number that identifies = the subserial number in
the license that is currently enrolled.

simple nodelocked license. In License Use
Management, a nodelocked license that allows an
unlimited number of simultaneous uses of the licensed
application on the local workstation.

simple password. In License Use Management, a
password that, once enrolled on a license server,
represents one or more licenses.

Enabled applications can use the simple password
directly.

soft stop. A policy according to which, if the end user
starts the product and there are no licenses available,
the product starts.

T

target. In License Use Management, the node at which
a password is to be installed. If the password specifies
a nodelocked license, the target is the node where the
licensed product is run. If the password specifies
multiple nodelocked license (that is, a compound
password for nodelocked licenses) or network licenses,
the target is a node at which the network license server
(LUMImd) is running.

target ID. In License Use Management, a unique
identifier of a node. A vendor can generate a password
that can be installed only on a node that has a specific
target ID. The target ID can be based on hardware or
generated by License Use Management Runtime.

threshold. In License Use Management, a percentage
of licenses; if more than this percentage of licenses for a
product are in use, messages about the level of use are
logged.

time stamp. In License Use Management, a number
that identifies the date and time at which a set of
licenses was created.

trace. A record of the execution of a computer
program. It exhibits the sequences in which the
instructions were executed.

try-and-buy license. In License Use Management, a
nodelocked license that has a fixed duration and a start
date equal to the date when the license is enrolled. A
try-and-buy license is made available for purposes of
evaluating the application, and can be replaced by a
production license after evaluation.

U

UDP. See[‘User Datagram Protocol.”|

universal unique identifier. An identifier that is used
by NCS to identify interfaces, objects, and types.

upgrade index. In License Use Management, a unique
number which identifies a specific license in the
upgrade set. It is always less then or equal to the
upgrade count.

upgrade count. In License Use Management, a total
number which identifies licenses in the set.

use-once license. In License Use Management, a type
of license, administered by the license server, that is
effective for only a single instance of starting a product
or using a service. The license server decrements the
number of available use-once licenses each time the
product or service is used.

User Datagram Protocol (UDP). In the Internet suite
of protocols, a protocol that provides unreliable,
connectionless datagram service. It enables an
application program on one machine or process to send
a datagram to an application program on another
machine or process. UDP uses the Internet Protocol (IP)
to deliver datagrams.

UUID. See |universal unique identifier]

\'

value units policy. A policy vendors use to price their
products by introducing a common unit of
measurement known as a value unit. Vendors can
combine usage count, different system capacity
measurements, and other product-specific indicators
into the same license certificate. Vendors can also define
the relative weights and rules for the translation of the
basic metric units into value units.

vendor ID. In License Use Management, the identifier
of a vendor of licensed products. Vendor IDs are a
License Use Management Runtime specific usage of
NCS Universal Unique Identifiers (UUIDs).

vendor definition file. In License Use Management, a
plain text file that contains all information relevant to
License Use Management for one vendor.

vendor-managed use control. In License Use
Management, a level of password use control in which
the vendor manages compliance with the terms of the
software product acquisition.

The customer of a vendor-managed use product
supplies a unique identifier (target ID) of each
workstation where product licenses are to be installed.
The vendor uses this information to create the

Glossary 207



password, which is tied to the target workstation and
cannot be used on another workstation.
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